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Part I: Introduction





1 Introduction to the sisNET Suite
This chapter describes the operations and workflows on which sisNET is based.
Overview
The following points are described:

• Programs in the sisNET Suite

• Installation

• Further documentation

• Starting programs in the sisNET Suite

• The sisNET message output

• The sisNET mouse control

Programs in the sisNET Suite
The program package of the sisNET Suite contains the following programs:

• sisNET: A complete GIS workplace for displaying and editing geographic data. 
The descriptions in this guide refer (unless stated otherwise) to the sisNET interface.

• sisFLOW: GIS information workplace which enables geographic data to be displayed 
and alphanumeric GIS data to be edited. In contrast to sisNET, GIS objects cannot be 
created and graphically modified. The menu structure is largely the same as the 
sisNET interface (some menu items are not available).

• sisVIEW: GIS information workplace optimised for mobile information solutions 
and user-friendliness, enables geographic data to be displayed and redlining (adding 
notes) to be done. sisVIEW has a standalone interface, optimised for ease of use.

• sisCONF: Program for editing the data structure (application module) and aligning 
database structures. For more documentation about sisCONF, please refer to the 
sisNET application module configuration guide.

All the programs in the sisNET Suite can access the same project data - there is no need 
to transform data. Scripts are provided to copy and align data so that mobile information 
solutions can be implemented without having constant access to a central data inventory.
sisNET Suite - User Guide 13



Introduction to the sisNET Suite
Installation

1

Installation
A standard installation program is provided to install all the programs in the sisNET Suite. 
During the installation, you can create links to start each of the programs. If more than 
one program from the sisNET Suite is to be installed on a workstation, the installation 
only has to be done once. To install the sisNET Suite, start the installation program on the 
installation medium (setup.exe). An installation wizard opens to guide you through the 
rest of the installation. For further information on the installation, please refer to the 
supplementary guide on the installation medium and to the installation wizard.

Other documentation
The sisNET administration guide provides information which is mainly of interest for 
administrators. It covers areas such as the following:

• Describes the concepts underlying the programs in the sisNET Suite

• Instructions for configuring the sisNET data structures (application module)

• Describes the sisNET macro language

Starting programs in the sisNET Suite
All the programs in the sisNET Suite can be launched by double-clicking the relevant link 
on the desktop. A welcome screen appears, along with a progress bar which indicates 
how the launch is proceeding.

Login and attaching the database

1. When the program has started successfully, the screen will show the dialog box for 
logging into the system while, at the same time, the connection to the database is 
established (if Single Sign-On is activated, this step is skipped).

2. First of all you need to enter your user name in the dialog box. The default entry in 
this line is the name of the workstation user. The workstation user is the user whose 
name is entered in the environment variable ustation_username. This name is used 
to define the rights and options available to the user. This name is not hidden.
14 sisNET Suite - User Guide
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3. A password then needs to be entered. This password is hidden. The user name and 
password are not case-sensitive.

4. The third line displays the alias name of the non-local database being used.

5. When the user name and password have been entered, the entry is confirmed with 
the “OK” button.

Selecting a category
Depending on the application modules installed, different categories can be opened and 
worked on.

Select a category

1. You use the mouse’s data button to select a category from the popup list in the dialog 
box. The category selected appears with its font inversed.

2. Select the “OK” button to confirm, and the relevant files for that category are loaded.

sisNET message outputs
The messages output by sisNET appear on the lower edge of the main window, in the status 
line. There is a detailed description of the complete status line in the MicroStation help.

2 parts of the status line are of particular interest to the sisNET user:

• Selected function / input prompt

• Message Centre

Selected function / input prompt

This line in the command window displays current information for the user which should 
prompt them to take particular actions.
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Message Centre

This line in the command window displays system messages. These may be, e.g., error 
messages if entries are incorrect, or indicators about, e.g., missing files. Clicking this 
area opens the sisNET Message Centre which lists the messages recently output. This 
can be useful if several messages have been output very quickly and have overwritten 
one another.

sisNET Message Centre

Using the mouse with sisNET
sisNET’s graphical user interface is largely mouse-controlled.

2 or 3 button mice may be used.

Each user can specify for themselves which functions to assign to the mouse buttons 
in the MicroStation menu work area > button assignments.

With a 3 button mouse, by default the left-hand button is the so-called data button. 
It is used to select drawing objects, confirm buttons and set points in the drawing file.

The right-hand mouse button is the so-called Reset button and is used to decline the 
actions the system proposes.

The middle mouse button (or simultaneously pressing the left and right buttons) is 
the so-called Tentative button. The Tentative button is used to click very precisely on 
inflection points or construction points, including if the cursor is not precisely positioned 
over the object being clicked.

By combining the Switch key with the right mouse button you can also access frequently 
needed menu functions.

Switch key + right mouse button

A menu appears from which you can select various functions for controlling the view. 
When the relevant menu item has been selected, the prompt for the next action to take 
appears in the user guidance field in the sisNET command window.
16 sisNET Suite - User Guide



Introduction to the sisNET Suite
Using the mouse with sisNET
Place the cursor over a sisNET object

A window appears with information about that sisNET object. The sisNET object 
attributes that display is specified for each project in the application module.

(hold down) the right mouse button
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A menu with context-sensitive content appears. The displayed menu was opened after 
the cursor was positioned over a sisNET object. You can use this menu to access the 
sisNET attributes mask and make certain edits to objects (providing there is a job open). 
Not all of the operations in this menu can be carried out on sisNET objects, however.

Double-click

Double-clicking a sisNET object opens the associated object editor or forms mask. 
By default, the mask opens in Read mode. If you are working on a job, the mask can 
also be opened in Edit mode by default. To do this, the environment variable 
SISNET_ENABLEUPDATEONDOUBLECLICK must have the value 1.

Dockable window
The sisNET Explorer dialogs, the object search and the named areas are dockable, i.e. they 
can be anchored to different edges of the screen. To dock a dialog, move it by clicking 
and hold it on its header row. Different symbols are dynamically displayed which offer 
you the relevant anchoring positions.
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2 The File menu
The File menu contains entries for opening, saving and manipulating files.
Task: Select from the “File” menu:

This menu option opens the dialog box of the 
Job Manager

Job Manager (Page 22)

Stores the current job Current job… > Save (Page 31)

Stores the current job and opens a new job Current job… > Save and continue to work (Page 33)

Discards the current job Current job… > Discard (Page 33)

Discards the current job and opens a new job Current job… > Discard and continue to work (Page 35)

Closes the current job Current job… > Close (Page 35)

Supplies information about the current job Current job… > Inf. (Page 35)

Checks the current job Current job… > Test (Page 37)

Repairs the current job Current job… > Repair (Page 37)

With this function you can change between 
the different categories

Change Category > Change (Page 37)

Modified object resources can again be read 
in with this function

Category > Read in category (objects) again (Page 37)

Using this submenu you can change to the 
main plan or to the municipality overview

Category > Derived maps (Page 37)

An information map can be created with 
this function

Information map… > New (Page 37)

An information map can be opened with 
this function

Information map… > Open (Page 38)

User-specific settings are saved with 
this function

Save setting (Page 39)

Drawing files can be compressed with 
this function

Compress file (Page 39)

Activation and processing of sisNET 
batch files

Batch file > Execute batch file (Page 39)
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Job Manager
This menu option opens the “Job Manager” dialog box. The Job Manager presents all jobs 
of all application modules clearly arranged by application modules and users and makes 
it possible to create, open, save or discard a job, and to have a log file for a job displayed. 
It is additionally possible to check and repair individual jobs.

Cancellation of sisNET batch files Batch file > Cancel batch file (Page 40)

Continuation of sisNET batch files Batch file > Resume batch file (Page 40)

Execution of batch files via a dialog box Batch file > Batch file dialog (Page 40)

Running a VBA macro VBA > Macros… (Page 42)

Opening the VBA development environment VBA > Visual Basic editor (Page 42)

Opening the VBA Project Manager VBA > Project manager (Page 42)

Canceling a long-running VBA macro VBA > Cancel macro (Page 42)

Exports data into the sisNET format Data Exchange > Export in sisNET format (Page 43)

Imports data into the sisNET format Data Exchange > Import in sisNET format (Page 45)

Imports data into the ASCII format Data Exchange > Import (ASCII format) (Page 48)

Printing the current view Print (Page 50)

Selecting the most recently opened files/job

Closing sisNET Close (Page 52)

Task: Select from the “File” menu:
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A popup entry is displayed in Job Manager for each job. The entries can be opened or 
closed using the lateral buttons. An opened job entry contains the following information:

• Job name: Here the displayed jobs can be sorted in ascending or descending order 
in order by names

• Comment: Contains any comment which can be entered by the user

• Type: Indicates whether this job entry relates to an acquisition, planning, import 
or non-graphic job

• Created by: Name of the user (sisNET user) who created the job

• Created on: Date on which the job was created

• Last changed: Date on which the job was last changed

• Currently opened by: Name of the user who has opened the job at present or “-” if the 
job is currently not opened

• Number of objects: Number of objects currently in the job

• Category: indicates the category to which the job belongs

• Map type: indicates whether this is a main plan or a layout plan

• Job ID: Displays the ID of the job assigned by the system

• File name: Contains the file name of the job. The job file is created with this file name 
in the system

The comment can be edited by a click in an opened job entry. No other entries can 
be edited.

The job is opened by double-clicking on a job entry. The conditions for this are that:

• the job is not opened at present by another user

• the job is not alphanumeric

• The user has the authorization to open the job

• the job file is available in the correct directory

By a click on the designation text (Created by or Created on) in an opened job entry it is 
possible to sort the jobs in ascending or descending order according to this information. 
In Advanced mode you can sort by any information. When the Job Manager starts, the 
job entries are always alphabetically sorted in ascending order by job name.

The display order of the job information can be changed by dragging and dropping 
a designation text (e.g. Number of objects). That can be done only in Advanced mode, 
however (See “View > Advanced mode” Page 30). The job information is again displayed 
in the order above the next time the job manager is started.

Job > Create new job…
In general, a new job is created with this function. Deviating from the earlier 
approach (until sisNET 2002), a dialog box now opens first to select the job name, 
the comment and the job type and only then does the entrance into the supply 
area begin by selecting a certain method.
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Job name

The name of the new job is to be entered here. This name may contain any characters 
(except the following special characters ',,/, \?,<:>, *) and is limited in length to 50 
characters. This name does not have anything to do with the name of the dgn file to be 
newly produced by the creation of the job. It is only used to describe the job. A job name 
may be used only once within a volume of data. That is to say, there cannot be several 
jobs with the same name in two different categories of a data volume.

✍ In addition to the job, a comment up to 2000 characters long can also be used.

Category
Here you can select the category to which this job belongs

Map type
Here you can determine the map type (e.g. As-build map, overview), to which the new 
job is allocated.

Job type
All sisNET objects can be processed only in job files. The selected job type decides 
whether the job objects can be edited only in one job or possibly simultaneously 
by several editors in different jobs. The following job types can be selected

• Default jobs

• Planning jobs and

• Import jobs

Default jobs are used for acquiring and editing sisNET objects. All objects in a default job 
can be changed only in the job in which they are located.

Objects in planning jobs, on the other hand, can be edited at the same time in different 
planning jobs.

W Planning jobs are meant for creation of variants or scenarios - their contents can be 
transferred into stock.

It makes sense to decide which of the alternatives is used based on the planned 
processing. For data acquisition and continuation, the default job will be the meaningful 
alternative, while the creation of planning variants and the performance of simulations 
require planning jobs because a range of the data stock is generally modified in different 
ways in this case. The designations of the two types of job were selected for this reason, 
but the use of the jobs designated in this way is not prescribed.
24 sisNET Suite - User Guide



The File menu
Job Manager
Import jobs are used to import sisNET objects that were created and exported by third 
parties into the sisNET format. No UNDO function is possible in these jobs. Import jobs 
can be only stored or discarded completely.

Job > Create new job… > By address
The function “Create new job… > By address” is used to open a new job. The entrance into 
the supply area takes place here via the address (practical if a new service connection for 
a known address is to be created, for example). First the Dialog box “Search by street, 
address”, in which the appropriate street name must be indicated, is opened.

Street name
Here you enter the street name that is to be selected. Which specific attribute in the data 
base is selected depends on the respective system configuration. The annotation texts 
for the input rows and for the box title row are dynamic and can be changed using the 
configuration files.

Entering a percentage sign (“%”) results in a wildcard search, i.e. “%2%” searches for 
buildings whose key attribute includes a 2.

House number
Here you enter the value of a key attribute (usually the house number) for selecting 
buildings on streets. You can configure the attribute that is to be used.

Entering a percentage sign (“%”) results in a wildcard search, i.e. “%2%” searches for 
buildings whose key attribute (e.g. house number) includes a “2”.

OK
Starts the search for objects which meet the search criteria entered. The graphic will then 
be fitted into the view in such a way that the objects found are fully displayed.

Cancel
Closes the dialog box without running a search.

If a correct inquiry was formulated, either an error message appears (if the defined 
address does not exist) or it opens a selection box, in which a list of all found data records 
appears. If several objects fulfill the search criteria, then all data records found appear in 
the selection box. In order to be able to make a unique selection from this box, additional 
attributes that are displayed in this box, with which user can further narrow the search, 
can be defined in the configuration files for the application modules.
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Example: Street name, street key
All data records found that fulfill the criteria of the previous selection box appear in 
the list. The attribute “street keys” is now offered as an additional selective criterion for 
uniquely selecting a data record. One of the data records can be selected with the mouse 
or with the “OK” button. 

OK
Acknowledges the selection made (street name + additional criterion). The function 
“Create new job… > by street” is continued and the selection is displayed.

Cancel
The Dialog box closes and terminates the relevant function.

Create new job… > By object
The function “Create new job… > By object” is used to create a new job. The “Data record 
selection” dialog box, which can be used to formulate the required search query, is 
opened (See “Search... > via object” Page 55). After the Select button is clicked, the “Data 
records” dialog window, from which the relevant object is to be selected, opens if there 
are several hits. If the selected object is a graphic object, the graphic of this object is fit 
into the job map. If a non-graphic object is selected, the new job extends over the realm 
that was represented in the current view when this menu item was activated. The object 
defined by the query is then offered to the user immediately for editing via the data input 
mask. For this to be possible, the defined object of course must not be locked for editing, 
for example because it is in another job for editing.

Create new job… > By object with address
The function “Create new job… > By object with address” is used to open a new job. The 
supply area is entered in this case via a user-selectable object type that has a relation to 
a certain street. First the Dialog box “Search by <Object type name> -> Street”, in which 
the desired object type and the appropriate street name must be indicated, is opened.

Among the relation objects, all those objects come up for which a relational possibility 
has been defined in the schema.
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Create new job… > By rectangle
The function “Create new job… > By rectangle” can be used to select a range of the 
supply area in which one would like to edit data. After job name, comment and job type 
have been defined in the “Create new job” dialog window, a window is to be defined by 
the user. This is done by clicking on the left mouse button. Thus two points are defined, 
which determine the window. The window then appears as a view.

Create new job… > By pool name
You can use the function “Create new job… > By pool name” to select a certain sheet line 
in which you would like to input or change data. When the function is activated, the dialog 
box “Sheet name”, into which the name of the desired sheet line must be entered, appears.

The name of a network file (generic type TYP_NETZ) must be entered as the page name. 
Inputting the name with a %-character as a wildcard is possible.

Create new job… > By update view
With the function “Create new job… > By update view”, a new job in the range of the 
current view can be produced. When the function is activated, the dialog box “Create 
new job” appears, into which the desired Job name, comments and job type must be 
entered.

Job > Open job
The selected job in sisNET is opened by this menu option/button or by double-
clicking on a job entry. The conditions for this are that:

• the job is not opened at present by another user

• the job is not alphanumeric

• authorization to open the job

• the drawing file of the job is available in the correct directory

After the job has been opened, the job manager closes. Exception: The menu option/
button “View > Always keep job manager open” has been activated.

Job > Save job(s)
The selected jobs are saved. Requirement is the authorization to save jobs. 
Several jobs can be selected by pressing the SHIFT or CTRL key.

Job > Discard job(s)
The selected jobs are discarded. Requirement is the authorization for top 
discard jobs. Several jobs can be selected by pressing the SHIFT or CTRL key.
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Job > Display job info
Information on the current job can be displayed this function. Information 
about the objects created or changed in the job appears in various columns 
in the opened view window:

• Date: Contains the date on which the modification was made

• Application module: Contains the name of the application module to which 
the modified object belongs

• Object type name: Name of the Object type that was modified

• MSLINK: MSLINK of the object that was modified

• Action: Indicates the action that was applied to the object

Job > Save current job and continue working on the job
The current job is saved and a new job of the same name is produced in which 
you can continue to work directly

The following information is carried over from the saved job:

• Category

• Map type

• Range of the update view

• Explorer settings

Job > Discard current job and continue working on the job
The current job is discarded and a new job with the same name is produced, 
in which you can continue to work directly

The following information is carried over from the discarded job:

• Category

• Map type

• Range of the update view

• Explorer settings
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Job > Verify
Checks a job for consistency.

Job > Repair
Repairs errors in inconsistent jobs.

View > Display only my jobs
Only the jobs that were created by the currently logged on sisNET user 
are displayed.

View > Display all jobs
All jobs of all users and all categories in the loaded application module 
are displayed.

View > Display only jobs from active category/derived map
Only the jobs of the currently active category are displayed.

View > Display jobs from all categories/derived maps
All jobs of all categories are displayed.

View > Filter job list
All those jobs that contain a certain character string in their job name can 
be displayed

View > Always keep job manager open
Keeps the job manager permanently loaded, even if a selected job has 
been opened.

View > Update job list
The job list is updated.

View > Transfer to derived maps
The interface for transferring the changes to the derived maps is called up.
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Each line of the upper level can be folded out with “+”, in order to find out what changes are 
hidden behind this line. The lines of the upper level can be selected. If at least one line is 
selected, the “Start transfer” button becomes active. If only one line is selected for transfer, 
there is a question as to whether the developed job is to remain open. The option of leaving 
the job opened is recommended if there are still manual changes to be made to the derived 
maps object. The list of changes can be limited to “My changes” or be extended to “All 

changes” with the two buttons  and . If a job has already been generated for a line 
on the upper level or if the current sisNET user does not have an authorization to create 
a job in this category, the line is grayed out and therefore can no longer be selected. The 
grayed-out lines have a tooltip that is displayed when the mouse pointer hovers over such 
a line. This tool tip describes the reason why this line is not selectable.

View > Advanced mode
Advanced mode is switched on or off with this menu option/button. In the 
advanced mode the jobs are represented not as individual entries to be opened 
and closed, but are listed in a table among themselves.

This table can be sorted by a click on a column heading in ascending or descending 
order based on that column. The column order can be changed by dragging and dropping 
column headings. A column heading can be dragged and dropped into the marked area 
above the table for grouping according to a column. 
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In order to remove the grouping, the column heading can be pulled out of the marked 
area and dropped at another place. If several column headings are dragged successively 
into the marked range, then it is also possible to group according to several columns.

Current job…
When a job is opened, the submenu “Current job…” appears in the File menu. The 
following menu options are also available to the user here: Save, Discard, Close, Info, 
Test, Repair. These functions can be applied in the current job. 

Current job… > Save
The current job, i.e. the job that is currently being edited, can be saved with this function. 
All changes made in the job will be transferred into the current volume of data by the 
save. The job will then be deleted and the job name can be used for new jobs.

“Undoing” this action is no longer possible. 

Yes

Selecting the “Yes” button checks whether a consistent transfer of work and changes 
executed in the job is possible. If “Yes” is selected, there are further questions.

No

Selecting the “No” button cancels the the “Save current job” function.
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Yes

After the “Yes” button is pressed, another window appears, which must again be 
confirmed with “Yes”. This selection transfers work and changes executed in the job 
to the current volume of data. “Undoing” this action is not possible; the data would 
have to be fixed manually in a new job. Selecting the “No” button cancels the the “Save 
current job” function. The confirmation with “Yes” opens the file selection box “Log file”, 
in which a path and a file name for a job log to be created and saved can be entered.

By default the path preset in the box points to the working directory of MicroStation or the 
directory defined by the Environment variable SIS_LOKAL. The preset file name for the log 
file is composed of the name of the job file to be saved and an extension consisting of three 
numbers. This extension is assigned automatically by the system and is incremented by 1 
each time based on the largest existing number of files, starting from 000. But only log files 
that contain error messages are saved. For an an action concluded without errors, the 
generated log file is automatically deleted and not saved in the specified directory. “OK” 
confirms the path and file name for the log file, “Cancel” suppresses the creation of a log 
file. If one decides to create a log file, the log file produced is displayed in a list box of its 
own in case of an error message, after performing all system checks.
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The displayed log file provides information about the checks that were executed and the 
errors with which they finished. If errors occurred in the checks (such as inconsistencies 
between graphical and object data records), then the job cannot be saved and 
a corresponding message appears in the log.

Current job… > Save and continue to work
The current job is saved and a new job of the same name is produced in which you can 
continue to work directly

The following information is carried over from the saved job:

• Category

• Map type

• Range of the update view

• Explorer settings

Current job… > Discard
This function can delete the job currently being edited. Work and changes executed 
within the job are lost. A dialog box appears with a warning asking whether the job 
should actually be discarded.
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Selecting the “Yes” button conforms the intention, and “No” cancels the action without 
discarding the job. Confirmation with “Yes” opens a second warning box, which is the last 
chance to cancel the action, or to finally confirm it with “Yes”.

The confirmation with “Yes” opens the file selection box “Log file”, in which a path and 
a file name can be created for a log file for the job to be discarded.

By default the path preset in the box points to the working directory of MicroStation or the 
directory defined by the Environment variable SIS_LOKAL. The preset file name for the log 
file is composed of the name of the job file to be saved and an extension consisting of three 
numbers. This extension is assigned automatically by the system and is incremented by 1 
each time based on the largest existing number of files, starting from 000. But only log files 
that contain error messages are saved. For an an action concluded without errors, the 
generated log file is automatically deleted and not saved in the specified directory. “OK” 
confirms the path and file name for the log file, “Cancel” suppresses the creation of a log 
file. If one decides to create a log file, the log file produced is displayed in a list box of its 
own in case of an error message, after performing all system checks.
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The displayed log file provides information about the checks that were executed and the 
errors with which they finished. If errors occurred in the checks (such as inconsistencies 
between graphic and object data record), then the job cannot be discarded and 
a corresponding message appears in the log.

Current job… > Discard and continue to work
The current job is discarded and a new job with the same name is produced, in which you 
can continue to work directly

The following information is carried over from the discarded job:

• Category

• Map type

• Range of the update view

• Explorer settings

Current job… > Close 
The current job is closed. 

Current job… > Inf.
After this menu option is selected, the “Log file” file selection box appears, into which 
a path and a file name for a log file to be created about the information of the current 
job can be entered.
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By default the path preset in the box points to the working directory of MicroStation 
or the directory defined by the Environment variable SIS_LOKAL. The preset file name 
for the log file is composed of the name of the job file to be saved and an extension 
consisting of three numbers. This extension is assigned automatically by the system and 
is incremented by 1 each time based on the largest existing number of files, starting from 
000. “Save” confirms the path and file name for the log file, “Cancel” suppresses the the 
creation of a log file.
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Information about the objects created or changed in the job appears in various columns 
in the opened view window. The following information about the current job can be 
obtained: Date/time at which the job was created, the application module in which 
the job is located, the object type, the ID, the executed action and the pool.

Object type: Contains the long names of the objects created or modified in the job.

ID: Contains the mslink of the specified object.

Action: Indicates the action that was applied to the object.

Pool: Indicates the pool index of the pool file in which this object is stored when the job 
is saved.

Current job… > Test
Checks a current job for consistency.

Current job… > Repair
Repairs errors in the current, inconsistent job.

Category > Change
With the “Change” function, it is possible to “switch” between the individual categories, 
i.e., a category other than the current category can become the active category. A new or 
already available job in this category can then be opened and edited. The following are 
additionally available as additional submenu options: Municipality, District heating, Gas, 
Water, Wastewater, Power, Telecom, Redlining.

Category > Read in category (objects) again
This menu option permits reading in a modified application module resource during 
a current sisNET session. To activate this function, it is necessary that all “Create boxes” 
are closed. The modified resources are available immediately after activation of the 
function and can be used. If the changes in the resource file also concern data base 
tables, then a data base alignment with sisCONF is necessary.

Category > Derived maps
With this menu option it is possible to switch from the display of the main plan to that 
of the municipal overview. This submenu is not available for the “Wastewater” and 
“Redlining” categories.

Information map… > New
A private drawing file can be created via this function It is only possible to work with 
CAD graphics (create, reference, etc.) inside this information map.

The information in this Information map is not stored in pool files by sisNET.
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After the activation of the function a window opens, in which the path and name of the 
drawing file to be created is defined.

The Information map is created and opened with “Save”. “Cancel” terminates the dialog.

Information map… > Open
An already existing information map can be opened via this dialog.
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Save setting
User-specific settings of the current drawing file (e.g. number and position of the opened 
views) are stored by selecting this function, and are once again at the disposal of the user 
the next time sisNET is activated. If it is determined that the saving of such settings is not 
noticed by the system, then one should check the setting in the <username>.upf file in 
the sisNET configuration directory.

Compress file
The job files can be compressed with the function “Compress file” by deleting the UNDO 
buffer. The consequence of this is that the actions executed to that point can no longer 
be canceled. The memory spce savings depends on the number of stored UNDO steps.

Yes

The UNDO buffer is deleted by selecting the “OK” button. Undoing previous work 
procedures is no longer possible thereafter.

No

The “Question” dialog box is closed by selecting the “No” button, without the UNDO 
buffer being deleted or the file compressed.

Batch file > Execute batch file
This menu option opens the “Batch files” file selection box for selecting a sisNET batch 
file to be processed.

sisNET batch files are batch files that consist of a sequence of sisNET and MicroStation 
commands and are executed cell by cell.
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When the function is first activated, the file selection automatically branches to the 
directory path pointed to by the environment variable SISNET_DIR_BATCH. If the user 
selects another directory, then the modified setting for this file selection box is preserved 
and the preset path branches out automatically to the most recently selected setting 
when this function is next activated. sisNET batch files have the extension *.scr by default.

Batch file > Cancel batch file
If an active batch file contains so-called non-batchable MicroStation commands or 
is in a continuous loop, further execution can be canceled with this menu option.

Batch file > Resume batch file
Batch files that contain non-batchable MicroStation commands can be resumed after 
processing such commands via this menu option.

Batch file > Batch file dialog
The “Batch file dialog” menu opens a dialog box that shows all batch files with the 
extension *.scr (for script file) in a list box. Batch files are searched by default in the 
directory pointed to by the environment variable SISNET_DIR_BATCH.
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Edit

The following functions can be executed in the “Edit” menu option

• Refresh list: Updates the displayed list of batch files, if for example further files were 
copied into the selected directory.

• Delete file: Deletes the file selected with the scrollbar.

• Copy file: Opens the file manager to specify the target file into which the batch file 
marked with the scrollbar is to be copied.

• Change directory: Opens the file manager to select a directory in which additional 
batch files can be looked up.

Run

Runs the batch file selected with the scrollbar and processes the commands listed in it. 
This menu option corresponds to the function > Batch file > Execute batch file” in the 
sisNET main menu(See “Batch file > Execute batch file” Page 39).

New

Opens the MicroStation Basic Editor, with which a new batch file can be created.

Edit

Opens the MicroStation Basic editor, with which the batch file selected with the scrollbar 
can be edited.

Resume

Batch files whose execution was stopped via the “Stop” button can be resumed with this 
menu option. This menu option corresponds to the function “File > Resume batch file” in 
the sisNET main menu (See “Batch file > Resume batch file” Page 40).

Stop

Batch files in which the user is requested to make an input or click on a certain place can 
be stopped by means of this button at this point.

Close

“Close” is used to close the dialog box.
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VBA > Macros…
You can use this to execute VBA macros. You can summarize and automate complex 
control workflows in sisNET with VBA macros. You can find more detailed information 
about the possibilities of sisNET VBA programming in the separate documentation for 
sisNET VBA.

VBA > Visual Basic editor
You can open the VBA development environment, in which you can edit, start and 
debug VBA macros, with this option. You can find more detailed information about the 
possibilities of sisNET VBA programming in the separate documentation for sisNET VBA.

VBA > Project manager
This opens the VBA Project manager. With the Project manager you can create, load 
and unload new projects, start macros, etc. You will find more information about the 
VBA Project manager in the relevant section of the MicroStation help.

VBA > Cancel macro
You can use this to cancel a current VBA macro that may have been running for too long.

Data Exchange
It is possible to exchange data from one overall system system between different non-
networked computer locations via an export/import mechanism. An update is possible 
in all directions. An uncomplicated external acquisition can be executed in this way.

Every spatially separated workstation that does not possess direct access to the central 
data base can now be supplied with data by an export. It imports the data, can modify 
it and now can even create an export, which is then imported by the master. Each 
peripheral system and also the central station receives an INSTANCE_ID (defined via the 
Environment variable SISNET_DATA_INSTANCE_ID) to manage the distributed objects. 
The source of each object is registered in the import. For export, the destination of the 
export is indicated. Only the correct recipient can import the data.
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Data Exchange > Export in sisNET format
Selecting the menu option “Data exchange > Export in sisNET format” opens opens 
a dialog box “Settings”, by means of which certain settings can be made for the export.

Export tab

Export mode popup menu

Various export modes can be selected via a popup menu. The following modes 
are possible

1. Export mode Current job: In this mode the currently loaded job is exported.

2. Export mode Fence contents: In this mode only the objects selected via a fence 
are exported.

SISNET_DATA_INSTANCE_ID=ERF1 SISNET_DATA_INSTANCE_ID=ERF2

SISNET_DATA_INSTANCE_ID=MASTER
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3. Export mode By object type: If this mode is selected, then the “Select” dialog box, by 
means of which the objects or CAD elements to be exported can be selected, initially 
opens after the start of the export function.

.

4. Export mode Selection: In this mode the objects previously stored in the Selection 
table by means of a selection are exported.

Input field Export file

The name of the export file is in this line. The name is pre-allocated by default with a file 
name consisting of the name of the current job file, to which the letter x is prefixed and 
which has the Extension *.exp. The Export file is written by default into the directory which 
the Environment variable SISNET_DIR_EXPORT indicates. If this environment variable is not 
set, then the file is written into the directory which the environment variable SIS_LOCAL 
indicates. If the user wants to indicate another directory for the export file than the pre-
defined standard directories, then he can do this by clicking on the button to the right 
beside the input line. Thus the File selection box opens (See “Using the mouse with sisNET” 
Page 16), by means of which any directory can be indicated for the storage of the Export file.

Export files are text files, whose contents and structure are described in detail in the 
Application module configuration manual.

Log file input field

The name of the Log file for export is located in this line. In the log file all export actions 
are logged and noted whether the export procedure was terminated successfully or with 
errors. The name of the Log file is pre-assigned by default as aexp.xxx and the extension 
*ptk, where xxx is a sequential number, incremented in each case by 1, in the directory in 
which the log files are stored. The log files are written by default into the directory to which 
the Environment variable SISNET_DIR_EXPORT points. If this environment variable is not 
set, then the file is written into the directory which the environment variable SIS_LOCAL 
indicates. If the user wants to indicate another directory for the export file than the pre-
defined standard directories, then he can do this by clicking on the button to the right 
beside the input line. This opens the file selection box (See “Using the mouse with sisNET” 
Page 16), by means of which any directory can be specified for the storage of the log file.
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Log files are text files, which have following contents and structure:

Active file: r:\sis_data_2002\sindelfingen\sisnet\dgn\wasser\lokal\jwuk.dgn (14872)
***************************************************************************
Object scale line, creator: SWSI, 569283 exports (modifies)
Object scale line, creator: SWSI, 569284 exports (modifies)
Object situation point, creator: SWSI, 569299 exports (modifies)
Object situation point, creator: SWSI, 569300 exports (modifies)
Object situation point, creator: SWSI, 569301 exports (modifies)
Object situation point, creator: SWSI, 569302 exports (modifies)
Object W-CAD-element, creator: SWSI, 606648 exports (modifies)
Object W-CAD-element, creator: SWSI, 606649 exports (modifies)
Object W-CAD-element, creator: SWSI, 606650 exports (modifies)
Object W-CAD-element, creator: SWSI, 607010 exports (modifies)
***************************************************************************
Export successfully completed!
***************************************************************************

The path and name of the exported file are in the heading, followed by the ID of the 
exported job.

For each exported object exactly one line follows, in which the long name of the exported 
object, the entity of the creator of the object (defined by the environment variable 
SISNET_DATA_INSTANCE_ID) as well as the mslink of the object on the source system are 
located. The action last carried out to the object then follows (created, deleted or modified).

Options tab

The only option available at present is the possibility of making a schema conversion at 
the same time as the export. The application modules of the exporting and the importing 
system do not have to be identical in this case. However, a special resource fileconvert.rsc, 
which describes the conversion between source and target object, must be available in 
order to use this option. If the option is selected and the conversion resource is missing, 
the error message “File convert.rsc not found” appears in the sisNET message window.

After clicking the “Start” button, the export is executed.

Data Exchange > Import in sisNET format
This menu option is the counterpart of the export menu and can be used to import from 
files exported by another user. The import takes place into an empty job in each case. 
The process of the import is logged. Objects that cause an error are segregated into 
a new ASCII file. This file has the same format as the source file. Thus it can be used 
for another import after clarification of the cause of the error.

If the import is to be canceled, then the job can be discarded.
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A dialog box “Settings” having several tabs, by means of which various settings for the 
export file to be imported can be selected, opens after selection of the menu option.

Import tab

The “Import” tab has several input fields, which can be filled out automatically via the 
system variable or by the user.

Import file input field

The name of the export file to be imported must be entered into this field. By clicking the 
button alongside the input field, the “Export files” file selection box opens and branches out 
automatically to the directory pointed to by the environment variable SISNET_DIR_EXPORT. 
If the export file *.exp to be imported is located in this directory, it can be selected by means 
of the file selection box and is then automatically entered into the input field. In place of 
a single *.exp file to be imported, a list of several files to be imported can also be specified. 
The list file must likewise have the Extension *.exp and contain the file names of the individual 
files to be imported. File lists usually arise during the execution of the EDBS import program.

Log file input field

The name of the log file to be created for the import process is entered into this field. 
The directory to which the Environment variable SIS_LOCAL points is in this file selection 
box by default. “xxyy_imp” is suggested by default as the filename for the log file, where xx 
is adopted as the name from the selected export file and yy stands for the sequential 
number of the log files available in the selected directory. The Extension reads *.ptk. When 
this button next to the input field is clicked, the “Log file” file selection box opens, with 
which the user can specify a path and file name for the output file to be created that differ 
from the default settings. The Log file is an ASCII file, in which all errors that may have 
occurred in the import procedure are logged.

Error file input field

The name of the error file to be created for the import procedure is entered Into this field. 
The directory path to which the environment variable SISNET_DIR_EXPORT points is preset 
in this file selection box by default. By default, <exportjobname>_e1.exp is suggested as 
the file name for the log file. A selection box “Log file”, by means of which the user can 
indicate a path or a file name for the error file to be created deviating from the default 
settings, is opened by clicking the button alongside the input field. The error file is an ASCII 
file and contains the original information about the objects that could not be imported 
from the export file that was to have been imported.
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Options

The following options are available in this tab:

1. Option Target-mslink=Source-mslink: If this option is chosen, the target and source 
mslinks of the objects are identical. This option is practical if fixed mslink ranges were 
designated and assigned in all source and target environments for acquisition.

2. Option No object update: Objects that are already available in the data base to be 
imported are not updated with the import if this option is selected. This option is 
practical, for example, if an export job is to be imported only for test purposes and the 
imported job is to be discarded afterwards. An update of the object type table is not 
necessary in that case.

3. Option of ignoring errors during the reading of the target graphic: If an object to be 
imported is available already in the target stock, then the program checks whether 
the graphic and data record for this object can be read error-free. If this is not the 
case, then these objects cannot normally be imported. An import is possible even 
in such cases only if this option is chosen.

4. Option of ignoring errors during the reading of the target DB data: If an object to be 
imported is available already in the target stock, then the program checks whether 
the graphic and data record for this object can be read error-free. If this is not the 
case, then these objects cannot normally be imported. An import is possible even 
in such cases only if this option is chosen.

5. Option Only log errors: By default the entire import procedure is logged. One can 
activate this option if one wants to log only the non-imported, faulty objects.

6. Option Do not log relationship errors: The logging of relationship errors can be 
suppressed with this option. This is meaningful only if one knows for sure that 
relationship objects for the objects to be imported are not present and that this 
option will not have undesired impacts on the data stock.
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Job tab

The settings of this tab can be used to import several export jobs at once. To do this, the 
file name of the export job to be imported first is specified in the Initial job name input 
field. With the selection fields “Open new job” or “Open new job for each import file”, 
you can determine whether all export jobs are to imported into only a single new job 
or each export job is to be imported into a separate new job

Cells tab

This register page can be used to determine whether objects or object components 
represented in the graphic by cells are to be scaled with the import or not. If a scale 
factor is indicated, all cells are scaled in accordance with this factor. This option is mainly 
intended to be able to scale objects originating from EDBS data to an appropriate size for 
the import.

The import is started after the “Start” button is pressed.

Data Exchange > Import (ASCII format)
Third-party data can be imported as sisNET objects with this function. The program can 
both create new objects, and update existing. In addition when creating the objects 
relations between objects can be developed. The program can be used thereby also 
for processing tachymeter data.
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The “Import files” file selection box, from which the user is to select the name of the 
import control file, opens after activation of this function

An import control file is a file for describing the data structure of the object data to be 
imported in an ASCII file. This structure is described with a notation especially developed 
for this purpose (see Category configuration manual, description of the import interface)

The import control file is likewise an ASCII file and can be written with any editor that can 
produce pure ASCII text (i.e. without control characters).

The “Import data files” file selection box, from which the user is to select the name of the 
data file to be imported, is opened after the desired import control file has been selected.

The import program IMPRT starts after the desired import data has been selected, 
and imports the data in the manner described in the control file.
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Print
This function is used to print/plot the loaded file. The printing dialog, in which further 
settings can be made, appears after this menu option is clicked.

A preview of the printout is presented in the dialog if you click on the small right arrow:

In order to print with pre-defined plot borders, you use the functions of the “Print 
Preparation” taskbar:

Here you can select from 4 tasks:

With this task you can open the Print Preparation tool bar , 
with which you can very quickly select templates (with the listbox) and the further 
procedure (with the right arrow). 
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With this task your administrator produces a new model in a plot template file. 
You can find details for creating plot template files in the Administration guide.

With this task you start the Print Preparation process with the most recently 
selected template.

With this task you start a multi-plot procedure with the most recently used 
template. In a multi-plot you can create a PDF file that contains the same map window 
for different categories on separate pages.

After selecting a template and starting (via the blue right arrow) the printing/plot field 
is next selected using the mouse cursor. Various settings, such as the specification of 
the scale or the angle of rotation, can also be made via a window. It can additionally be 
determined whether the next border point is to be used under the item “Origin” as the 
origin of the placement. The options “Fine adjustment” and “Show preview” are also 
available. Another input window appears once the printing area has been determined by 
double confirmation of the left mouse button. It offers the possibility of filling the legend 
with text. In the lower area of the window, several free texts can be entered, the function 
value of the scale and the date can be edited and the name of the reviewer can be indicated. 
The upper, larger area of the box displays a preview of the text in the drawing. There is 
either the possibility of confirming the entire legend by clicking the button “All OK” or of 
confirming the individual inputs by pressing the “OK” button. Also an input can be removed. 
The text can be edited subsequently by double-clicking with the left mouse button.

The print preparation process stores its results as another model (with the names 
PrintPrepOutput, PrintPrepOutput-01 etc.) in the current dgn file. By switching to 
the standard model you are again in your sisNET work area.

If you placed the borders of the template, you receive additional post-processing 
functions in the now context-dependent extended Print Preparation taskbar:

This concludes the print preparation process and you can return to the preceding 
sisNET work area.

Dynamic legends with printing templates

To be able to plot a dynamic legend with Print preparation, the plot template must 
contain a special area for the legend:

The legend area must be rectangular and not rotated. The function “Create rectangular 
frame” is used to insert a legend area into the plot template. In the function setting 
dialog, the mode must be set to “Function”, the function to “Dynamic legend” and the 
area to which the legend refers must be adjusted.

An Explorer topic must be active for the legend to appear while plotting. If no topic 
is active, the legend area is not filled.
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Most recent files/jobs
sisNET remembers the 5 most recent files/jobs

Jobs are easily recognized by the preceding “Job:”. This allows the most recently used 
jobs to be reopened particularly easily, even without using the Job Manager.

Close
Thus function terminates the sisNET session. The current process status is automatically 
backed up; it is not necessary to save it separately The work can be continued when 
sisNET is next started and the most recent job is opened if desired.
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3 The Edit menu
The “Edit” menu contains functions for editing and modifying elements and objects and 
for displaying information about those objects.
Task: Select from the “Edit” menu:

Undo, or reverse, activities and commands 
that have been executed

Undo (Page 54)

Undo, or reverse, activities and commands 
that have been executed up until a mark that 
was set previously

Undo to mark (Page 54)

Set an UNDO mark Set UNDO mark (Page 54)

Go to a supply area by searching for objects 
via an address

Search... > via address (Page 55)

Go to a supply area by searching for objects 
via any linking of search criteria

Search... > via object (Page 55)

Go to a supply area by searching for an 
object type with a relationship to a particular 
street

Search... > via object with address (Page 57)

Go to a supply area by defining a window Search... > By rectangle (Page 58)

Go to the supply area via the name of 
a sheet extract

Search... > By pool name (Page 58)

Go to the supply area via a predefined area Search... > By coordinate table (Page 58)

Go to the supply area via predefined 
database queries

Search... > By saved selection queries (Page 59)

The Create submenu is only available if a job 
is active/open. It is used to create all sorts 
of elements.

Create > ... (Page 59)

Query, change or delete information about 
the individual object types in terms of their 
attributes and relationships. Display 
database of internal information, e.g. pool 
tables, ID´s etc.

Object info (Page 81)
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Undo
This function enables you to easily undo individual activities. E.g. Pipes that have been 
created in error can be deleted from the drawing using the “Undo” command. In doing 
this, any database entries relating to this pipe are reset to their initial status, of course. 
A status message appears in the sisNET command window which states that a function 
has been undone. The number of steps that can be undone is specified via the size of the 
“undo buffer” (in the MicroStation application).

Undo to mark
This function offers the same options as the “Undo” function, but here it is not individual 
activities which are undone but all the activities up until a mark which has previously 
been set. Such a mark is set using the menu item “Edit > Set undo mark”.

Set UNDO mark
This function enables you to set an undo mark so that the “Undo to mark” function can 
be used to undo all the actions up until the undo mark set.

Different functions for editing objects 
and text

Tools (sisNET Tools) (Page 85)

Generate derived views on default plans 
and displays

Thematic Analysis > Activate (Page 101)

Exit an active filter and restore the 
default view

Thematic Analysis > Close (Page 117)

Display element information relating to 
the drawing level, drawing colour, line type, 
strength, etc.

(MS)Information (Page 117)

Used to specify the MS locking 
function modes

(MS)Locks (Page 118)

Used to specify the MS snap function modes (MS)Snap function mode (Page 118)

Task: Select from the “Edit” menu:
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Search... > via address
Opens the “Search for street, address” dialog box which you can use to search for objects 
by entering addresses.

Street name

Here you enter the value of a key attribute for selecting streets. You can configure the 
attribute that is to be used. So the annotation texts for the input rows and for the box 
title row are dynamic and can be changed using the configuration files.

Entering a percentage sign (“%”) results in a wildcard search, i.e. “%abc%” searches for 
streets whose key attribute includes the string “abc”.

House number

Here you enter the value of a key attribute (usually the house number) for selecting 
buildings on streets. You can configure the attribute that is to be used.

Entering a percentage sign (“%”) results in a wildcard search, i.e. “%2%” searches for 
buildings whose key attribute includes a “2”.

OK

Starts the search for objects which meet the search criteria entered. The graphic will 
then be fitted into the view in such a way that the objects found are fully displayed.

Cancel

Closes the dialog box without running a search.

Search... > via object
Opens the “Data record selection” dialog box which can be used to formulate the 
required search condition. Elements can be selected based on particular conditions 
(criteria). The elements found when the function is executed can then, firstly, be 
displayed in the graphic or the attributes of the object found can be displayed. 
When the function is selected, the following window opens:
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The box has the display fields and buttons which will be explained below.

Categories

In this list box you can select from the categories defined in the current configuration. 
Depending on the category selected, the objects belonging to it are displayed in the 
“Objects in category” list box.

Objects in category

In this list box, you select an object type for which you wish to make a data record 
selection.

Attributes

The available database attributes (columns) in the selected object type are listed here. 
For each row in the search expression, one of these attributes must be linked to 
a comparative value by a condition.

Condition

Here you can select from predefined condition types. The following relational operators 
are available:

< smaller than

<= smaller than or equal to

= equals

>= greater than or equal to

> greater than

!= does not equal

like equals for strings (with % to be used as a placeholder)

not like does not equal for strings

is(NULL) Has the attribute not been given a value?

is not(NULL) Has the attribute been given a value?

Comparison value

Here you enter a comparison value (numeric or text) that matches the attribute type.
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Link

If more than one search condition is to be linked together, the type of link can be 
specified here (and and or).

SQL expression

From the search conditions you have entered, an SQL expression which is valid for the 
database will be generated and displayed here. Each search condition equates to one 
row in this window. Search conditions can be added and deleted.

Insert

When you select this button, a new search condition is added to the SQL expression.

Delete

When you select this button, the search condition that is currently selected is removed 
from the SQL expression.

Select

When you select this button, the search process is triggered, providing a valid SQL 
expression has been formed. If more than one data record has met the search conditions, 
the data records that were found are displayed in a new dialog box.

After one of these data records has been selected, the view is adjusted to suit the 
relevant object, which is selected.

Cancel

Select this button to exit the dialog. The SQL expression that is currently entered 
is discarded.

Search... > via object with address
The function “Search... > via object with address” is used to search for an object type with 
a relationship to a particular street. First, the “Search for <Object type name> -> Street” 
dialog box opens, where the object type you want and the relevant street name must 
be entered.
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With the relation objects, all those objects come up for which a relational possibility has 
been defined in the schema.

When the street name is entered and the required object type is selected, all the objects 
of that type display which have a relation to the specified street; now you can select one 
of these. The view window skips to the relevant object which is shown selected.

Search... > By rectangle
You can use the “Search... > By rectangle” function to select an area in the supply area 
where you want to view data or query information. When the function is selected, the 
supply area displays in overview (similar to the monitor function). The user is then 
prompted to define a section for which, then, the relevant ground and network maps 
are loaded.

Search... > By pool name
You can use the “Search... > By pool name” function to select a particular section of the 
sheet where you want to view data or query information. When the function is selected, 
the “Page name” dialog box appears in which the file name of the required sheet section 
must be entered.

The name of a network file (generic type TYP_NETZ) must be entered as the page name. 
You may optionally enter the name with a % sign as a wildcard.

Search... > By coordinate table
You can use the “Search... > By coordinate table” function to select an area in the supply 
area where you want to view data or query information. When the function is selected, 
the “Page name” dialog box appears in which the name of the required area (sheet 
section) must be entered with predefined corner coordinates.

This sheet section name and the assigned corner coordinates must be saved in a separate 
table (default name: COORD_LOOKUPTAB). These sheet sections do not need to be 
exactly the same as the sheet sections of the available map types that were entered in 
the pool table. If this table does not exist, this function works in the same way as the 
menu item “Create new job... > By pool name” in the job manager.
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Search... > By saved selection queries
A dialog opens which enables one or more predefined database queries to be listed. The 
results of the queries can be used to go into the supply area. For further explanations, go 
to Object Search (Page 144).

Create > ...

The “Create” submenu contains functions that can be used to create different objects in 
the graphic or in the database and link them to one another. For example, the functions 
can be used to set construction points and nodes, create pipes, place built-in parts in 
pipes, etc.

The “Create” submenu is only available if a job is open.

The functions found in the “Create” submenu depend on the object class model created 
in sisNET, so they are specific to each company. This chapter, therefore, only describes 
the menu items which are identical in every installation (set CPs and nodes, and create 
dimensionings). The main procedure and the menus which are involved in creating 
objects are also described. 

Basically, when you are creating and editing sisNET objects, you are supported by 
AccuSnap. This means that snapping geometries has become context-sensitive. This 
means that the user can only snap geometries which are permitted for the specific 
operation.

In each case, the “Create” popup menu displays the names of the object classes which 
have been defined in the underlying data mode.

Task: Select from the “Create” menu:

This function is used to place construction 
points in the drawing

Construction point (Page 60)

This function is used to create nodes Node (Page 60)

This function is used to dimension existing 
points or generate construction points with 
dimensioning

Dimensioning (Page 60)

A special module for creating stretches of 
cabling and create the relations to bus bars

Create stretches of cabling using the KSTR user module 
(Page 66)

A module for creating route cross sections in 
the ELECTRICITY category

Creating route cross sections (Page 67)

A function for creating any objects in an 
object class

Create an object in a class (Page 73)

Special methods are available for creating 
line-shaped objects 

Special methods for creating line-shaped objects (Page 77)
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Construction point
The “Construction point” function is used to set construction points in the drawing file 
which are then required later on to design pipes or other objects.

When the function is selected, the sisNET command window displays the prompt “Enter 
point”, and construction can be entered anywhere in the drawing file with the mouse’s 
Data button. Construction points only have a graphical appearance, but no actual data 
record in the database.

Node
The “Node” function is used to create nodes (and construction points) which are required 
later on to design other objects. In line with the object class model created in sisNET, the 
nodes may have an actual data record and relations to other objects which are to be 
defined in the function workflow.

Dimensioning
The dimensioning function holds several dimensioning objects

• Orthogonal dimensioning (Orthogonal dimensioning (Page 60))

• CP with dimensioning (CP with dimensioning (Page 63)) and

• Dimension line (Dimension line (Page 63))

• Tie distance (Dialog Dimension Value für a tie distance (Page 66))

which are, in turn, partly made up of different parts.

When the function is selected, the “Create” dialog box opens, in which the user can select 
the dimensioning object they want and which they can create with the “Start” button.

The procedure for the three dimensioning types is explained below.

Orthogonal dimensioning

The “Orthogonal dimensioning” function is used to orthogonally dimension any points 
in relation to a base point (the dimensioning source). When the function starts, the user 
is prompted to click the base point. Once the base point has been selected, the base line 
direction must be selected. This is done by clicking any other point. The base line is then 
the connection between the base point and the last point selected. When the base line 
has been specified, the user is prompted to click the point to be dimensioned. When the 
point to be dimensioned has been selected, other points can be clicked which are also to 
be dimensioned. If no other points are to be dimensioned, the Reset button cancels the 
action and the dimensioning of the selected points is finished.
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So a dimensioning always consists of the base point, a base line and one or more 
dimension lines. The relevant terms are explained in the drawing above. The terms in 
brackets are the relevant object names in the sisNET category. The dimension values 
in brackets are parts of the dimension line. The brackets indicate that the system has 
calculated these dimension values and the user has not subsequently edited them. 
Dimension values in brackets are associative, i.e. if the base point is moved, the 
dimension values are automatically corrected. The user can specify the choice between 
associative and non-associative dimensioning, details about placing the dimension 
values, the number of decimal places, the distance the dimension values are from the 
dimensioning lines, etc., in a settings box. This is activated via Misc > Settings box > On.

Base point (Ortho. dimension)

Base line (Object part Ortho. dimension)

Dimension line

of a dimensioned point

Angle symbol (Object part dimension line)

(Object part dimension line)

(Object part dimension line)

Direction arrow
(Object part Ortho. dimension)

Ordinate value

Abscissa value
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The fields in the settings box mean the following:

• Decimal places: specifies the number of decimal places required for the 
dimension values.

• Standard abscissa the value entered specifies whether the abscissa value for the base 
point (source) has a value that is different to 0. If it does, the value specified is added 
to all the ordinate values as an offset.

• Base distance: the value entered specifies the distance the dimension value is from 
the dimension line in main units (usually m).

• Override dimension values: If this field is activated, once the dimensioning has been 
created the “Dimension Values” dialog box appears, which the user can use to specify 
whether, for the dimension values, he would prefer the CAD dimensions calculated 
by the system or his own dimensions (Dialog Dimension Value (Page 64)). This dialog 
opens for every new dimension line if the “Override dimension values” option 
is selected.

• Node at end point: If this field is activate, after the dimensioning has been created 
the “Warning” dialog box appears in which the user is asked whether a node is to be 
created or not in the point to be dimensioned. Selecting OK to confirm creates a node, 
while the “Cancel” button aborts the creating of a node. The “Warning” dialog box 
appears as many times as the dimensioning created has dimension lines. So, for every 
point dimensioned within a dimensioning, the user needs to decide separately 
whether a node is to be created in the dimensioned point or not.

• Relation to node: If, in generating the dimension line, a node, a node has been 
generated at the dimensioned point and this field is selected, a relation from the 
dimension line to this node is created.

• Measure at direction point: a dimension line is created for the direction point with 
the abscissa value of the direction point. 
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The “CP with dimensioning” function is used to create construction points with 
dimensioning. When the function starts, the user is first of all prompted to click the base 
point of the dimensioning (source). Once the base point has been selected, the base line 
direction must be selected. This is done by clicking any other point. The base line is then 
the connection between the base point and the last point selected. When the base line 
has been specified, the “Dimension Value” dialog box appears in which the abscissa and 
ordinate distance of the construction point to be dimensioned are queried (Dialog 
Dimension Value (Page 63)).

When the coordinate values entered are confirmed by OK the user is prompted to click 
the page (relating to the base line) on which the construction point to be generated is to 
be set. After the page has been selected, the user can enter more coordinates for other 
construction points and select the related page for each one. If no more construction 
points are to be generated, the function is ended using the X button in the “Dimension 
Value” dialog box and the construction points that have been selected are generated 
with the relevant dimensioning.

Dialog Dimension Value

The abscissa and ordinate distance of the construction point to be generated from the 
base point of the orthogonal dimensioning can be entered in this dialog:

The abscissa value is the distance of the construction point from the base point in 
the direction of the base line in main units (usually m), while the ordinate value is the 
distance of the construction point to be generated from the base line in the selected 
abscissa value.

W The dimensions for the construction points are created as real dimensions, so they are 
not adjusted when the base point is moved or the orthogonal dimension is rotated.

Dimension line

The “Dimension line” function is used to generate other dimension lines within an 
existing dimensioning. When the function is selected, the user is, first of all, prompted to 
click the point that is to be dimensioned anew and then click the base line of an existing 
dimensioning. The point selected is then dimensioned with the new dimension line.
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Dialog Dimension Value

The user can use this dialog to specify whether, for the dimension values, he would 
prefer the CAD dimensions calculated by the system or his own dimensions. 

The user can enter their own values in the “Real dimension” input fields. If the user 
selects the “Real dimension” button, the values entered in the “Real dimension” input 
fields are taken, while if they select the “CAD dimension” button the CAD dimensions 
calculated from the design are adopted. 

For each dimension line generated, users can decide seperately whether they wish to 
use the CAD dimension or their own dimension.

W As was stated in the description of the orthogonal dimensioning, real dimensions are 
not associative, so they are not adjusted if the base point is moved or if the orthogonal 
dimensioning is rotated.

Tie distance
The “Tie distance” function is used to dimension the distance between any two points. 
When the function starts, the user is prompted to click the starting point of the tie 
distance and then the end point. After confirming the end point selected, the “Define 
Dimension Value” dialog opens if the “Real dimension” option is selected. Here the user 
can correct the dimension value and have it output as a real dimension or as an 
associative CAD dimension. If the “Dimension value correction” option is not selected, 
the dimension value is generated as an associative CAD dimension. If the “Relation to 
node at the end points” option is selected, relations are also generated to nodes at the 
start and end point of the tie distance (if there) when the new tie distance is generated.
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The drawing above shows a tie distance between a pipe and the corner of a building. The 
dimension value in brackets is part of the dimension line. The brackets indicate that the 
system has calculated this dimension value and the user has not subsequently edited it. 
Dimension values in brackets are associative, i.e. if one of the two end points of the tie 
distance is moved, this dimension value is automatically corrected. The user can specify 
the choice between associative and non-associative dimensioning, the number of 
decimal places and the distance the dimension value is from the dimensioning line in 
the settings box for the tie distance.

The fields in the settings box mean the following:

• Decimal places: specifies the number of decimal places required for the 
dimension values.

• Base distance: the value entered specifies the distance the dimension value is from 
the dimension line in main units (usually m).

• Override dimension values if this field is activated, once the dimensioning has been 
created the “Define Dimension Value” dialog box appears, which the user can use to 
specify whether, for the dimension value, he would prefer to have the CAD dimension 
calculated by the system entered, or his own dimension (e.g. from an existing plan) 
(See “Dialog Dimension Value für a tie distance” Page 66).
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• Generate relations to nodes at the end points: if there is a node at the end points 
of the tie distance, the tie distance creates a relation to this node (if this relation is 
permitted in the category).

• Save settings as group settings: if this option is activated, the settings for the current 
object type are saved for the user’s user group.

Save settings as default: if this option is activated, the settings for the current object type 
are saved as general default settings.

Dialog Dimension Value für a tie distance

In this dialog, the user can correct the dimension value for the tie distance that is 
currently being created:

The user can enter their own value in the “Real dimension” input field. If the user selects 
the “Real dimension” button, the value entered in the “Real dimension” input field is 
taken, while if they select the “CAD dimension” button the CAD dimension calculated 
from the design is adopted.

W As was stated in the description of the tie distance, real dimensions are not associative, 
so they are not adjusted if the end points are moved.

Structurally engineered dimensioning

Document

Create stretches of cabling using the KSTR user module
In electricity categories, stretches of cabling can be generated using the KSTR user 
module. The cabling can be created using a guide created beforehand with the CABLE 
program, or placed flexibly. The user module can only be activated for the action 
ACTION_NEW_ELEM and the action times 11 (ACTION_TIME_CREATE_GRAFIC) and 12 
(ACTION_TIME_CREATE_REL) (see also the guide to category configuration: The Hook 
user module).

The user module has 5 parameters, the meaning of which is determined by their order.
Parameters table for the KSTR module

Parameter Meaning

Object short name 1 Short name of the connection point object

Attribute name 1 Attribute name of the connection point number 
(connection point attribute)

Attribute name 2 Attribute name of the ID: Connection is 
allocated Y/N (connection point attribute)

Object short name 2 Short name of the bus bar object which this 
cable can be connected to

Attribute name 3 Attribute name for the number of connections 
on the bus bar (bus bar attribute)
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The following example shows the selecting of the module in an application module 
resource file for two different action times.

{{0, OBJ_ACT_USER_MODUL, ACTION_NEW_ELEM},
"11, 0, 0, 0,kstr,ST_ASP APNR BELEGT NS_SAS AZA,"},
{{0, OBJ_ACT_USER_MODUL, ACTION_NEW_ELEM},
"12, 0, 0, 0,kstr,ST_ASP APNR BELEGT NS_SAS AZA,"},

Action time 11 is activated before the first point in the stretch of cable is clicked. The user is 
prompted to click a guide. If clicking a guide with the Reset button is rejected, the user has 
to click the first point in the cabling to be generated and action time 12 becomes active.

The user module is mainly used to generate the topologically correct connection of the 
cable to the bus bars if there are such bus bars at the beginning or end of a stretch of 
cable. If the stretches of cable are being generated using special guides (CABLE), these 
guides must intersect the bus bars so that connection points can be generated on the bus 
bars. If the cables are generated directly, without using guides, the bus bars that are to 
be connected need to be clicked with the Tentative button (snap mode: next point) so 
that connection points can be generated on the bus bar.

Creating route cross sections

The route cross section object is a module used to display attribute values for the pipe 
objects in a route. This module is particularly useful on routes where a lot of pipes have 
been laid closely together (e.g. in the electricity segment), because the distance between 
these pipes is usually not enough to be able to label each individual pipe with the 
annotation function. Using the route cross section, the annotations for all the pipes 
can then be placed together anywhere outside the spaces between the pipes.

After starting the module, first of all a line is drawn at right angles to the route of which 
a cross section is to be generated. To do this, the user first clicks the “first point in the 
cross section line”, then the “second point in the cross section line” and then the cross 
section can still be moved sideways.

The way the route cross section looks depends on the mode defined in the schema 
(mode = SWB, LEONIS, LEONIS2 or interactive).

Mode=SWB

With this, the cable annotations are created in the sequence they occur in the route. 
The fact that you can only see a line beneath the text but not a symbol frame is due 
to the modifying of the TRW cell.
sisNET Suite - User Guide 67



The Edit menu
Create stretches of cabling using the KSTR user module

3

Mode=LEONIS

Besides the annotations, this also displays rectangles for the route positions and larger 
representations of each cable. The display is chosen so that it suffices for an SQD export 
for a LEONIS electricity application module in SICAD.

The entering of the cables in the route does not usually equate to their real positions. 
However, the display in the route cross section should be the same as the position, which 
is why the user needs to define the position of the cable cross section symbols using 
attributes for the cable object. With this, up to 3 cables can go in the same position.

The size of the route cross section must be queried via the application module when it 
is being created.

Mode=LEONIS2

The appearance is similar to that of the route cross section in LEONIS mode, but SICAD-
specific elements are left out. The cables are not given inflexion points at their 
intersection with the cross section line, and neither are any nodes created there.

Mode=interactive

Like LEONIS2, but the position of the cross section objects is interactively queried.

In “interactive” mode there are, depending on the configuration in the application 
module, a large number of variants of the route cross section which are listed here 
by way of example. 
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E.g. conduits can be displayed within conduits:

Another feature is that the cable cross sections whose cables are inside a conduit are 
now only displayed as a number in the conduit cross section if the number exceeds 
a particular limit.
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Other object types can be included when generating the route cross section:

• “Cover panel”

• “Cover panel cross-section”

• “Vertical separation”

• “Separation cross-section”

• “Floor panels”

• “Floor panel cross-section”

The graphic representations of the real world objects are spaces, while cells are used for 
the display in the route cross section.
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Configuring the modules

For the route cross section to work properly, the module has to be configured. When the 
module is selected for the first time in an application module, the configuration program 
begins automatically. In this, the user has to specify which objects in the application 
module are the route, the pipe objects and the cable cross-section object. The application 
module objects are assigned to these object types using a selection box in which the user 
selects the relevant application module objects and uses the “Add” button to add them to 
the current object type in the configuration.

Definition of the route object:

Definition of the pipe objects:
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Definition of the cable cross section object:

If a configuration is subsequently changed, the configuration box for the route cross 
section has to be switched on in the Create box.

Then, when the Start button is selected, the configuration box opens and can be used 
to add to, change or delete the settings made previously.
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Create an object in a class
The “Create” menu enables you to create all the objects defined in the selected category. 
Because the objects that are to be created in this way depend on the company-specific 
application module, the menu items which appear under the “Create” menu also differ 
accordingly. However, the flow of the program’s individual functions and the systematic 
structuring of the menu is the same for all the application modules.

The individual menu entries in the “Create” menu are derived from the object classes 
defined in the category selected. I.e. there is an entry in the menu for every object class. 
When a menu item is selected, a dialog box opens in which the user has to select an 
object that is to be created.

“Create” dialog box

The “Create” dialog box contains several pulldown menus which can be used to make 
different settings.

The pulldown menu “Obj. Settings”

This menu contains various settings which can be taken into account when creating 
an object.

Obj. Settings > Relation box > On

When an object is being created, the relevant relation box for the selected object class 
opens (See “Dialog box Show relations dialog” Page 84). After selecting an object, the 
Data button on the mouse can then be used to select a relevant element (e.g. street 
name, address, etc.) to which the object is to have a relation.

Obj. Settings > Relation box > Off

The relation box described above does not open when an object is being created.

Obj. Settings > Relationship list > On

When an object is being created, the relationship list for the relevant object opens (See 
“Dialog box Relations <Object name>” Page 83). It lists all the relationships created from 
the object.
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Obj. Settings > Relationship list > On

The relation box described above does not open when an object is being created.

Obj. Settings > Identify containing object > auto

When an object is being created, an automatic search is run for objects to which 
a relationship is to be created. E.g. the relationship to a manhole can be created if 
there is a stop point in it.

Obj. Settings > Identify containing object > man

When an object is being created, the relationships to sensitive objects (see above) 
are not created automatically, but rather, the user defines them manually.

Obj. Settings > Form > On

After an object has been created in the graphic, the data input mask in which the relevant 
fields (attributes) are to be populated with real values for the object, opens immediately 
(See “Data input mask” Page 78).

Obj. Settings > Form > Off

The form for entering the real attribute values for the object does not open. The values 
for the object created beforehand are automatically applied, or the current values for 
e.g. the coordinates are applied.

Obj. Settings > Annotations > On

When you are creating an object, you have the option of generating an annotation 
for the object in the same work step. If the “Annotations > On” option is selected, 
the selection box for annotations appears at the relevant moment.

Obj. Settings > Annotations > Off

If the “Annotations > Off” option is selected, no annotations are generated while the 
object is being created. However, you can create an annotation afterwards using sisNET’s 
“Place text” tool.

The “Node settings” pulldown menu

When many objects are being created, a node is also generated in the job at the same 
time. You can use this pulldown menu to select the following settings for the nodes 
generated in the job.

Node settings > Show relations dialog > On

When a node is being created, the relation box for nodes opens. After selecting a node 
type, the Data button on the mouse can then be used to select a relevant element (e.g. 
street name, address, etc.) to which the node is to have a relation.
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Node settings > Show relations dialog > Off

The relation box described above does not open when a node is being created.

Node settings > Relationship list for node > On

When a node is being created, the relations list for nodes opens. The attributes shown 
in the relations list depend on the application module defined.

Node settings > Relationship list for node > Off

The relations list described above does not open when a node is being created.

Node settings > Identify containing object > auto

When a node is being created, an automatic search is run for objects to which 
a relationship is to be created. E.g. the relationship to a manhole can be created 
if there is a node in it.

Node settings > Identify containing object > man

When a node is being created, the relationships to sensitive objects (see above) are not 
created automatically, but rather, the user defines them manually.

Node settings > Show attribute editor > On

After a node has been created in the graphic, the form in which the relevant fields 
(attributes) are to be populated with real values for the node opens immediately.

Node settings > Show attribute editor > Off

The form for entering the real attribute values for the node does not open. The values for 
the node created beforehand are automatically applied, or the current values for e.g. the 
coordinates are applied.

Node settings > Annotation placement > On

When you are creating a node, you have the option of generating an annotation for the 
node in the same work step. If the “Annotations > On” option is selected, the selection 
box for annotations appears at the relevant moment.

Node settings > Annotation placement > Off

If the “Annotations > Off” option is selected, no annotations are generated while the 
node is being created. However, you can create an annotation afterwards using the 
toolbox’s “Place text” function (See “sisNET Tools > Annotation” Page 94).

The “Misc” pulldown menu
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The “Misc” pulldown menu provides the following possible settings in the Create box:

Misc > Save settings

When this menu item is selected, all the settings made in the pulldown menu are saved in 
a user-specific file objxxx.yy and they remain in effect until the user deletes them again.

Misc > Revert to default settings

When this menu item is selected, the settings a particular user has saved for this 
Create box are deleted again and the default settings defined in the application module 
are applied.

Misc > Generate child object > None

If the intention for a particular object is, in the application module, that a particular other 
child object is generated when this object is being generated, the user can switch this 
option off by selecting this menu item.

Misc > Generate child object > <Child object name>

If the intention for a particular object is, in the application module, that a particular other 
child object is generated when this object is being generated, the long name of the 
planned child object appears here.

If there are non-graphic objects in the application module which might have a relation to 
the object which is being created, the long names of these objects also appear here and 
they can be created at the same time as the main object by selecting this menu item.

Misc > Linking... > On

If the “Linking > On” option is selected, as soon as the first object has been created the 
Create function for this object automatically restarts and more objects of this type can 
be generated, until the function is cancelled with the mouse’s Reset button.

Misc > Linking... > Off

If the “Linking > Off” option is selected, the Create function is cancelled once the creating 
of the first object is complete. If additional objects of this type are then to be created, the 
Create function will need to be restarted.

The default setting for whether linking is switched on or off when an object is being 
created is specified in the application module.

Misc > Creation modes

If different creation modes are intended (OBJ_ACTION_ERZGMODUS) for the object to 
be created in the application module, the intended creation modes (Normal, Import 
geometry, etc.) appear here and the user can select them.

Misc > Option 1, 2 OR 3

If other options for generating objects are intended (for example, when creating objects 
via user modules), these options can be selected here.

Object

If the class selected in the “Create” menu contains more than one object type, the user 
can select the object type they want from the object types offered in the pulldown list.

If there are no selection options, i.e. the pulldown list only holds one element, the 
function to create this object type starts immediately. Depending on the type of object to 
be created (graphic or non-graphic) and the relations defined in the application module, 
the sisNET message line now prompts the user to do the other actions required.
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Start

If there was more than one object type in the class selected in the “Create” menu, after 
selecting the object type they want from the pulldown menu the user must click the 
“Start” button to begin the function for creating the required object.

Cancel

If the user selects the “Cancel” button, the function is aborted and no new elements/
objects are created.

Special methods for creating line-shaped objects
Special methods are available for creating line-shaped objects which can greatly simplify 
the designing of such objects in certain cases. For example, in practice it is often the case 
that pipes are laid at a particular distance parallel to the kerb. sisNET now provides 
a suitable method which enables such pipes to be created with a single mouse click 
without having to laboriously and individually design each of the pipe’s inflexion points.

To be able to select the required methods for creating such line-shaped objects, another 
box for selecting the methods appears in addition to the usual Create box.

Now, using the selection button provided in this box, the user can select different 
methods for creating the line-shaped object. Some of the possible methods can also 
be combined with different variants. Another dialog box opens which the user can use 
to select the required variants.

The following methods are available

1. Start points (default method)
This method is the default method, in which mouse clicks specify the startpoint, 
endpoint and all the intermediary points of the line object.

2. Parallel to path
Selecting this method generates the line-shaped object in parallel to an existing 
polyline. It makes no difference here whether the polyline is a sisNET object or a pure 
CAD graphic. First of all, the user is prompted to click on the startpoint of the required 
polyline, and then on the required endpoint. After selecting the endpoint, the path 
selected appears in the specified highlight colour and the user has to confirm this path 
with the Data button or use the Reset button to have the system search for other 
possible paths between the startpoint and the endpoint. When the displayed path 
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has been confirmed, the object that is to be created appears at the cursor and can 
be generated at a required distance in parallel to the selected path. The required 
distance can either be fixed by checking the “Distance” selection field and entering 
a value in the input field, or specified flexibly using the mouse. There are various 
variants of this method which can be selected by checking the relevant selection field. 
The following variants are possible

• Add end segments: After the object has been generated, the endpoints remain 
hanging on the cursor and can be extended as the user wishes. If no extension is 
required, the Reset button can be used to cancel the process.

• Extend to intersection This option enables, in the case of an object generated in 
parallel to an existing line, the last segment of this object to be extended, with a freely 
selectable other line, up to an imaginary intersection.

• Extend end segments: This option enables an object generated in parallel to an 
existing line to be extended as far as the user wishes beyond the endpoints in the 
direction of the end segments.

• No extension: This option generates the object in parallel to the selected line with the 
same length as the source line, and no extension is planned while it is being created.

3. Use Element
With this method, the user is prompted to click a line-shaped element which is then 
used to generate the required line-shaped object. This method can also be combined 
with the variants outlined for method 2.

4. Use Segment
This method is like method 3 except that, instead of the element (object) that has 
been clicked, only the segment of this line (between 2 inflexion points) that is 
currently clicked is used to generate the object. This method can also be combined 
with the variants outlined for method 2.

5. Parallel to element
This method is like method 3 except that the object is not generated superimposed on 
the selected element, but in parallel to it at a definable distance. This method can also 
be combined with the variants outlined for method 2.

sisNET saves the choice of a particular method in the object resource file objxxx.yy so 
that every method selected in a particular category for a particular object by a particular 
user remains active until that user explicitly selects a different method in this category 
for this object.

Data input mask
When creating and when changing an object’s attribute values, during the course of the 
action an input mask (or object editor) opens in which the relevant real values for the 
object can be entered. Note, here, that the mandatory attributes (red asterisk) have to be 
entered while the optional attributes need not be. After entering the relevant attribute 
values and confirming the dialog box with the “OK” or “Save” button, the attribute values 
entered are saved to the database.

We shall now explain the structure of the data input box and how it works.
78 sisNET Suite - User Guide



The Edit menu
Data input mask
The number and name of the tabs in the data input mask differ according to the category 
and the selected object type. However, the basic layout remains the same. 

The different tabs divide the overview information that is to be entered into separate 
areas. Each tab provides a number of attributes for which the values either need to typed 
in manually or selected using a list of options.

Any changes made can be saved using “Save”, in which case the window does not close. 
“Close and save” and “OK” also save the entries but the window then closes automatically. 
“Cancel” discards the changes and the window closes with no save procedure.

File

The “File” menu provides the following functions: “Save”, “Cancel” and “Close and Save”. 
These equate to the three buttons “Save”, “OK” and “Cancel” in the lower right of 
the window.

Layout

The “Layout” menu provides access to three selection options: “Edit current layout”, 
“Edit other layout” and “Select layout family”.

The appearance of the currently opened file input mask can be changed using the “Edit 
current layout” function. When the function is clicked, the “Object editor - Layout 
designer” window opens.
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The appearance of layouts that have been saved for file input masks can be changed 
using the “Edit other layout” function. When the function is clicked, the “Layout file 
selection” window opens. The default path points to the ObjectEditor directory in the 
project folder. The available layout files (*.xml) can be selected there. However, the only 
layout files that can be edited are those which match the same object type as that in the 
open data input mask. “Open” opens the selected layout file for editing, while “Cancel” 
aborts the action.
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The “Select layout family” function enables a layout family in the same way as with the 
“Edit other layout” function.

Object info
Selecting this function opens a dialog box called “Object Info”. This dialog box enables 
users to view, change and delete information about the individual elements held as 
objects in the database. Aswell as the open dialog window, the prompt “Identify object!” 
appears in the status row in the sisNET command window. Then, when an object is 
clicked, the information associated with the selected object displays in the dialog box.

The dialog box has a number of function buttons which will now be explained.

Select element in map

Selecting the “Select element in map” button enables individual elements to be selected. 
The selected elements display in the selected highlight colour. At this point, the relevant 
buttons in the “Object Info” dialog box are activated and can be selected. After selecting 
the “Select element in map” button, the status message “Identify object!” also appears in 
the sisNET command window.
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Search object in the database

Selecting the “Search object in the database” button opens the “Database Selection” 
dialog box which the user can use to search the database for those objects that have 
no graphic representation (See “Search... > via object” Page 55).

View attributes

Selecting the “View attributes” button displays the data input mask (See “Data input 
mask” Page 78) for the selected object, where all the database attributes for the selected 
object can be viewed.

Edit attributes

Selecting this button opens the same window as with the “View attributes” button. 
The difference between the two buttons is that, in the case of “View attributes”, the 
database attributes are only displayed, and cannot be changed. When the window 
is opened with the “Edit attributes” button, the database attributes may be 
retrospectively changed.

View relations

Selecting the “View relations” button displays all of the selected object’s existing 
relations in the box “Relations <Object name>” (See “Dialog box Relations <Object 
name>” Page 83).

Edit relations

Selecting the “Edit relations” button opens the relations list, as is the case with the “View 
relations” function. The relations box (See “Dialog box Show relations dialog” Page 84), 
where all the potential relationship objects for the current object are entered, also 
opens. This box can be used to create additional relations or delete existing ones.

Zoom to object geometry

Selecting the “Zoom to object geometry” button fits the selected object into the active 
view, i.e. the rectangular area is automatically selected so that the object displays at 
a sensible size (e.g. in the case of a pipe, the pipe from the startpoint to endpoint).

Delete object

Selecting the “Delete object” button deletes the selected object. This also deletes all the 
relations connected to the object and any objects (e.g. nodes), both in the graphic and in 
the database.

Object history

The object history first needs to be activated:

The history object type is activated in the application module via the line 
{{0,8,0},"N_[OBJEKTTYPKURZNAME]_HIST"}, where [OBJEKTTYPKURZNAME] needs 
to be replaced by the object’s short name.

If an object with an activated history is changed (graphic or object data), the history 
is created (object data and graphic) when the job is created with this object.

When the object history is selected, a selection list appears with all of the object’s stati 
throughout its lifetime. Only attributes that have been changed are displayed. So you can 
use this to temporarily display the object’s historic stati in a view.
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Information about the object geometry

Selecting the “Information about the object geometry” button opens the MicroStation 
box for element information and displays the information about the selected graphic 
element which is customary in MicroStation (See “(MS)Information” Page 117).

Dialog box Relations <Object name>
This dialog box has two slightly different versions, depending on whether it was opened 
using the “View relations” button or “Edit relations”. In the “View relations” function it 
looks like this:

A scroll box in the window lists all the objects which have a relation to the selected object.

Object

Beneath the “Object” header there is a list of the long names of the objects found which 
have a relation with the selected object.

ID

Beneath the “ID” header is a list of the primary keys (mslink) of the objects found.

DB attributes

When the “DB attributes” button is selected the data input mask for the relation object 
selected with the scroll bar opens in “View mode”, which displays the attributes of the 
selected relation object (See “Data input mask” Page 78).

Graphic

Selecting the “Graphic” button the relation object selected with the scroll bar is “fitted 
into” a newly opened window and displayed.

Selection Tool

This function copies the selected object straight to the selection tool (See “Selection” 
Page 131).

DB Edit

When the “DB Edit” button is selected the data input mask for the relation object selected 
with the scroll bar opens in “Update mode”, in which the attributes of the selected 
relation object are displayed and can be changed (See “Data input mask” Page 78).
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In the “Change relations” function the relations list looks like this:

The “Delete” button is there instead of the “DB Edit” button. This can be used to delete 
the relation selected with the scroll bar.

Close

Selecting the “Close” button closes the relations list.

Dialog box Show relations dialog
The relations box opens for the relations list if the “Edit relations” function has been 
selected in the “Object Info” dialog box. The relations box lists all the objects that might 
potentially have a relation with the selected object.

Settings

The Settings menu has two settings:

• Relationship list: opens the “Relationship list” box if it is not yet open.

• Database selection…: opens the data record selection box (See “Search... > via object” 
Page 55) which can be used to select a specific relation object. This function is 
particularly useful if relations to non-graphic objects are to be created.

class

Beneath the “Class” header, in the scroll box, there is a list of the long names of the 
objects to which the current object can have a relation.

Objects

Beneath the “Objects” header there is a list of the long names of the objects to which 
the current object can have a relation.
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Create

The “Create” button is used to create a new relation and is activated after a particular 
object type has been selected from the list of objects and either the relevant object has 
been clicked in the graphic or selected using the database selection. Clicking the button 
creates the relation and enters it into the relations list.

Delete

The “Delete” button is used to delete all the specific relations of the object type selected 
with the scroll bar in the objects list. In contrast to the Delete function in the relations 
list, therefore, multiple relations can be deleted simultaneously in this way.

Search

The “Search” button prompts the user to click a specific relation object in the graphic or, 
in the case of non-graphic relation objects, to select it from the record selection box (See 
“Search... > via object” Page 55). After selecting the required object, the relation to it can 
be created or deleted.

Tools (sisNET Tools) 

The former sisNET toolbox is available as a MicroStation taskbar in sisNET V8i and later. 
During a transitional period, the old toolbox can still be opened using this menu function. 
We shall now describe the functions of the sisNET tools that have been implemented as 
tasks. The sisNET tools contain different tasks for editing open jobs. E.g. this set of tools 
can be used to:

• create construction points

• undo activities

• insert, delete and move points in pipes

• move and rotate elements
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• divide pipes

• edit annotations (create, move and delete)

• fence off multiple elements for simultaneous editing 

• delete individual elements

• open the Job Manager

• open the Explorer

sisNET Tools > INFO

The Info toolbox is used to systematically query information about the graphic objects.

Element selection

Any command that is running is cancelled and the element selection is switched on.

The “Object Info box” button opens the “Object Info” dialog box and its effect is the same 
as selecting the menu “Edit > Object Info” (See “Object info” Page 81).

Explorer

This is used to display the sisNET Explorer.

Job Manager

This is used to display the Job Manager.

sisNET Tools > Undo

The “Undo” toolbox enables single or multiple activities to be revoked.

Undo

The “Undo” function enables the last action to be undone. The function is the same 
as the command “Edit > Previous view” (See “Undo” Page 54).

Undo to mark

The “Undo to mark” function enables multiple activities prior to a set mark to be undone 
simultaneously. This command is the same as the command “Undo to mark” (See “Undo 
to mark” Page 54).

Set undo mark

This function enables you to set an undo mark so that the “Undo to mark” function can 
be used to undo all the actions up until the undo mark set. This command is the same as 
the “Set undo mark” command (See “Set UNDO mark” Page 54).
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sisNET Tools > Fence

The “Fence” toolbox is used to edit (e.g. delete, move, etc.) different objects in the 
graphic all together and in a uniform way.

Fence Block

The “Fence Block” button is used to combine elements which are then all going to be 
edited (e.g. deleted, moved, etc.) together. Users are free to select the shape of this fence, 
e.g. block, polygon area, circle, etc., under Fence Type in the box that opens. The mouse is 
used to place the relevant fence in the drawing. The user is prompted to define the fence 
points in the drawing. At the same time, the user can select the required fence mode 
(inside, outside, overlapping, etc.) in the box.

Create fence from buffer

The “Fence Block” button is used to combine elements which are then all going to be 
edited (e.g. deleted, moved, etc.) together. If an object in this mode is clicked, the fence 
is placed based on the buffer size that has been set. This can be specified in the box under 
“Distance (in m)”. The user is prompted to click an object in the drawing around which the 
relevant fence is to be placed. At the same time, the user can select the required fence 
mode (inside, outside, overlapping, etc.) in the box.

Select fence

The “Select fence” button is used to select objects and CAD elements, to be specified 
by the user, inside a fence. To select those objects and CAD elements which are to be 
selected inside the fence, the “Objects” dialog box opens, listing all the objects in those 
application modules with their long names. The scroll bar can be used to select one, more 
or all of these objects for the selection set.
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The selected objects and elements are written to the selection table and can then be 
viewed and edited using the menu “Selection > Selection...” (See “Selection” Page 131).

Copy the geometry of the objects in the fence to a job

The “Copy the geometry of the object(s) in the fence to the Job” button is used to copy 
selected objects to the current job. The user is prompted to specify the source of the 
copy function by clicking in the drawing. The mouse can then be used to place the 
selected content. Pressing the Data button confirms the copy procedure. The user can 
now place as many other identical copies as they wish, or use the Reset button to select 
a new source. The database links and user links for the objects copied using this function 
are detached when they are copied so that the copied objects are pure CAD elements. 
If using original MicroStation copy function, the objects’ user link would always be copied 
and, depending on the copy mode specified, the database link might also be copied.

A further option is to keep the object connection. To prevent contradictions, all the 
object graphics become “parts” of your source object, i.e. main objects, annotations, 
transition cells of nodes become parts and, in turn, parts become new parts. All parts 
are identified by a new type identifier.

Benefits
• The tooltip will show the individual parts with their object attributes. 

• Users can access the relevant object functions using the context-sensitive menu.

• If the object is deleted, these parts are deleted too.

Procedure:
The following function settings box needs to be noted for this:

The first option button determines whether the procedure is to work using the old 
method, i.e. generate simple CAD objects. Relevant parts are only also generated if the 
“Create components” box is checked. The second option enables scaling to be done in 
the fence’s target area. To enable precise positioning, we recommend that users select 
the lower left-hand corner of the fence as the move’s source point.

(Type: PART_FROM_FENCE_PART=14).
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Changing the application module
The application module must be used to specify which object types are included in this 
operation. For this purpose we created the new action (ACTION_TEIL_FROM_FENCE=35). 
The 2 should be used as the action time.

Objects without this line will not be copied.

If the parts are still going to be changed, a macro can be used (as in the above line: 8001). 
The colour, level, line width and line style in the macro can be changed. When doing this, 
note that the new Part Type=14 is used as the second parameter, so that only the 
recently generated parts of this type are changed.

Lock fence

The “Lock fence” button is used to lock the objects that have been fenced in. This copies 
the fenced in objects from the inventory plan to the current job so that they are locked to 
other editors.

Lock fence objects in the DB

The “Lock fence objects in the DB” button locks the objects within the fence into the 
object type tables in the database as though they had been copied to the job. However, 
the graphic of the objects is itself not copied to the job. The locking is done by discarding 
the job.

Copy graphics from the update view to new file

With this task, the content in the view can be exported as a DGN, DWG or DXF file for the 
reference update. There is also an option to place a fence within the update view. The 
fence is then incorporated in line with the fence mode. However, the exported graphics 
are not clipped either at the edge of the view or at the border of the fence (except if 
the mode is set to Clip). The exported graphics have no sisNET links. When the tool is 
activated, the user is prompted to select a new file. If this file ends in DWG or DXF, it is 
not a DGN file that is generated but an AutoCAD DWG or DXF file. With any other file 
ending, a MicroStation v8 DGN file is generated. The task can also be addressed using 
the keyin “WERK ZAUN EXPORTIEREN <File name>“ in which <File name> is the optional, 
complete file name. If an existing file is specified, it is immediately overwritten.

Delete fence

The “Delete fence” button is used to delete the objects selected by means of the fence. 
Before the delete process, a box opens listing all the elements which are within the 
fence. Here the user can, again, carefully select the area from which elements are to 
be deleted. A warning box opens and asks the user whether the selected objects really 
should be deleted.

    {{0,17, ACTION_TEIL_FROM_FENCE},  "2, 8001, 0, 0,,,"},

    {{0,8001,0}, "MODOBJPARTBYTYPE(P_(),14,'FARBE',146)"},
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Delete object

The “Delete object” function enables elements to be deleted. When this is done, the 
elements are not just deleted from the database but also from the drawing, in the 
process of which various plausibility checks are run and other objects may, if necessary, 
be automatically deleted or modified.

The elements to be deleted are selected and confirmed with the Data button on the mouse.

sisNET Tools > Point

The toolbox with the point-related tasks contains functions for inserting, deleting and 
panning points and for restoring constraints.

Insert point

The “Insert point” function is used to retrospectively insert inflexion points into line-
shaped objects. “Identify Object” appears as a status message in the sisNET command 
window. A pipe can then be selected with the mouse. The breakpoint is inserted at the 
position where the pipe was clicked. The pipe then “hangs” from the cursor and the 
breakpoint can be placed with the Data button.

Insert point with projection

The “Insert point with projection” function enables points to be inserted into pipes 
retrospectively, with the original pipeline, in contrast to the “Insert point” task, not being 
changed. So the inflexion point that has been inserted is, initially, not visible. This task 
is the used if the original pipeline is to be kept but an inflexion point, for example, is 
required for placing a connection point. The inflexion point is inserted at the position 
where the pipe was clicked.

Delete point

You can use the “Delete point” function to remove unwanted inflexion points from line-
shaped objects. When the function is selected, the prompt “click point to be deleted” 
appears in the sisNET command window, at which point the point to be deleted is 
selected with the Tentative button and accepted with the Data button. The graphic 
and database are then updated and modified accordingly.

Move point

The “Move point” function is used to move points on the pipe. First, the message “click 
point to be moved” appears in the status row of the sisNET command window. This point 
can be selected with the Tentative button and accepted with the Data button. The 
selected point then hangs from the cursor and can be placed afresh with the mouse. All 
the necessary information is then modfied in the database (e.g. the point’s coordinates, 
length of the pipe, etc.). This function can also be used if, e.g., a connection system lying 
on the pipe is to be moved. In such a case, along with the pipe point, the connection 
point and the connecting cables that extend from the connection system are also 
automatically modified too, and all the relevant database entries are updated.
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sisNET Tools > Move & Rotate

The “Move & Rotate” toolbox for modifying elements includes functions for moving and 
rotating elements.

Move & Rotate

The “Move” function is used to move elements. First, the message “click object to be 
moved” appears in the status row of the sisNET command window. When the element 
required has been selected, it “hangs” from the cursor and the Data button can be used 
to place it afresh. All the necessary information is then also modfied in the database 
(e.g. coordinates of nodes, etc.). 

With this function, note that the only elements that can be moved are those for which 
movement is not forbidden under the rules of the application module.

Rotate Object

The “Rotate Object” function is used to rotate elements. First, the message “click element 
to rotate” appears in the status row of the sisNET command window. When the element 
required has been selected, it “hangs” from the cursor and it can be rotated by moving 
the mouse. The required position is confirmed with the Data button. All the necessary 
information is then also modfied in the database (e.g. coordinates of nodes, etc.). 

With this function, note that the only elements that can be rotated are those for which 
rotation is not forbidden under the rules of the application module.

Rotate over 3 points

The “Rotate over 3 points” function is used to rotate elements. First, the message “click 
element to be rotated” appears in the status row of the sisNET command window. When 
the required element has been selected, the user needs to click to specify the rotation 
point. Now the selected element “hangs” from the cursor and can be rotated by moving 
the mouse. The required position is confirmed with the Data button. All the necessary 
information is then also modfied in the database (e.g. coordinates of nodes, etc.). 

Scaling

This icon starts the scaling function. There are no special icons for annotations and parts. 
The element that is clicked is scaled. The scale factor is entered in the function settings 
box. An element that is clicked is immediately scaled. It only makes sense to use this tool 
for cells, texts and text nodes (sisNET object annotations). Before clicking the tool, the 
option also exists to use the MicroStation selection function to group a number of 
elements (including various sisNET objects) and then scale them with a single scale 
factor. For security purposes, this action needs to be confirmed with a data point.

sisNET Tools > Parts/Merge
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The Divide functions are used to divide sections of pipe that have already been created. 
And the Merge function that the toolbox also provides can be used to merge 
neighbouring sections of pipe. There are various ways of dividing pipes:

• The pipe can be divided by inserting an additional inflexion point

• The pipe can be divided by inserting an inflexion point into the projection of the 
old pipe

• The pipe can be divided at an existing inflexion point

Split and bend

The “Split and bend” function is used to divide a pipe while, at the same time, inserting 
a new inflexion point. To do this, first of all, the user selects pipe which is to be split, 
and then the point in the pipe which is to be defined as the “separation point” (the new 
endpoint of one pipe and, at the same time, the new startpoint of the other pipe). When 
the selected elements (pipe and separation point) have been confirmed with the Data 
button, the pipe section is split into two pipe sections.

Parts with projection

In principle, the “Split along object” function has the same task as the “Split and bend” 
function. However, in contrast to splitting with no projection, in this method the division 
does not change the original pipeline. The two pipe sections which result have an 
identical path to the source section from which they were created.

Divide

The “Divide” function splits the pipe at an existing inflexion point. The user is prompted 
to click the pipe at the inflexion point. After confirming with the Data button, the pipe is 
split at the existing inflexion point.

Merge

The “Merge” function is used to merge two neighbouring pipe sections. After selecting 
this function, the user must click the pipe sections which are to be merged at their 
common node (merge point) and, if there is more than one object at this point, keep 
right-clicking until one of the two pipe sections which are to be merged is found and 
displayed in the highlight colour. After confirming with the left mouse button, the two 
pipe sections adjacent to one another at the merge point are merged into one pipe 
section. The pipes being merged need to have all their attribute values matching before 
the merge can take place. Otherwise an error message will appear indicating that the 
objects being merged have a different attribute value.

If a merge is to be possible despite differing values for particular attributes (this makes 
sense, e.g., with an attribute such as LAENGE for the length of the pipes), this attribute 
needs to be explicitly flagged for this action to be permitted in the application module.

Constraints
The “sisNET - Tools” taskbar contains 3 tools for working with objects which are subject 
to a parallel constraint.
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The tools perform the following tasks:

• Create constraint relation

• Display constraint relation

• Remove constraint

Numerous checks are run before attempting to create a constraint relation between 
objects. The result is shown in graphic form. Any errors are listed in the Messages Centre 
in the sub-section “Message details”. The following errors are identified:

• The objects involved have a different number of points

• Line-shaped objects have different directions

• Nodes in relation are missing at the ends of line-shaped objects

• Group numbers missing

• Group number incorrect

• Group numbers differ in the graphic and the database

The graphic display of the test is done using the graphic attributes as defined in the 
element templates (see below). The displays are kept until a new test or different 
primitive are started. If you wish to deactivate the display manually, you can select 
the “Highlight off” item in the context menu.

About creating and repairing

Objects with constraint relations are always repaired in two steps; the 1st step is to 
remove the existing constraints and the 2nd step is the attempt to create the constraint 
afresh. If the only error is that the direction of line-shaped objects differs, this is repaired 
automatically. A differing number of points cannot be repaired. The re-creation of the 
constraint is aborted. However, under certain conditions a constraint of line-shaped 
objects with a differing number of points can work correctly (e.g. when moving points). 
To enable this, you can check “Ignore constraint creation error” in the “General Settings”.

Before doing the create, you are warned once again that not everything is correct. You can 
still abort the creation of the constraint group at this point. If you continue, you need to 
study the result of any subsequent operation (e.g. moving or inserting points) carefully.
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sisNET Tools > Annotation
The annotation functions enable you to generate and manipulate annotations e.g. for 
pipes, manholes, etc. There are functions for creating, moving, rotating and deleting 
an annotation.

Place annotation

The “Place annotation” button is used to create an annotation for an existing object. 
In this case, the text is not manually entered with the keyboard, but generated 
automatically based on relevant attributes of the object types to be annotated. When 
the function is selected, first of all the message “Identify object!” appears in the status 
line of the sisNET command window. If more than one annotation mode is planned for 
the selected object, the “Annotation modes” dialog window opens after the element to 
be annotated has been selected. Appropriate forms of annotation can be selected in this 
window (See “The Annotation modes command window” Page 94). Once the appropriate 
annotation type has been selected, the left and right annotation points need to be 
selected with the mouse. The annotation is then fitted in between those two points, in 
line with the selected annotation mode (e.g. centred, left-justified, right-justified, etc.).

The Annotation modes command window

In this command window, different modes can be selected for the annotation type.

A.Mod: (Annotation modes)

Predefined annotation modes can be selected from this popup list. The main thing here 
is to specify which of the attribute values of the object to be annotated are going to be 
used. E.g. when the annotation type is LTG-ART/NW, attribute values for the attributes, 
pipe type and nominal width are used to annotate the pipe.

DA Type X

The label on this button is “dynamic” and matches the annotation mode set above.

OK

When the “OK” button is selected, the “Place annotation” function, as described above, 
is continued by entering the left and right annotation points.

Cancel

Selecting the “Cancel” button aborts the “Place annotation” function.
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Move annotation

Selecting the “Move annotation” function enables the user to move annotations which have 
already been placed. The annotation element to be moved is selected with the mouse and 
can then be moved to any other position. Note, here, that the text that has been placed can 
be made up of more than one text element. If multiple text elements are to be moved at the 
same time, this can be done by, e.g., placing a fence around the relevant elements.

Rotate annotation over 2 points

Selecting the “Rotate annotation over 2 points” function enables the user to rotate 
annotations which have already been placed. The annotation element to be rotated is 
selected with the mouse and can then be rotated as required around its insertion point. 
Note, here, that the rotated text can be made up of more than one text element. If 
multiple text elements are to be rotated at the same time, this can be done by, e.g., 
placing a fence around the relevant elements. The angle of rotation is specified by 
clicking with the Data button on any point in the drawing.

Rotate annotation over 3 points

The “Rotate annotation over 3 points” function enables annotation elements to be 
rotated over 3 points. With this function, a rotation point also has to be entered after 
the element has been selected. The annotation element to be rotated is selected with the 
mouse and can then be rotated as required. Note, here, that the rotated text can be made 
up of more than one text element. If multiple text elements are to be rotated at the same 
time, this can be done by, e.g., placing a fence around the relevant elements. The angle of 
rotation is specified by clicking with the Data button on any point in the drawing.

Rotate annotation with an active angle

The “Rotate annotation with an active angle” function is used to rotate annotation 
elements around the active angle set in the methods box. This enables the user to rotate 
an annotation around a pre-defined angle.

Rotate annotation to the active angle

The “Rotate annotation to the active angle” function is used to rotate annotation 
elements on the active angle set in the methods box. So if the active angle is set to 90° in 
the methods box, the annotation is aligned exactly vertical to the x-axis in the drawing file.

Delete text

The “Delete text” function is used to delete individual text elements by selecting them 
and accepting with the Data button.

sisNET Tools > Part

The Part toolbox is used to create and manipulate parts of a (main) object. Object parts 
have the same database record as the main object, but are differentiated from it through 
the user link. They can be regarded as a sort of child object to the main object. This 
enables the creating of complex graphic objects which do not merely consist of a graphic 
primitive (point, line, etc.). A prerequisite for the existence of parts of objects are special 
user modules and relevant entries in the resource files.
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Place component

The “Place component” button is used to create a new part for an existing main object. 
The user is prompted to click the main object and confirm the selected object with the 
Data button.

Move part

The “Move component” button is used to move a part of an existing main object. The 
user is prompted to, firstly, click the required part and then click with the Data button 
at the moved object’s insertion point.

Rotate part over 2 points

The “Rotate part over 2 points” button is used to rotate a part around its insertion point. The 
user is prompted to, firstly, click the required part and then specify the angle of rotation.

Rotate part over 3 points

The “Rotate part over 3 points” button is used to rotate a part around a point of rotation 
that can be freely selected. The user is prompted to, firstly, click the required part, then 
specify the rotation point and, finally, the angle of rotation.

Rotate part with an active angle

The “Rotate part with an active angle” function is used to rotate parts around the active 
angle set in the methods box. This enables the user to rotate an annotation around 
a precisely pre-defined angle.

Rotate part to the active angle

The “Rotate part to the active angle” function is used to rotate parts on the active angle 
set in the methods box. So if the active angle is set to 90° in the methods box, the 
annotation is aligned exactly vertical to the x-axis in the drawing file.

Delete part

The “Delete part” button is used to delete a part of an existing main object. The user is 
prompted to, firstly, click the required part and confirm their choice with the Data button 
or reject it with the Reset button.

sisNET Tools - Help construction

The “CP” toolbox is used to set construction points based on different methods.
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Set construction points

The “Construction point” function is used to place construction points in the drawing 
which are then used later on for designing pipes, house connections or nodes. When the 
function is selected the status message “Select node!” appears in the sisNET command 
window. The user can then set construction points wherever they wish.

Design orthogonal construction points

The “Design orthogonal construction points” function is used to generate construction 
points by entering dimensions in a rotated local coordinate system. With this type of 
design, the y-axis in a local coordinate system is defined using a measurement line 
y(start) - y(end). Then new points, which are known by their coordinates in the local 
system (xi, yi), are passed to the higher-level coordinate system (X, Y) and a construction 
point is generated at that point.

When the function is selected, the “Design orthogonal” dialog box opens for entering the 
local coordinates.

First of all, the user is prompted to click, first, the start point y(start) and then the 
endpoint y(end) of the local measurement line. This determines the direction of the 
measurement line and the dialog becomes active.

If the dimensions of the CP to be generated relate to the local measurement system, the 
start measurement and the end measurement of the measurement line can be entered. 
The local coordinate system is now defined. The difference between the measured section 
and the section which is calculated based on the coordinates of the start and end points is 
calculated, and the scale of the local system is displayed in the higher-level system.

You can now create new CPs using the coordinates x(i) and y(i) related to the 
measurement line. If you want to create CPs to the right of the measurement line, enter 
positive x(i) values, negative x(i) values result in points to the left of the measurement 
line. Enter the values in the fields and terminate your input with Return; the “Create CP” 
button generates the CP at the position calculated. The focus is put back on the input 
field “x(i):” so that you can enter the next point straight away.

When you have generated all the construction points that are related to this 
measurement line, you can create a new measurement line by pressing the Reset button. 
Pressing the Reset button twice exits the function.
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The drawing below clarifies the terms used in this description:

Design construction points between data points

The “Point(s) between” function enables the user to place any number of construction 
points, characters or cells in the drawing file, equidistant between two freely selectable 
points. When the function is selected, the “Design points between data points” dialog 
box opens, which is used to specify the number of points, characters or cells that are 
to be placed.

The magnifying glass can be used here to open the cell library. When the user has 
selected the type and number of the points they want to place, they are prompted 
to click the start and end points of the (planned) line on which the points are then 
automatically placed.

Project active point on element

The “Point on element” function is used to place a construction point, a character 
or a cell precisely on an existing drawing element. When the function is selected, the 
“Project active point on element” dialog box opens, which is used to specify the type 
of point, character or cell that is to be placed.

After specifying the type of point to be placed, the user is prompted to click the required 
drawing element on which the point is then placed at the position they choose.
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Design active point at intersection

The “Point at intersection” function is used to place a construction point, a character or 
a cell precisely at an existing intersection of two existing drawing elements. When the 
function is selected, the “Design active point at intersection” dialog box opens, which is 
used to specify the type of point, character or cell that is to be placed.

After specifying the type of point to be placed, the user is prompted to click the first 
drawing element and then the second drawing element, at whose intersection the 
point is then placed.

Design points along element

The “Point(s) along element” function is used to place any number of construction points, 
characters or cells equidistant between two freely selectable points along an existing 
element (including if the selected element has inflexion points). When the function is 
selected, the “Design points along element” dialog box opens, which is used to specify 
the number of points, characters or cells that are to be placed.

When the user has selected the type and number of the points they want to place, they 
are prompted to click the start and end points of the required element, on which the 
points are then automatically placed, equidistant.

Design active point at distance along element

The “Point at distance along” function is used to place a construction point, a character 
or a cell at a definable distance from the data point along the selected element. When 
the function is selected, the “Design active point at distance along element” dialog box 
opens, which is used to specify the type of point, character or cell and the required 
distance from the data point.

After selecting the required type and distance of the point to be placed, the user is 
prompted to click the required element at the data point, at which point the point is 
then placed on the element at the distance selected.

With this function, note that the only elements that can be rotated are those for which 
rotation is not forbidden under the rules of the application module.
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sisNET Tools GPS
You can use the GPS tools to configure and launch the use of a GPS receiver in sisNET.

GPS Module

This opens the dialog for configuring the GPS module. In this dialog you can configure 
a GPS receiver connected to the computer and query its status. You will find more 
information about this dialog in the relevant section of the MicroStation help.

Start view centering

This starts the automated view centering. At a configurable time interval, the current 
view is centred on the current GPS position.

Stop view centering

You use this to stop the view being automatically centred on the current GPS position.

Increase time interval

You use this to increase the time interval after which the view is automatically centred. 
Each time this button is selected, the size of the time interval is doubled.

Reduce time interval

You use this to reduce the time interval after which the view is automatically centred. 
Each time this button is selected, the size of the time interval is halved.
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Thematic Analysis > Activate
Opens the “Filter” dialog box which you can use to create, change and start filters. A filter is 
used to change the graphic appearance of objects and elements, to control the sequence 
when plotting, and to make selections based on object attributes. A view is used as the 
input for a filter, while the output is to a view or also to a file. If objects from more than 
one category are to be used, the reading has to be done in multiple categories in sisNET. 
A prerequisite for working with filters is an entry for a filter library in the sisNET config file.

The “Library” menu

In this menu you can select a particular filter library file *.rsc in which the required filters 
are saved.

The “Edit” menu

The “Copy filter” menu item is used to copy an existing filter under a new name to 
a different filter library with a new filter ID. The settings are made in the “Save filter” 
dialog box.

The “Filter Description” menu item displays a text file which displays a textual description 
of the filter that is currently selected with the scroll bar.” This text file *.txt is saved in 
the directory that the environment variable SISNET_DIR_HTML points to. An HTML 
file can also be generated instead of a text file if the option “HTML output for filter 
description” is activated in the menu “Extras > General settings > Output” (See “The 
Output tab” Page 160). 
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Here is an example of a filter’s HTML output:

Run

This button is used to run the filter selected with the scroll bar in the “Filter” dialog box. 
Based on the filter definitions (identifiers) that have been set, the objects and elements 
are highlighted and/or have their appearance changed. The graphic and drawing file are 
updated. The current filter settings remain active until the filter settings are deactivated 
with the “Stop” button.

New

This function is used to create new filter definitions. The “Define new filter” dialog box, 
which is the same as the “Edit filter” box, opens (See “Edit filter” Page 103). The filter’s 
function is defined in this dialog box.
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Edit

When a filter has previously been selected in the “Filter” dialog box, an existing filter 
definition can be edited. The “Edit filter” dialog box opens for this purpose (See “Edit 
filter” Page 103).

Delete

Select the filter you wish to delete in the “Filter” list box and click the “Delete” button. 
The “Warning” window opens.

Select “Yes” to delete the filter from the filter library. The “No” button aborts the 
delete process.

Stop

The running of the active filter is terminated. “Refresh view” rebuilds the drawing. This 
releases all the objects and elements manipulated by the filter definition. The content 
of the view is the same as was displayed before running the filter.

Close

Closes the “Filter” dialog box.

Edit filter
The lists below describe the possible entries in the “Define new filter” and “Edit filter” 
dialog boxes for defining a new filter and editing an existing filter.

The dialog box enables filters to be created and changed.

W If an existing filter is being edited it may not be active or the changes made have no 
effect. It is important to bear this point in mind when testing filters, as the user must 
not forget to stop or exit the filter before each change.
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“Output” group field
In the “Output” group field, entries are provided for describing a filter’s output (screen 
output and possibly file output).

File name

A file name can be specified here for the output file which is to be created. If no path 
is specified, the output file is placed in the current work directory. If the user wishes to 
specify a particular path for the output file to be created, they can achieve this using the 
button to the right of the input line. When this button is clicked, the “Output file” file 
selection box opens, with which the user can specify a path and file name for the output 
file to be created. The input field is only activated if the “Create new file” setting is marked.

Open existing file

If this option is selected, before the filter is run the file output box appears which the 
user has to use to select an existing filter output file *flt. The current filter output is then 
attached to the existing filter output file.

Create new file

If no output file has yet been entered in the “File name” input field and this option is 
selected, before the filter is run the “Filter files” file selection box appears with which 
the user can select a path and file name for the output file which is to be created. Filter 
output files have the extension *.flt and can be loaded and edited like normal *.dgn files 
with MicroStation. The only objects written to the specified filter output file are those 
for which a filter identifier has been defined. If you also want to copy the rest of the 
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drawing’s content to this output file, an identifier must be defined for all the remaining 
objects for the relevant filter ID. This identifier must appear as the last identifier in the list 
field for the identifiers defined, since the top identifier in this field has top priority and 
the last identifier has the lowest priority.

View

This is where you set the view you require for the filter output. The following options can 
be selected:

1 .. 8 : MS views 1 - 8
All open: all the open views
Last view: the last view to have been clicked
Reference update is the view set for Ref.update in the menu item “Tools > General 
settings” (See “The Timer tab” Page 158).

W If an output file is being created, in the views, the view in which the filter is activated 
should be set precisely. If the “All open” views option has been selected and more than 
one view is actually open, this results in the the objects occurring more than once in the 
output file.

Fit

The user can select here whether the filtered objects are to be fitted into all or 
a particular view, or if they are not to be fitted in at all.

Only output selection

This field is only activated in connection with a selected selection mode. If a selection 
mode has been selected, the user can specify here that only the selected objects will 
be output.

Refresh screen layout

When this option is selected, the screen content of the selected view prior to the filter 
is deleted and then rebuilt. If this option is not activated, the filtered screen content is 
overlaid onto the unfiltered content.

Include fence
Selecting this option restricts the output to just the content of the fence. Objects outside 
the fence area are not taken into account for the output.

“Macro” group field

No.

After entering a valid macro ID (ID>=1000) and selecting the Edit button, the “Macro 
Editor” dialog box opens, with which the user can create or edit any macros (which 
comply with the usual sisNET macro language conventions.
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The open editor is the Windows editor and it is used in exactly the same way. When 
a filter macro has been created, the editor can simply be closed. The edited file macro.r 
is located in the directory which the environment variable SIS_LOCAL points to. When 
the editor is compiled, the macro.r file is automatically compiled and the macro.rsc file 
is generated. This is stored in the same directory. Both files are only required temporarily 
and can be deleted again after a filter macro has been created. The compiled macro is 
always automatically integrated into the associated filter.

“Select” group field
There are various selection modes which enable the user to specify whether the current 
filter definition is to be valid generally or for specifically selected objects. The following 
selection methods are available:

Mode

The “Mode” popup menu is used to specify the mode for a selection set. The following 
modes are available:

No selection: The filter settings apply generally to the objects and elements specified 
in the identifiers

Selection table: The filter only edits the objects selected in sisNET via the menu (See 
“Search... > via object” Page 55) and described in the selection table.

SQL command: This option is recommended when there are more than 500 objects. The 
objects required can be selected using an SQL command. The SQL query has the following 
general format: select mslink from <table name> where mslink = %ld and <search criterion>.

select mslink from N_G_ANL where mslink = %ld and TYP=1;

Generate list: When there are fewer than 500 objects this can be used to generate a list 
of the selected objects. The SQL command has the following format: select mslink,objekt, 
poolix from <table name>;

select mslink,objekt,poolix from N_G_ANL;

The relevant SQL commands need to be written to the input line “SQL command”.

Automatically attach archive maps

If this option is activated, the associated archive maps are attached for all the objects 
which are included in the selection set, if this has not yet been done.
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“Properties” group field

Filter ID

Here the user needs to enter a unique filter ID which is greater than or equal to 1000 
from the assigned filter library.

Library

Name of the file in which the filter data is stored. The file name may be up to 8 characters 
long. You may choose, here, from all the libraries that have been entered in the string list 
SISNET_DEFAULT_KUNDE in the system settings in the sisNET configuration file config.r. 
The Extension “.rsc” is added automatically.

Comment

A filter title up to 80 characters long may be entered in the list field. The text entered 
here appears in the “Comment” column in the “Filter” dialog box.

Filter remains active after execution

If this field is checked, when the filter function is selected a warning box appears with 
which the user can confirm, with the OK button, that the filter is to stay active or, with 
the Cancel button, that the filter function can stop running.

Activate filter after file change

If this field is checked, after a file is changed the filter is also immediately run in the newly 
loaded file.

Identifiers list field
In the “Identifiers” users can enter or edit the filter definitions required (identifiers) for 
a particular filter ID. The “New identifier” entry is always available and is used to define 
a new identifier. Double-clicking this row opens the “Create identifier” dialog box, with 
which a new identifier can be generated for the current filter ID.

Identifier (Create identifier dialog box)

In the “Identifier” list field, the user can enter a freely selectable name for the identifier 
being defined. The associated filter definition is then entered under this name in the 
“Identifiers” list field in the dialog box for creating and editing filters.

Object types (Create identifier dialog box)

In this input field the user selects the object type to which this identifier is to apply.
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Elements (Create identifier dialog box)

In this input field the user selects the CAD elements to which this identifier is to apply.

File types (Create identifier dialog box)

In this input field the user selects in which of the defined file types this identifier is to apply.

Object components button

This button is used to select the parts of an entire object to which the identifier defined 
applies. Object components and object sub-components relate to the object type set. 
If object components and/or object sub-components are specified, the filter only works 
on the specified part of an object. The following options are available:

The identifier applies to

• the entire object (none)

• the main geometry of the object (main geometry)

• the transition symbol (as part of a node)

• the annotation (of the annotated object type)

• the other components (of the selected main object)

Object sub-components button

Some object components, for example annotations, can be further sub-divided into 
object sub-components. With annotations these are, for example, DAS type IDs, so that, 
by using this type of identifier, only very specific annotation for an object type can be 
edited in this type of identifier.

If, for an identifier, the other components (parts) have been selected, the following 
special sub-components are available

• abscissa

• ordinate

• underscore

• base line

• arrow

• cell with empty text node

• symbol frame in route profile

• cell in route profile

The identifier, the object types to be filtered, the CAD elements and the file types to 
be included have been selected, an appropriate identifier is generated by selecting 
the OK button and entered in the “Identifier” list field in the dialog box for creating 
and editing filters. 

W Each newly created identifier is, by default, placed at the bottom of the list of all 
the identifiers available for this filter ID, so it gets the lowest priority in the processing 
sequence of the available filter identifiers, while the top identifier always has the highest 
priority. If you want to change the order of priority for processing the various identifiers 
in the list, this can be done by right-clicking the required identifier. A context-sensitive 
menu appears that you can use to move the required identifier upwards or downwards 
in the list or delete the identifier.
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Each object that has been defined in an identifier is processed with this identifier; the 
processing for that object type is then complete.

If an existing identifier is to be edited, this is done by double-clicking the identifier to be 
processed, which opens the “Identifier <Identifier name> Edit” dialog box, with which an 
existing identifier can be edited (See “Edit identifier” Page 110).

File types list field
This list field contains all the file types that are being used in any identifier of the current 
filter. For each file type entered here, a specific level symbology can also be activated for 
the filter function. Double-clicking the required file type opens the “Level symbology” 
dialog box with which the user can select a level symbology file for activating a level 
symbology defined within it.

File types

In this list field the file type is entered that was previously selected from the “File types” 
list field in the “Edit filter” dialog box. The field cannot be edited.

Levels

If this settings field is selected, only the level settings from the level description file 
are included.

Symbology level

If this settings field is selected, the symbology settings (columns 2,3,4) from the level 
description file are also included.
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File name

Here you must enter the path and file name of the level description file (*.dat) that is 
to be used.

Name

The name of the symbology to be used in the selected level description file must be 
entered here.

Search

Selecting the “Search” button opens the “Level-Symb files” file selection box with which 
the user can select the level symbology file *.dat they require.

The file selection box automatically branches to the path that the environment variable 
SISNET_DIR_LEVELSYMB points to.

OK (Edit filter dialog box)

If the dialog box for creating and changing filters was opened in “Create New Filter” 
mode, the following warning appears when the OK button is selected.

“OK” adopts the proposed path and file name. Selecting the “Cancel” button aborts 
the definition and save.

Cancel (Edit filter dialog box)

The “Cancel” button closes the dialog box for creating new filters or editing existing 
filters, and the settings that have been made are discarded.

Edit identifier
Double-clicking an existing filter in the “Edit filter” dialog box opens the “Identifier 
<Name of identifier> Edit” dialog box. This dialog box enables the filter identifiers 
for the various object types and elements to be edited. This dialog box has 3 tabs.
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The General tab

Object types

Displays the object type associated with the selected identifier. The field cannot 
be edited.

Elements

Displays the element associated with the selected identifier. The field cannot be edited.

File types

Displays the file type associated with the selected identifier. The field cannot be edited.

Priority

By entering a priority you can specify the order in which the identifiers associated with 
a filter are to be output. The identifier with the lowest priority is output first.

Macro

Here you can enter the ID of any macro you wish, which is to be activated for this 
identifier. The “Edit macro” button becomes active after the TAB or RETURN keys 
are pressed. The macro specified is only processed in connection with this identifier.

Edit macro

Opens the “Edit macro” dialog box (See ““Macro” group field” Page 105). The button 
is only active if a macro number has been entered.
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The Edit tab

Hide group field
The “Hide” group field enables graphic objects to be excluded from the filter editing.

Object
The object type (element) selected via the identifier is blocked (not displayed) for 
the output.

Annotation
The annotation of the object type/element selected via the identifier is blocked (not 
displayed) for the output.

Transition
This hide only works with nodes. The transition symbols are not displayed if the hide 
is activated.

Link
Activating this settings field only makes sense in connection with the outputting of the 
filter results to a new file. In such cases, a database link attached to the objects is not part 
of the output, so that the new file only contains pure CAD elements.

Parts
When this field is activated, the components of a main object are not displayed. This hide 
does not affect annotations and transition symbols.

Apply masking group field
In the “Apply masking” settings field, graphic objects can be released.
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Text
When this settings field is activated, texts are released. If this function is activated in 
connection with an identifier for a particular object type, it only affects texts associated 
with that object type. If you want to release texts for all object types in general, you need 
to make the relevant activation in an identifier for all object types.

Text nodes
When this settings field is activated, text nodes are released. If this function is activated 
in connection with an identifier for a particular object type, it only affects text nodes 
associated with that object type. If you want to release text nodes for all object types 
in general, you need to make the relevant activation in an identifier for all object types.

✍ Note: In MicroStation, texts and text nodes are different types of element. Texts may be 
single line only, while text nodes may be multi-line. In contrast, a text element can be 
placed more than once, while a text node can only be placed once. On the other hand, 
a text node can be updated from a database table, while this cannot be done with text 
elements. In sisNET, all the annotations used are usually text nodes. Only streets and 
house numbers are text-shaped objects in some application modules.

Cell
When this settings field is activated, cells are released. If this function is activated 
in connection with an identifier for a particular object type, it only affects cells that 
represent this object type. If you want to release cells for all object types in general, 
you need to make the relevant activation in an identifier for all object types.

Shape
When this settings field is activated, area-shaped objects (shapes) are released. If this 
function is activated in connection with an identifier for a particular object type, it only 
affects area-shaped objects (shapes) that represent this object type. If you want to 
release area-shaped objects (shapes) for all object types in general, you need to make 
the relevant activation in an identifier for all object types.

Multiline
When this settings field is activated, multilines are released. If this function is activated 
in connection with an identifier for a particular object type, it only affects multilines that 
represent this object type. If you want to release multilines for all object types in general, 
you need to make the relevant activation in an identifier for all object types.

Complex shape
In contrast to shapes, complex shapes can have up to 100 corner points. When this 
settings field is activated, these objects (complex shapes) are released. If this function is 
activated in connection with an identifier for a particular object type, it only affects these 
objects (complex shapes) that represent this object type. If you want to release these 
objects (complex shapes) for all object types in general, you need to make the relevant 
activation in an identifier for all object types.

Ellipse
When this settings field is activated, objects of this element type (ellipse) are released. 
If this function is activated in connection with an identifier for a particular object type, it 
only affects these objects (ellipses) that represent this object type. If you want to release 
these objects (ellipses) for all object types in general, you need to make the relevant 
activation in an identifier for all object types.
sisNET Suite - User Guide 113



The Edit menu
Edit filter

3

The “Settings” button
This button is used to change the colour, fill colour, line width, line style and offset of the 
release shape. The settings required are made with the “Shape Settings” dialog box.

“Transform” group field
The “Transform” group field can be used to completely change the entire graphic 
appearance of an object type.

Mode
The following settings can be selected:

All points: All the individual points (inflexion points) of line-shaped objects are displayed.

Start/end points: The line-shaped objects are only displayed as a straight line connection 
between startpoint and endpoint. All the intermediary points are filtered out.

Node: The only individual points of line-shaped objects that are displayed are those that 
are also nodes.

Start/end/connection point: The only individual points of line-shaped objects that are 
displayed are those that are either the startpoint or endpoint of the object, or those 
a connection point is resting on.

Graphic ID
In the “Graphic ID” settings field, the user can view the available graphic information 
(graphic ID=0) for the current object type, or create a new, additional piece of graphic 
information. 

Clicking the “Edit” button opens the “Geometry information” dialog box with which the 
user can view the current graphic information about the object type, or create a new 
piece of graphic information about displaying this object type.
114 sisNET Suite - User Guide



The Edit menu
Edit filter
In terms of its layout, the dialog box is the same as the dialog box used by sisCONF to 
change or create graphic information about an object, and you can find out the meaning 
of the individual settings fields in the sisCONF guide.

The “Attribute” popup menu
From this popup menu, the user can select a particular attribute of the object type 
selected in the identifier. The content of this attribute is then output as text instead 
of the object graphic if the object has been given an annotation.

“Scale factor” group field
Texts or cells can be scaled in the “Scale factor” settings field. Scale factor 1 means 
no scaling.

The Identifier tab
In the “Identifier” tab, you can specify how the filtered objects/elements are to be flagged.
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Highlight

If this settings field is activated, the filtered object/element is displayed with the colour 
specified.

Annotated cell

This settings field can only be activated if the current identifier contains an object type. 
The filtered objects are then flagged with a circular cell which shows the value of the 
attribute specified in the “Annotation attribute” line.

Scaled cell

This settings field can only be activated if the current identifier contains an object type. 
The filtered objects are then flagged with a circular cell the radius of which is calculated 
from the value of the attribute specified in the “Radius attribute” line and a value entered 
in the “Radius reference” and “Scale factor cell” lines. The radius R of the circular cell is 
calculated here using the following formula (in master units):

R=attribute value/radius reference value*scale factor 

To prevent the user from being able to select any illogical object attributes in the “Radius 
attribute” input field, the popup menu that opens when this field is clicked only contains 
those attributes which contain numeric values.

None

Activating this settings field means that the filtered objects/elements will not be flagged 
in any special way.

Pie

The “Pie” settings field only makes sense in connection with specific macro functions.

Insertion point

The “Insertion point” menu is only activated in connection with the “Pie” settings field. 
It enables the object’s insertion point or the object’s centroid to be selected for the 
insertion point of the pie chart.

Table

Here the user can select between the “GRUP” table and the object type’s database table 
if “Annotated cell” or “Scaled cell” have been activated. An attribute can then be selected 
from this table for “Radius attribute”.

Radius attribute

If “Annotated cell” or “Scaled cell” have been activated, an attribute can be selected here 
the value of which is displayed in the identifying circle.

Radius

If “Scaled cell” has been selected, a value can be specified here. The circle’s radius is 
calculated from the value of the attribute divided by the radius reference.

Scale factor cell

If “Annotated cell” or “Scaled cell” have been selected, a scale factor can be specified 
here. The value “1” means no scaling.
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Cell name

If “Annotated cell” or “Scaled cell” have been selected, a cell name can be entered here. 
The objects are flagged with this cell.

Ok

The current identifier is saved and the “Edit identifier” dialog box is closed.

Cancel

The current identifier is discarded and the “Edit identifier” dialog box is closed.

Thematic Analysis > Close
The menu is used to close active filters. The default view is restored once more. The view 
may need to be updated manually (screen refresh).

(MS)Information

The (MS)Information function is used to query information about the drawing elements. 
The window that opens after a relevant element has been selected displays the element 
coordinates, the drawing level, the drawing colour, the line width, the line style, etc.
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(MS)Locks
The (MS) Locks function is a MicroStation application function. The function is used to 
switch certain locks on and off.

E.g. the raster lock and the levels lock can be activated and deactivated using the function. 
The result of this is that you can only draw on the “imaginary” raster points of a grid 
overlaid on the drawing, and when the levels lock is switched on you can only draw in 
a specified level. Other locks include, e.g., the text node lock, the graphic group, the setting 
for the fence mode, the snap function, axis locks, etc. Please refer to the MicroStation 
guide for more information about this function.

(MS)Snap function mode
The MicroStation Snap function mode can be set or changed with this function. When it is 
selected, the MicroStation toolbox for setting the different snap function modes appears.

Please refer to the relevant MicroStation user guides for information about the various 
snap function modes.
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With the functions combined under the “View” menu, each user can select the way in 
which the drawings are displayed to them.
Task: Selection from the “View” menu:

With the explorer, object types can be shown or hidden, 
sub-divided into their geometry roles and levels and 
depending on the zoom

Explorer (Page 120)

A dialog box is used to select from amongst the topics that 
have been generated

Topics > Dialog (Page 124)

This function closes the current topic Close topic (Page 124)

This function is used to display the jobs that have been 
opened in the supply area

Display Map tiles (Page 125)

Highlight blocked objects in the current job View locked objects (Page 127)

Highlight active objects in the current job View active objects (Page 127)

Highlight active elements in the current job View active elements (Page 127)

Specify a graphic display on a particular scale Zoom to scale (Page 127)

Display areas that users have defined themselves Designated areas (Page 128)

Only the current file should be displayed Detach all ref. files (Page 128)

The function opens the dialog window in the Microstation 
application for editing reference files. The dialog window 
provides various functions for attaching and detaching 
reference files, and for panning, scaling and rotating the 
drawings, etc.

(MS) Reference (Page 128)

This function is used to control the display of one or more 
grid images in the view of a DGN file

(MS) Grid Manager (Page 129)

This function is used to switch the various view attributes 
(line types, line strengths, pattern, text, etc.) on and off

(MS) Attributes (Page 129)

This function is used to specify the active level and the 
displayed levels of the active drawing file for the various 
views

(MS) Level display (Page 130)
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Explorer
To use the sisNET explorer, you need to have at least one configured topic for the user 
group to which the current user belongs. Topics are created in a separate configuration 
program which is accessed via the Topic>Configure Topics menu.

When the “Explorer” menu item is selected in sisNET, the “Explorer” dialog box, with 
which the user can select a topic they want, opens.

The topics explorer is used to select sisNET filters and switch them on and off. 
The colour of the symbol shows whether a filter is currently active. If the symbol 
is grey, you can click the button to select a filter

If the symbol is red, you can click the button to switch off a filter the filter that 
is currently active.

When using the explorer and filters at the same time, you should ensure that the explorer 
and the filters have no contradictory entries, e.g. water pipes are hidden in the explorer 
and water pipes are highlighted by the filter.

Select topic

Reset topic

Switch filter on/off

Topic entries
Switch on/off
120 sisNET Suite - User Guide



The View menu
Explorer
Within a topic there are different types of topic entry. By using a grouping, you can 
combine several topic entries so that you can switch them all on and off together.

A CAD map type indicates a map type that only contains CAD elements. CAD 
elements have no object data. Within a CAD map type, one can further differentiate 
between different geometry roles (e.g. lines and texts) and between levels.

A grid map type only contains grid files; e.g. TIF files.

An object type can contain all sorts of graphics with object data. Within an object 
type, one can differentiate between the four geometry roles: main geometry, 
annotation, transition and part. Within the geometry roles, one can further 
differentiate between various levels.

The geometry role is the 1st sub-division level for object type and CAD map 
type entries.

CAD map types are sub-divided as follows:

• Lines with the MicroStation element types: Line (3), polygonal line (4), curve (11), 
complex chain (12), arc (16), BSpline pole (21), BSpline node (26), BSpline curve (27), 
BSpline weighting (28) und polyline (36)

• Symbols with the MicroStation element types: Cell (2), dot chain (22), pseudo cell 
definition (34) and pseudo cell (35)

• Texts with the MicroStation element types: Text (7) and text node (17)

• Areas with the MicroStation element types: Surface (6), complexe surface (14) 
and ellipsis (15)

• Dimensionings with the MicroStation element type: Dimensioning (33) 

• 3D elements with the MicroStation element types: 3D surface (18), 3D solid (19), 
3D cone (23), 3D BSpline surface (24) and 3D BSpline margin (25)

Object type entries are sub-divided as follows:

• Main geometry

• Annotation

• Transition cell

• Part

Beneath the geometry role is the sub-division into MicroStation levels. This enables, 
e.g., an annotation for a particular object type that is on a particular level to shown 
or hidden.

Zoom shot dependence

The graphic that is linked to each topic entry can be shown or hidden depending on the 
relevant zoom level in the MicroStation view. A topic entry’s zoom shot dependence is 
shown in the tooltip for the entry.

There are four basic settings for the zoom shot dependence:

• Minimal view to maximum view: The topic entry’s graphics are not dependent on the 
zoom level

• Minimal view to xxx m: The topic entry’s graphics are only displayed up to the view 
level specified
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• xxx m to Maximum view: The topic entry’s graphics are only displayed from the view 
level specified

• xxx m to yyy m: The topic entry’s graphics are displayed from the view level specified 
(xxx) and hidden again after the other limit (yyy).

The width and height of each view, and the name of the active topic, are noted in the 
view header.

Activate > topic

Use this to select from between different topics. Alternatively, there is a topic selection 
box in the upper area, beneath the button bar. It can be expanded using the arrow on the 
right-hand side. Then you can select a topic. This causes the tree view of the topic entries 
to be updated.

Topic > Reset theme to default settings

This resets the current topic setting back to the default setting. The standard setting 
is specified in the topic configurator.

Topic > Configure topics

If you have the appropriate permission, the dialog for configuring the sisNET explorer will 
open. The sisNET topic configurator is described in the sisNET administration guide.

View > Update all views

This button is used to update one or more open MicroStation views. You can specify 
which views are to be updated in the Settings menu.

This runs a complete design view. When a topic entry has been shown or hidden, the view 
is not yet updated. It is only when the “Refresh view” button is clicked in the relevant 
MicroStation view, or when this function is used, that a view is updated based on the topic 
entries that have been switched on and off.

View > Update contents based on range of View 1

This button is only enabled if the fully automated view update (see next point) has not 
been switched on. You can specify which view is the update view in the sisNET menu under 
“Extras > General Settings > Timer > Reload on view” (See “Reload on view” Page 158). This 
button is used to load the maps needed to create the update view and remove the maps 
that are no longer required. After a view is zoomed or scrolled, this button should be used 
to load the maps required if the “Fully automated view and content update” button has not 
been activated.
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View > Fully automated view and content update

Activating this button automatically updates the reference files required for the design 
view when scrolling and zooming, so that the view and the content do not have to be 
refreshed by clicking the “Refresh view” button. When this button is activated, the 
“Update content by range” function cannot be used.

In general, the design view causes performance to deteriorate. However, this is offset 
by the convenience of having the maps load automatically.

View > Deactivate zoom dependency

When the zoom dependency is deactivate, all the graphics for the selected topic entries 
are displayed, no matter what the zoom level of the MicroStation view.

View > Deactivate Explorer

By deactivating the sisNET explorer, the graphics displayed in the various views are no 
longer filtered based on the topic entries selected. The same effect can be achieved if 
no topic entry is selected.

View > Display as-built map

By default, the archive maps are displayed. This button can be used to hide the archive maps.

View > Show all jobs of all categories within the area

By default, the job maps are not displayed. This button can be used to display the job 
maps. The only jobs that display are those for which objects are also displayed in the 
MicroStation view.

View > Show legend for view 1

This menu item is used to show or hide the legend display for the sisNET update view. 
A topic needs to be active for the legend to be displayed. The legend displays in a separate 
view. The sorting and grouping of the legend entries is based on the sorting and grouping 
of the entries in the active topic. The only elements that are displayed in the legend are 
those which also appear in the update view. You can use the topic configurator to specify, 
for each topic entry, whether the entry is also to appear in the legend. If nothing is 
configured, all the entries are copied to the legend.

View > Derived maps...

Besides the main plan, other plans can also be configured in a project. This button is used 
to display the maps from the other plans. This function opens another dialog field:
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This dialog is used to specify in which views (buttons 1, 2, ..., 8 for the 8 MicroStation 
views) which plans are to be displayed.

The main plan in the “Derived maps” dialog is divided into various categories so that, 
for the gas overview plan, for example, only the municipality objects from the main 
plan can be displayed in the same view. 

The dialog box only displays main plans and overview plans that occur in the topic. 

Theme > Big/Small toolbar icons

This is used to toggle between big and small icons in the explorer toolbar.

View > Other maps

This function is used to attach reference files. These are specified dynamically, using 
environment variables. This type of reference file might, for example, be a town plan 
that includes an overview of the supply area. It could point to the environment variable 
SISNET_FILE_STADTDGN. For this menu item to be available, the environment variables 
need to have been defined and set in a donfiguration file *.cfg. Then, as sub-menu items 
for this fuction, the functions to attach and detach the files defined using these 
environment variables will be available.

Object > Create new object from selected object type

This menu item and the button are only active if an object type topic entry has been 

selected. These entries are indicated by the general object icon . This function starts 
the create process for a new object from the selected object type. Prerequisites for 
creating a new object are:

• A job in the relevant category must be open.

• The user currently logged into sisNET must have the right to create for this object type.

Topics > Dialog
A topic can be selected without having to open the explorer under “View > Topics”. As 
stated before, the individual topics need first to have been set up in the sisCONF. When 
the sub-menu item “Dialog” is clicked, the “Topics” dialog box appears, listing all the 
topics. They are also listed beneath the “Dialog” menu item so that the topic required 
can also be selected in this way as an alternative to the dialog box.

Close topic
This exits the current topic and deactivates the explorer. The topic selection box in the 
explorer, the tree view of the topic entries and the sub items in the “Topic” menu are 
then greyed out. They are only reactivated if a new topic is selected via “View > Topics”.
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Display Map tiles

The “Display Map tiles” function is used to display the total expanse of the file types 
(maps) managed in the relevant schema. This function can be used to display the position 
and spread of each available map can be using a border within the overview map across 
the supply area. The overview map loaded here is the one which the environment variable 
SISNET_FILE_STADTDGN points to. The “Display Map tiles” function enables two different 
file types to display at the same time and to be displayed with different borders or fillings.

Border 1
The popup list enables you to specify the colour of the border that is to mark the required 
file type.

Text 1

The popup list enables you to specify the text colour with which the file name is to display.

B.strength 1

The popup list enables you to specify the border strength.

File type 1

The popup list enables different types of file to be displayed. E.g. by selecting “Gas job” the 
current gas jobs are displayed, and by selecting “Gas archive”, all the pool files (network 
maps) in the gas supply area are displayed.

Fill out 1

You select this button to, e.g., fill in the border for the display of the current file type with 
the selected colour.
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Real Values 1

Two pairs of values (default/real) are stored for each of the different graphic files. The 
default values contain e.g. the corner coordinates as they have been specified when 
defining the maps (urban area divided into sheet extracts). The real values contain the 
actual corner coordinates, which may differ from the original data, e.g. due to the fact 
that pipes have been drawn beyond the bounds of the map. After any such action, the 
“real values” are readjusted to suit the map size.

When the “Real values” button is selected, the maps display in their actual dimensions.

Border 2
The popup list enables you to specify the colour of the border that is to mark the required 
file type.

Text 2

The popup list enables you to specify the text colour with which the file name is to display.

B.strength 2

The popup list enables you to specify the border strength.

File type 2

The popup list enables different types of file to be displayed. E.g. by selecting “Gas job” 
the current gas jobs are displayed, and by selecting “Gas archive”, the entire available gas 
supply area.

Fill out 2

You select this button to, e.g., fill in the border for the display of the current file type with 
the selected colour.

Real Values 2

Two pairs of values (default/real) are stored for each of the different graphic files. The 
default values contain e.g. the corner coordinates as they have been specified when 
defining the maps (urban area divided into sheet extracts). The real values contain the 
actual corner coordinates, which may differ from the original data, e.g. due to the fact 
that pipes have been drawn beyond the bounds of the map. After any such action, the 
“real values” are readjusted to suit the map size.

When the “Real values” button is selected, the maps display in their actual dimensions.

View
The popup list enables you to select the view to which the selected parameters apply and 
in which the relevant information is displayed.

Time interval
The popup list enables you to specify the time interval (in secs.) at which the displayed 
values are updated.

Save settings
Selecting this button saves the selected settings, which are again available the next time 
the “Display Map tiles” function is selected.
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View locked objects
This function enables you to highlight the objects that are being edited in other jobs and 
which, therefore, are locked for editing in the current job. 

You can specify the colour in which the locked objects are displayed in the “Colour” tab 
in the “Extras > General Settings” menu (See “Colour locked objects” Page 159). All the 
remaining geometries are greyed out.

The display is only temporary - it switches back to the normal view when the view is 
moved or a different topic is selected.

View active objects
This function enables you to highlight the objects that are being edited in the current job. 
Active objects are those objects which have either been created in the current job or 
copied from the archives for the purpose of editing. The active objects in the current 
job are, at the same time, locked objects for other jobs.

You can specify the colour in which the active objects are displayed in the “Colour” tab 
in the “Extras > General Settings” menu (See “Colour active objects” Page 159).

Load job

View active elements
This function is largely the same as the “View active objects” function, with the 
difference that active elements may also be dummy graphics. So active elements do 
not need to be objects in the sisNET sense. Selecting this function involves selecting the 
“View active objects” function.

You can specify the colour in which the active elements are displayed in the “Colour” 
tab in the “Extras > General Settings” menu (See “Colour active elements” Page 159).

Zoom to scale
Here you can enter a specific scale for the active view. You should bear in mind that what 
you specify should only be regarded as an approximate value, because it depends on the 
size of the screen you are using.
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Designated areas
A dialog window opens in which you can save sections of views under names which you 
are free to choose. You can navigate to these saved views with one mouse click.

This function opens by default when you start sisVIEW.

You can save the current view as a designated area by clicking the map symbol. Double-
clicking a designated area centres the current view on it again.

To save designated areas for the longer term, the storage folder needs to be specified 
in “SISNET_DIR_EXTENTS”.

Detach all ref. files
When you select the “Detach all ref. files” function you detach (unload) all the reference 
files that are currently loaded. The effect is that the drawing data in these files is no 
longer available on the screen and only the drawing content of the currently loaded 
drawing file will be displayed.

(MS) Reference

The function opens the dialog window in the Microstation application for displaying 
reference files. The dialog window provides various functions for attaching and 
detaching reference files, and for panning, scaling and rotating the drawings, etc. 
For further information on working with reference files, please refer to the MicroStation 
reference guide.
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(MS) Grid Manager

The grid manager is used to control the display of one or more grid images in the view 
of a DGN file. For further information on working with reference files, please refer to 
the MicroStation reference guide.

(MS) Attributes

This function is used to switch the various view attributes (dimensionings, fillings, line 
types, line strengths, pattern, text, etc.) on and off. Some attributes specify whether 
specific parts of a model and drawing tools are to be displayed. Others, in turn, specify 
how the DGN file is to be displayed. This function is a MicroStation application function. 
So you can get more information on this function from the MicroStation guides.
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(MS) Level display

When this sub-menu item is selected, the Level Display dialog field opens. This function 
is a MicroStation application function. This dialog field is used to specify, e.g., the active 
level and the displayed levels of the active drawing file for the various views. You can get 
more information on other function options from the MicroStation guides.

Menu item Reference > Topics

You can use this menu item to activate a topic without starting up the explorer interface. 
When a topic has been activated using this menu item, the zoom dependency (See “Zoom 
shot dependence” Page 121) is deactivated.
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5 The Selection menu
You can use the functions in the “Selection” menu to seach the data inventory using 
different criteria and to display and mark the objects found by different graphic means.
Selection
There are different ways to start a selection:

• run an existing selection file,

• load an existing selection result or

• define a new selection.

Before making the selection you can define the geographic area to which the selection 
should be restricted. A selection across the entire data inventory or across a defined area 
(fence) is possible.

After making the selection, all the objects and elements found are displayed in the list 
window in the “Selection Tool” dialog.

The list window displays the objects found with their long name. Each object displayed 
in the list window can be selected with the scroll bar, and the database attributes and 
relationships for each object selected can be viewed or changed. Double-clicking the 
object selected with the scroll bar opens the “Object Info” dialog, which enables the 
views or changes required (See “Object info” Page 81).

When the “Selection” menu item is clicked, the “Selection Tool” dialog opens for 
specifying the selection and display conditions. If objects from a previous selection 
are entered in the selection table, they are displayed in the box’s list window.

Task: Select from the “Selection” menu:

These are used to make self-defined selections in the 
data inventory which can be graphically edited in many 
different ways

Selection (Page 131)

Use this to make a database selection and then create 
a report

Selection with standard report... (Page 142)

Use this menu item to create reports using existing 
report definition files

Report from template… (Page 143)

Go to the supply area via predefined database queries Object Search (Page 144)
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The dialog contains four pull-down menus for selecting create and display options for the 
selection required.

Pull-down menu: Create
This menu enables you to specify how the selection is created. These methods are possible

Database selection

The “By database selection...” function opens the “Selection” dialog which is used 
to define attributive selection tasks that may also encompass all object types.

List window for 
displaying a chosen 
selection
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Category/Object

In the upper list window you can select from the categories defined in the current 
configuration. Depending on the category selected, the objects belonging to it are 
displayed in the lower list window. In this lower list box, you select an object type 
on which you wish to make a data record selection.

Attributes

The available database attributes (columns) in the selected object type are listed here. 
For each row in the search expression, one of these attributes must be linked to 
a comparative value by a condition.

Activating the checkbox to the left of “Use DB column name” lists the attributes with 
the name that is saved in the database.

Condition

Here you can select from predefined condition types. The following relational operators 
are available:

< smaller than

<= smaller than or equal to

= equals

>= greater than or equal to

> greater than

!= does not equal

like equals for strings (with % to be used as a placeholder)

not like does not equal for strings

is (NULL) Has the attribute not been given a value?

is not (NULL) Has the attribute been given a value?

Link

If more than one search condition is to be linked together, the type of link can be 
specified here (and and or).

SQL expression

From the search conditions entered, an SQL expression which is valid for the database 
will be generated and displayed here. Each search condition equates to one row in this 
window. Search conditions can be added and deleted.

Add new condition

When you select this button, a new search condition is added to the SQL expression.

Delete condition

When you select this button, the search condition that is currently selected is removed 
from the SQL expression.
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+Append

Selecting the “+Append” button opens another window in which other conditions for 
other objects can be entered. The conditions for the various object types that have been 
defined in this way can then be linked to one another to form a selection.

Select

When you select this button, the search process is triggered, providing a valid SQL 
expression has been formed. If at least one data record has met the search conditions, the 
data records that were found are displayed in the list window of the “Selection Tool” box.

Cancel

Select this button to exit the dialog. The SQL expression that is currently entered is discarded.

Selection - File > Save query

The “Save query” menu item can be used to save the finished, defined selection job 
under any file name of your choosing. This selection job can then be run again at some 
later point in the menu “Create >Run saved query...” in the “Selection Tool” box.

Selection - File > Save as web query

To use a selection query with sisIMS, the selection definition file needs to have its syntax 
modified. This menu item creates and saves selection queries modified in this way.

Selection - Settings > Save query before selection

The effect of this setting is that, before running the selection, a file selection dialog opens 
to save the query.

Selection - Settings > Query on selection table

This option can be selected if there are already records selected in the selection table 
and this selection is to be further restricted. So a condition formulated using this option 
always relates to a quantity that has already been selected in the selection table and may 
restrict this further.
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By object selection

The “By object selection” function in the “Selection Tool” box only runs the selection 
for those objects which lie within an area that has been spatially delimited using a fence. 
So the only elements selected are those that are found inside the fence area and, at the 
same time, meet the selection conditions.

If a fence area has been specified and if this function is then selected, the selection box 
appears for the objects or CAD elements that are to be included in the selection across 
the fence area (See “sisNET Tools > Fence” Page 87). The objects entered in this selection 
box are now included in the fence selection and entered in the selection table and in the 
list field in the selection box.

By Pos. file selection

Position files are generated, for example, using the menu “Extras > Check consistency” 
if corrupt drawing elements have been found during the consistency check. The position 
files hold the MS file positions of the corrupt elements found during the consistency 
check. To be able to display these elements, a selection of these elements can be made 
in this menu.

Position files are saved in the directory that the environment variable SIS_LOCAL points to.

When this menu item is selected, the “Position files” file selection box opens, which is 
used to select the path and file name of the position file required.

The structure and content of position files are described in the sisNET configuration guide.

Run saved query

The “Run saved query” function can be used to access predefined selection jobs. The 
“SQL-Select files” file selection box opens, in which you can select the name of a selection 
job that has been saved. These SQL script files for defining a selection job can either be 
produced using an editor or they are created when a selection job is defined using the 
menu, via the “Selection” dialog and the “Save file” menu item in the “Selection” box 
(See “Database selection” Page 132).

The SQL file to be selected holds the relevant SQL commands, which run after it is 
selected. The selection results are then available for further processing, just as if the 
selection job had been defined using the “Selection” dialog.
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Edit saved query

This can be used to change the value assignment for search criteria (variables) in an 
existing selection file. After selecting this menu item, the file to be edited needs to be 
selected in the “SQL-Select files” file selection box.

The “Variable list” window, which contains all the search criteria with their value 
assignments, then opens.

To change a value, the relevant line in the list window needs to be selected with the 
cursor. At that point, the value of the search criterion is released for editing in the edit 
line in the lower part of the dialog.

No further changes to a saved query for formulating a selection job can be made with 
this menu item. For example, if you wanted to also change a condition format for the 
selection (=, <, >), you would need to load the saved selection into a text editor and use 
the editor to make the changes you want.
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Pull-down menu: Selection
This menu enables you to edit the current selection in various ways, and to reload 
a selection result produced previously to view or edit. The menu provides the 
following functions:

Clear

This menu item deletes the entries in the most recent selection both in the list field in the 
selection box and the entries in the selection table.

Update

If the selection result in the selection table has been changed by another program, this 
menu item provides the option of refreshing the list window in the selection box with the 
new content in the selection table.

Highlight

This menu item is used to display the graphic for the selected objects. You can specify in 
which view and how the selected objects are to be displayed in the “Settings...” menu.

Settings...

You can specify how the selected objects are to be displayed in this menu. The “Settings” 
dialog opens for you to specify the display settings you require.
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Statistics

Selecting this menu item generates statistics for the objects selected using the Selection 
function by displaying the objects found individually with their mslink and the total of all 
objects found in the Notepad editor.

Report from template...

Selecting this menu item opens the “Report definitions files” file selection box, which 
is used to select an existing report definition file (for creating report definition files and 
their syntax, see the SISREPORTGENERATOR guide).

In the file selection box, the path for selecting a report definition file is, by default, set 
to the one that the environment variable SISNET_DIR_REPDEFSEL points to. The report 
definition file the user selects needs to relate to the objects in the selection table before 
a useful report on them can be produced. The form of these report definition files is no 
different from the report definition files *r??, and sisNET does not differentiate between 
them. With report definition files for selections, however, it is intended that the report 
result file generated is only limited to the objects previously selected. The responsibility 
for this, however, lies with the person who programmed the report definition file, and 
sisNET does not check it.

Report by selection...

This function equates to Selection with standard report... (Page 142). However, it can 
only be selected if a selection has already been made using the selection tool. So the 
Report by Selection window opens immediately afterwards.

Display current selection as data table

The current selection is transferred to the table in the sisNET object search. Here, the 
attributes of the objects selected are displayed in a table.

Load selection results & filters

The “Load selection results & filters” menu item can be used to load a selection result 
that was previously saved with the “Save selection results & filters as” menu item, and 
to display it in the list window in the “Selection Tool” dialog.

Selecting this menu item opens the “Select results” file selection box, which can be used 
to load a saved selection result and display it in the list field in the “Selection Tool” dialog.
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By default, files for saving selection results have the extension *.ser.

Save selection results & filters

This function saves the current selection result in a file that was previously created with 
“Save selection results & filters as”. All the filters defined prior to this point (Filter menu) 
are saved along with the selection result.

Save selection results & filters as

The result of a selection can be saved in a file. When this menu item is selected, the “Save 
selection results” file selection box opens in which a path and file name can be entered 
for the selection result. The directory to which the environment variable 
SISNET_DIR_SELECTERG points is proposed as the default path.

The saved selection result is a string list whose content can be displayed in the list 
window in the “Selection Tool” dialog.
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Long/Short list

The user can use this menu item to select whether or not they wish to display, in the list 
field for the objects selected, the mslink and ID of the pool file for objects and the file 
position and file number for CAD elements.

Pull-down menu: Objects

The entries in this menu permit various manipulations of the objects selected, so they 
can only selected if the user is currently working in a sisNET job.

Delete

Selecting this menu item results in the deletion of all the objects selected in the selection. 
Before executing the delete command, the user is asked once more, for security purposes, 
whether they really wish to delete the number of objects displayed in the list window. The 
deletion is only actually done if this question is answered with OK.

Lock

This function locks the selected objects in the inventory files (network maps) and copies 
them to the current job. This means that these objects can now be edited like completely 
normal job objects. It is only when the job is saved that they are saved again in the 
relevant inventory files.

Edit...

This function enables the user to globally change database attributes of all the objects in 
the selection list of the object type which is highlighed in the list with the scrollbar. When 
this menu item is selected, the data entry mask for this object type opens in so-called 
“Prototype mode” (See “Data input mask” Page 78). Now the user can make the changes 
they want in this mask and confirm their entries with OK. At this point, they are asked again 
whether all of the objects of this type that are listed in the selection list are to be changed.

The changes entered are only made when this question is confirmed with OK.
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Create relation

This function enables relations to be created globally for all the objects entered in the 
selection list. When this menu item is selected, the user is prompted to click the relation 
object. Relations for the selected objects can only be created for a specific new relation 
object which needs to be selected by clicking. All the objects selected in the selection are 
then given a relation to the object that was clicked.

Delete relations

For the objects selected with the scrollbar, the relations to a specific object and to an object 
type can be deleted. To do this, the user needs to select the relevant sub-menu item.

If the relation to be deleted is to a specific object, the user is prompted to click the relevant 
object to remove the relation. When it is clicked, and confirmed with the Data button, the 
relation of the objects selected with the scrollbar to the object clicked is deleted.

If the relation to be deleted is to an object type, the “To the Object type” selection box 
opens which can be used to select the object type to which the relations are to be deleted.

The user needs to select the object type they want from the list field in this box and 
confirm with OK, then the relations to all the objects of this type are deleted.

Pull-down menu: Filter
The user can use this menu item to create new filter definitions or open, activate or edit 
existing filter definitions.

For the functionality of filters, and the methods of editing and creating them, please refer 
to the description in the menu “Thematic Analysis > Activate” (See “Thematic Analysis > 
Activate” Page 101).
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By default when a selection is displayed, a filter is activated through which the selected 
objects are displayed in the highlight colour and all the remaining ones in grey. If one 
wants the non-selected objects to continue displaying in their original colour, the 
relevant flag for “All_remaining” needs to be deactivated.

Selection with standard report...
This function can be used to create summary statistics in a file format and, at the same 
time, automatically display it.

Firstly, the selection window for the database selection opens Database selection (Page 132). 
The required selection can now be made here.

Now the Report by Selection window opens.

Format: Here you can choose from between the output formats *.html, *.xml, *.xls, 
*.doc and *.csv.

Output file: The storage location for the output file is specified here. By clicking the button 
with the three dots you can enter both the path you require and give it a name. Select 
“Open” to confirm the path and file name, or “Cancel” to close the window and discard 
any changes. If no new name is explicitly given, the default name (“datasetexport”) is kept. 
However, this may also overwrite existing files with the same name!
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Document title: Here you can enter any title you want for the report.

XSL file: Here you can select an appropriate XSL file.

Object Info reference: Here you have the option of specifying an Object Info reference.

System attributes: If this option is activated, the system attributes are also put into the 
report.

Sort: If this option is activated, you can select both the column on which the sort is to 
be based and specify the type of sort (ascending/descending).

Clicking “OK” triggers the save process and opens the file in the relevant application. 
“Cancel” discards the entries and the dialog closes with no further action.

Report from template…
This menu item enables you to produce reports on your data inventory. To do so, report 
definitions will need to have been created beforehand, usually by your administrator. 
You can then select and run them here.

2 different report generators can be used here:

1. Report templates can be run in the SAP Crystal Reports format. This enables you to 
generate reports with any amount of complex formatting, which can then be 
exported and printed in different formats (Word, Excel, PDF, etc.). Here is an example:

2. Reports can be produced in the *.lst file format from report definition files (*.rds).

Selecting this menu item first of all opens the “Report definitions files” file selection box, 
which is used to select an existing report definition file (for creating report definition files 
and their syntax, see the SISREPORTGENERATOR guide).
sisNET Suite - User Guide 143



The Selection menu
Object Search

5

In the file selection box, the path for selecting a report definition file is, by default, set to 
the one that the environment variable SISNET_DIR_REPDEFSEL points to. 

You confirm the selection with OK. The results file window then opens. You can specify 
in this where the *.lst file is to be saved and which name it is to be given. By default, the 
path in the SIS_LOCAL environment variable is proposed.

Object Search
A dialog opens which enables one or more predefined database queries to be run. 
The top input field enables you to select a query that your administrator has predefined. 
Depending on the query definition, you can then restrict the query in one or more input 
fields. You can also use selection lists instead of input fields. This depends on the query 
definition. For background information on creating and using selection files, please refer 
to the sisNET administration guide.
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Selecting the “Search” button triggers the query. The result then displays in a table in the 
lower half of the dialog. The content and headers of the result’s columns depends, again, 
on the query definition.

The individual rows in the table enable you to select, while the right mouse button opens 
this context menu:

View object geometry
The graphic for the object selected appears in the map display

View attributes
The attributes mask for the object selected appears in read mode

Edit attributes
The attributes mask for the object selected appears in edit mode

Export table to Excel
The table content is exported to a new Excel table

Save as selection and display
The table content is moved to a sisNET selection (saved in the user’s selection table and 
the sisNET selection dialog opens, where you can further process the objects selected)

Save as selection and display adjusted
Here the objects selected are displayed fitted into the map view and highlighted - see 
Highlight (Page 137)
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6 The Application menu
The “Application” menu groups functions that enable users to process or display the data 
inventory from different perspectives. For example, elevation profiles, area network 
plans and length statistics can be generated.
Coordinate system module
The coordinate tool is used to display and convert drawing coordinates in different 
coordinate systems. Particularly in the case of data inventories which include a very 
large area so that different regional systems overlap, a key question is: “What are the 
coordinates of Point X in coordinate system Y?”

Task: Select from the “Application” menu:

Enables conversions between different 
coordinate systems

Coordinate system module (Page 147)

This function enables any elevation profiles 
which have been generated to be displayed 
graphically

Display elevation profile... (Page 151)

This function enables any areas that have been 
specified to be graded

Blend tool... (Page 152)

This function enables an isolation tracing zone 
associated with a particular pipe section to be 
displayed

Isolation tracing zone... (Page 152)

Hydraulic calculation module Hydraulic calculation network model... (Page 152)

Electrical calculation module Electrical calculation network model... (Page 152)

Enables network paths to be displayed 
according to different criteria

Network paths... (Page 153)

This function enables a schematic display of an 
electricity station to be generated

Schema... (Page 154)

Activity recording Activity recording... (Page 154)
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Configuration
The system tables required are created during installation. The configuration of the 
coordinate system module is saved in them.

The very first time that the coordinate system module is launched, if the system tables 
are still empty, a message appears saying that the coordinate tool has not yet been 
configured. So you need to configure it.

A new version of the coordinate system module may also mean that the structure of the 
system tables needs to be changed. If so, a message appears prompting you to reconcile 
databases using sisCONF. In such cases, first run the database reconciliation with 
sisCONF, and then the default configuration.

Standard configuration 
The coordinate tool provides the option to run a standard configuration which will 
be sufficient in most cases. It is triggered in the coordinate tool via the menu item 
“Configuration> Reset to standard configuration”

W The standard configuration can only be run by a user in the “Admin” group.
The standard configuration deletes the previous configuration. So a further security 
question gives the user the opportunity to abort the standard configuration.

A series of standard coordinate systems is now loaded to the system tables.

In the next step, the user needs to select the internal sisNET coordinate system from 
the available coordinate systems (see image). It displays the coordinate system in 
which all the sisNET geodata is saved. So it is the reference coordinate system for the 
coordinate tool.

When the selection made has been confirmed with OK, a message displays about 
the successful configuration. After a reboot, the coordinate tool becomes available.

✍ User-defined configurations of the coordinate tool are the task of the administrator. 
They will find a description of the system tables that hold the configurations in the 
application module configuration guide.
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When the coordinate tool is configured, selecting the menu item “Coordinate Tool” 
opens the “Coordinate Tool” dialog box.

Coordinate display field

The coordinate display field shows the coordinates of the current position in the active 
systems. The current position can be determined in various ways:

1. By entering coordinates in the coordinate display field

2. By selecting a position in an MS view with the mouse’s Data button

3. By dynamic calculation while moving the mouse within a view

4. By an ASCII import

5. By copying the coordinates from a GPS receiver

By clicking a cell in the column “Abscissa” or “Ordinate”, the value of the cell can be 
edited. If you leave the cell with the Tab or Return key, the coordinates of all other 
systems are recalculated.

Display menu

In the “Display” menu, you select the systems that are to be displayed.

The “Systems...” menu item contains a sub-menu with the known (i.e. configured) coordinate 
systems. You activate a system by selecting the system in this sub-menu. The selected system 
is then given an “Activated” symbol (in Windows: a tick). The coordinate display field has 
a new row added which displays the activated system. If, in the “Systems...” sub-menu, you 
select a system that is already activated, it becomes deactivated.

If the “Valid for area only” menu entry is activated, the coordinate tool automatically 
determines which coordinate systems are displayed. Every coordinate system definition 
is given a definition area (e.g. Gauß-Krüger3 from 7.5° east length to 10.5° east length), 
the coordinate tool calculates the geographic coordinates of the position required, and 
only displays the coordinate systems whose definition area includes the current position. 
If “Valid for area only” is activated, the “Systems...” menu entry is deactivated, because 
systems are selected automatically.
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Coordinates menu

The user uses the “Coordinates” menu to specify the type of current position calculation 
or display the current position.

If the “Dynamic display” menu item is activated, the current position is continuously 
calculated, and displayed in the coordinate display field, as the mouse is moved within 
a view. The dynamic display can be deactivated by selecting the menu item again or using 
the Reset (right mouse) button.

The “On mouse click” menu item enables individual positions to be clicked. The Data 
button triggers a recalculation of the current coordinates, and the Tentative functionality 
can be used here (see MicroStation help). This mode, too, can be deactivated by selecting 
the menu item again or using the Reset (right mouse) button.

Configuration menu

The “Run standard configuration” menu item deletes the existing configuration of the 
coordinate tool and replaces it with a standard configuration. The standard configuration 
is described in chapter Configuration on page 234.

The following coordinate systems can be selected in sisNET:

• geographic coordinates, DHDN 1995 (degree, decimal)

• geographic coordinates, S 42/83 (degree, decimal)

• geographic coordinates, WGS 84 (degree, decimal)

• geographic coordinates, DHDN 2001 (degree, decimal)

• geographic coordinates, WGS 72 (degree, decimal)

• Gauss-Krüger 2 - DHDN 1995

• Gauss-Krüger 3 - DHDN 1995

• Gauss-Krüger 4 - DHDN 1995

• Gauss-Krüger 5 - DHDN 1995

• Gauss-Krüger 3 - S 42/83 LSA, Mecklenburg

• Gauss-Krüger 4 - S 42/83 LSA, Mecklenburg

• Gauss-Krüger 5 - S 42/83 LSA, Mecklenburg

• Gauss-Krüger 2 - 9° (6° strips) - S 42/83 DDR

• Gauss-Krüger 3 - 15° (6° strips) - S 42/83 DDR

• Gauss-Krüger 2 - DHDN 2001

• Gauss-Krüger 3 - DHDN 2001

• Gauss-Krüger 4 - DHDN 2001

• Gauss-Krüger 5 - DHDN 2001

• UTM 2 - 9° - Brandenburg (Zone 32)

• UTM 3 - 15° - Brandenburg (Zone 32)
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• Gauss-Krüger 3 - PD 83 Thüringen

• Gauss-Krüger 4 - PD 83 Thüringen

• Gauss-Krüger 4 - RD 83 Sachsen

• Gauss-Krüger 5 - RD 83 Sachsen

• Gauss-Krüger 2 - DHDN 2001 Nord

• Gauss-Krüger 3 - DHDN 2001 Nord

• Gauss-Krüger 4 - DHDN 2001 Nord

• Gauss-Krüger 5 - DHDN 2001 Nord

• Gauss-Krüger 2 - DHDN 2001 Mitte

• Gauss-Krüger 3 - DHDN 2001 Mitte

• Gauss-Krüger 4 - DHDN 2001 Mitte

• Gauss-Krüger 5 - DHDN 2001 Mitte

• Gauss-Krüger 2 - DHDN 2001 Süd

• Gauss-Krüger 3 - DHDN 2001 Süd

• Gauss-Krüger 4 - DHDN 2001 Süd

• Gauss-Krüger 5 - DHDN 2001 Süd

About the datum shift: A datum shift occurs if one ellipsoid datum is transformed into 
a different ellipsoid datum. There is no datum shift when switching from the meridian 
strip to the same ellipsoid datum. The datum shift is calculated as follows (simplified): 
Coordinates in the initial coordinate system -> Coordinates in the WGS84 -> Coordinates 
in the target coordinate system.

Display elevation profile...
This module is described in Display elevation profile (Page 235).
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Blend tool...
This module enables areas to be blended with areas, areas with lines and areas with 
points, so that new objects are generated. These can also be saved as a DGN file.

Isolation tracing zone...
This module is described in Isolation tracing zone (Page 191).

Hydraulic calculation network model...
The “Hydraulic calculation network model” module is a standalone program which does 
not come as standard with sisNET, but which can be purchased as an add-on application.

This module is described in Generating hydraulic calculation network models (Page 195).

Electrical calculation network model...
The “Electrical calculation network model” module is a standalone program which does 
not come as standard with sisNET, but which can be purchased as an add-on application.

This module is described in Generating electrical calculation network models (Page 225).
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Network paths...
With the “Network Paths” application module, users can display connecting pipe sections 
between any two selectable start and end points of pipes which satisfy certain, freely 
selectable conditions (shortest path, paths below a certain length, etc.). The option is 
also provided to search for and display all the paths with a specified length, starting 
from a freely selectable point on a pipe.

Prerequisites for using the Network Paths module
Because the sisNET data structure can, to a great extent, be freely configured, the 
Network Paths module can be configured to different customer data models. To do this, 
the associated sisNET object types from the sisNET schema for the current category, and 
the required display attributes, need to be assigned to the object types which are to be 
differentiated in the Network Paths module.

Only two object types are required for the Network Paths module:

• the node object type, with the connection object between the pipe sections (this is 
usually the situation point), and

• the pipe object type for the pipe objects whose path is to be displayed as a network 
path. The application module attribute for the length of the pipe is also required for 
the pipe object type.

To search for paths, certain conditions, described below, are also required for the data 
model in the customer schema.

1. The pipe objects are all linked to one another by common node objects (e.g. situation 
points).

For this program module to be started, an environment variable SIS_LOCAL needs to be 
defined. The value of SIS_LOCAL should point to the sisNET work directory. As soon as 
the program has been configured once, the parameter file wayxxx.par (xxx is the internal 
number of the category for the parameter file), containing the settings made while 
configuring the program, is created in the directory defined by SIS_LOCAL.

Using the Network Paths module
The “Search for paths” dialog in the “Network Paths” module is used to search for paths. 
This is where you specify the pipe path to be searched for (shortest path, paths with 
a length, etc.) and start the search for it:
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After selecting the search mode (all paths, shortest path, all paths up to a length, all paths 
with a length) and, possibly, entering the maximum or required path length, you select 
the “Start” button to trigger the path search. The user guide in the sisNET main menu 
prompts the user to click the start and end point for the network path to be searched for. 
In line with the conditions that have been entered, the system then searches for the 
relevant network path and displays it in the highlight colour selected.

If the “Add to selection set” box has been checked, the pipes in the path found are 
written to the current sisNET user’s selection table.

The “Parameter” button can be used to change the setting parameters for tracing the pipes.

The last selected settings in each case are saved in the current sisNET user’s user settings.

Schema...
This module is used to generate schematic displays of stations in the electricity category. 
The station required is selected and the function is then started.

Activity recording...

This function can be used to create a statistical analysis of the sisNET objects that have 
been included. This statistical analysis can be created for a job, an mslink area or a period. 
To be able to use the function, a special resource file “auswert.r”, or its compiled version 
“auswert.rsc” needs to be installed. There is a sample “auswert.r” file in the DEFAULTS 
folder in the sisNET installation.

Analysis dialog
When selected, the “sisNET Activity Reporting” dialog box opens where the job name 
required for the Job mode should be selected. When the Start button is selected, the 
output file is queried and the analysis is generated.
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Mode

The mode is used to select the type of activity recording. You may select from 3 modes.

1. Job - All the objects in a job are included

2. Contractor (MSLINK) - All the objects in an MSLINK area are included.

3. Contractor (Import) - All the objects that have been imported within a particular 
period are included.

Contractor

This button enables you select from the contractors that have been defined in the 
auswahl.r configuration file.

Job name

This option button is only active in Job mode. In this case, any existing job can be selected 
for activity recording from the pulldown menu.

From date and To date input fields

These input fields are only active in the “Contractor (MSLINK)” or “Contractor (Import)” 
modes. In the “From date” input field, you specify the start date you want for the activity 
recording, while in the “To date” input field you specify the end date you want.

Using the tool

A prerequisite for using the tool as a whole is a special configuration file auswert.r, 
or its compiled version auswert.rsc. The compiled file must be located in the usual 
RSC directory in the sisNET installation. There is a more detailed description of this 
configuration file in the sisNET administration guide.
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7 The Extras menu
The functions grouped into the “Extras” menu enable users to, e.g., custom-design 
various system settings.
General settings
This menu item opens the “General settings” dialog box, in which the user can use 
various tabs to apply user-specific settings. The general settings are saved for the specific 
user even after exiting from sisNET.

Task: Select from the “Extras” menu:

Manages the attachment mode of time-marked 
reference files and the highlight colours of selected 
objects

General settings (Page 157)

Switches debug information on or off for the macro 
functions

Debug Info On/Off (Page 163)

Refreshes the coordinates of the active drawing file Update active file range (Page 165)

Refreshes the coordinates of any files Update range of other files (Page 165)

The function can be used to check the consistency 
of any pool files

Check consistency > Repository file (Page 166)

The function can be used to check the consistency 
of all pool files of one type

Check consistency > Repository files by type 
(Page 167)

The function can be used to check the consistency 
of any individual objects

Check consistency > Single object (Page 168)

The consistency of a file is to be repaired Repair consistency > Repository file (Page 169)

The consistency of an individual object is to 
be repaired

Repair consistency > Single object (Page 169)
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The Timer tab

Timer: Without Ref. files
A freely selectable file type with a timer marking can be given to all file types that are to 
be attached as reference files The effect of the timer marking is that files of this type are 
continuously updated and re-attached at time intervals that must be specified. The timer 
marking, of course, is only of use with “living” files, i.e. those such as job files and pool 
files which are subject to constant change. There is no point in time marking static files 
such as base maps.

A timer function is only ever active if sisNET is in Create mode, i.e. a Create box is open.

Activating this setting field deactivates the timer function for the file type given the timer 
marking.

Timer: Reload most recent only
If this setting is selected, when each new, time-controlled image build takes place, the 
only reference files reloaded are those whose creation date (incl. time) has changed since 
the last image build (e.g. other users’ jobs).

Timer: Error messages On
When this setting field is activated, an error message appears if a reference file which 
should be attached is missing.

Reload on view
This function can be used to select the view in which the reference maps to be attached 
are displayed. When sisNET is rebooted, a check is run to see whether the view specified 
here really is the active view. If not, the setting is reset to “View 1”.

Reload interval
This function can be used to set the time interval after which the time-marked reference 
files are to be reloaded. Possible intervals are 5, 10, 20, 30, 60 and 90 seconds. The STOP 
setting can be used to switch off the timer function.
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General settings
The Colour tab

Colour locked objects

This function can be used to define the highlight colour for locked objects. The objects 
that are selected with the function “View > View locked objects” (See “View locked 
objects” Page 127) are displayed in the highlight colour selected.

Colour active objects

This function can be used to define the highlight colour for active objects. The objects 
that are selected with the function “Edit > View active objects” (See “View active objects” 
Page 127) are displayed in the highlight colour selected.

Colour active elements

This function can be used to define the highlight colour for active elements. The elements 
that are selected with the function “Edit > View active elements” (See “View active 
elements” Page 127) are displayed in the highlight colour selected.

The Action tab

Preserve constraint on object change

You can use the “Preserve constraint on object change” setting field to specify whether, 
when manipulating constraint objects, the constraint is to be lifted or not.
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Automatically open last active category

This setting field enables you to display the content of a job file depending on the current 
factor. A prerequisite for this setting to work is that the info field DFLT_SIS_RANGEVIEW 
is defined in the config.r configuration file in the SISNET_DEFAULT_KUNDE structure (see 
configuration guide, “Structure and content of configuration files”). There also needs to be 
a *.dat file in which the levels to be displayed or not displayed for a particular factor need 
to be defined. The structure of these files is the same as the files for setting a particular 
level symbology (see onfiguration guide, “Directory structure and environment variables”). 
The concept of displaying the drawing concept in a way which is view-dependent is based 
on switching levels off. If you want to manage the view content in a way which is object-
related, this needs to be managed using relevant filter functions.

The Output tab

HTML output for filter description

This option can be used to manage whether the definition and description of a filter 
selected with the scroll bar in the “Filter” dialog box (See “Thematic Analysis > Activate” 
Page 101) is to be displayed as a pure text file or with the operating system’s HTML 
viewer (See “Thematic Analysis > Activate” Page 101).

The Job tab
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Export job before saving

This option needs to be activated if there is an intention to share data from different, 
non-networked data entry computers with a central system (e.g. if a company is entering 
data at different locations).

If this option is activated, the graphic for a job is saved as a *.dgn file when it is saved, 
while the associated object data is saved in a separate ASCII file. The export process runs 
in the same way as the method described in the menu “File > Data Exchange > Export 
(sisNET format)” (See “Data Exchange > Export in sisNET format” Page 43).

Export without confirmation

If this option is not activated, when the user saves a job and the previous option 
(“Export job before saving”) is activated, a warning box asks them again whether 
the job really should be exported prior to saving.

Confirming with Yes exports the job and saves it, confirming with No does not export 
the job and saves it.

Compress job DGN on job closure

If this job is activated, the current job file is compressed when leaving the job.

Discard log file for successfully completed jobs

Discard log file for successfully completed jobs

If this option is activated the log files for a job are automatically deleted after it has 
been saved or discarded.

The CP Tab
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No conversion of MS points to CP

In the sisNET toolbox for the point tools (See “sisNET Tools - Help construction” Page 96), 
only the “Construction point” button generates a construction point immediately. The 
other buttons in the CP sub-palette are actually MS tools that only capture the MS 
command they displace and normally generate actual sisNET construction points instead 
of MS CAD points. If the user does not want this, they need to explicitly select the “Skip 
MicroStation point to Construction point(CP) conversion” option in this box. The points 
these buttons generate are then pure CAD points with no user link, as if they had been 
generated with the original MS tools.

The Fence tab

Keep fence after action

By default, the fence is deleted after running a fence operation with the fence-related 
tasks (See “sisNET Tools > Fence” Page 87). If one wishes to carry out other operations 
with relation to this fence, one would have to put the fence back in place. Re-positioning 
the fence can be avoided by activating the “Keep fence after action” option. The fence 
then remains active even after running a fence operation.

Search for all objects & CAD elements in fence

If this option is activated, all the objects and CAD elements included within the fence are 
selected when the fence is selected (See “sisNET Tools > Fence” Page 87). If this option is 
not activated, the user can use the “Objects” dialog box to select which objects or CAD 
elements they wish to select in the fence.

During fence search:

The options below this heading specify which graphic aspects of sisNET objects are 
to be included when searching in the fence. These may be main graphics, annotations, 
transition cells or parts.
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The Limits tab

This menu can be used to make various settings with relation to the maximum number 
of particular view factors. The settings are possible for the following points:

• Max. nesting depth for object notification

• Max. number of selected records

• Max. number of attached files

• Max. number for attaching files without progress indicator

Debug Info On/Off
This function opens the “Debug Settings” dialog box, which the user can use to make 
settings for the debug information for the programs that are running for the active 
functions (e.g. creating an object). These functions are usually only of interest to system 
administrators when changing or creating an application module, as they enable the flow 
and functionality of the programs and macros that have been created to be examined.

The Action tab

Messages

Checking this box enables the debug messages to be viewed. This field is activated by default.

Time stamp

When this box is checked, the start and end time of an action is logged.
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Time difference (init. overall)

When this box is checked, the time difference between the start and end of an action 
is logged. The time difference is given in “clicks” (each approx. 1/30 s).

Input Queue

If this option is activated the only commands that appear in the message window are 
those that are passed from sisNET to MicroStation.

The Output tab

Output file

Checking this box writes the debug messages to an output file. The log file is called 
sisdbg.txt and is written to the directory which the environment variable SIS_LOCAL 
points to. The resulting output file can only be opened with a suitable editor if the 
debug mode has been switched off again.

Dialog box

Checking this box writes the debug messages to the Messages dialog window so they 
can be seen on the screen.

Total time display

Selecting this button displays the total time of a completed action (e.g. creating a pipe).

The Stops tab
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Task

Checking this box logs only the messages for a particular task (e.g. eval, commit etc.) 
whose name must be specified in the related input field.

Function

Checking this box and clicking the associated button opens a pulldown menu from which 
the user can select a particular program function. In this case, the debug file only logs the 
execution of this function.

Object

Checking this box and clicking the associated button opens a pulldown menu from which 
the user can select a particular object type from the application module. In this case, the 
debug file only logs messages about this object type.

ID

By checking this box and entering an object ID, you only log messages about the object 
with the ID entered.

Use MicroStation debugger

Checking this box activates the MicroStation debugger, which enables you to monitor 
in detail how the program runs in the source code.

Update active file range
Refreshes the size and range of a basic map, a job or another DGN file which is being 
managed in the pool table. All of these files have a default value for the coordinates of 
the bottom left and top right corners. These pre-set values can be changed during the 
files’ life cycle if, e.g., pipes have been drawn beyond the original area of a basic map. 
To refresh the geographic range and save the actual parameters, the “Update active 
file range” function can be used. The function refreshes the range of the current file 
in contrast to the “Update range of other files”, which can be used to refresh any files.

Normally when working with sisNET, the range is automatically refreshed in the pool table. 
The function is only used to correct any inconsistencies that have arisen between the 
geographic range of a map and the value entered in the pool table. Such inconsistencies 
can occur if, for example, inventory maps from a third party system are copied without the 
associated records in the pool table.

Update range of other files
Refreshes the size and range of a basic map, a job or another DGN file which is being 
managed in the pool table. All these files have a default value in terms of their geographic 
range. These pre-set values can be changed during the files’ life cycle if, e.g., pipes have 
been drawn beyond the original area of a basic map. To refresh the geographic range 
and save the actual parameters, the “Update active file range” function can be used. 

The “Pool files” file selection box opens which can be used to select the file whose range 
is to be updated.
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Normally when working with sisNET, the range is automatically refreshed in the pool table. 
The function is only used to correct any inconsistencies that have arisen between the 
geographic range of a map and the value entered in the pool table. Such inconsistencies 
can occur if, for example, inventory maps from a third party system are copied without the 
associated records in the pool table.

Check consistency > Repository file
The “Check consistency” function runs a consistency check. This consistency check is 
used to identify any differences between the graphic and the database. The consistency 
check routine works bidirectionally, i.e. on the one hand it checks whether there is an 
entry in the database for every element and, on the other hand, whether there is 
a graphic element for every database entry. 

Any pool files can be checked with this function. This type of check is recommended, 
e.g. before a job is copied to the archive. It ensures that only consistent jobs are added 
to the general data inventory.

When this function is selected, the “File to test” file selection box opens, from which 
the user selects the name of the pool file to be checked.
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“OK” triggers the check, while “Cancel” aborts the process.

When the check is finished, the user is asked whether the test report is to be displayed.

The “OK” button outputs the report to an editor window. You can skip the report 
with “Cancel”.

Check consistency > Repository files by type
This function checks all the pool files of one type. This type of check is recommended, 
e.g. before a job is copied to the archive. It ensures that only consistent jobs are added 
to the general data inventory.

When the function is selected, first of all the following window appears:

“Yes” continues the process, while “No” aborts it. In the next window you select the type 
that you want to be checked.
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“OK” triggers the check, while “Cancel” aborts the process.

When the check is finished, the user is asked whether the test report is to be displayed.

The “OK” button outputs the report to an editor window. You can skip the report 
with “Cancel”.

Check consistency > Single object
With this function, a single object is checked. This type of check is recommended, 
e.g. before a job is copied to the archive. It ensures that only consistent jobs are added 
to the general data inventory.

When the function is selected, the user is prompted to click the object that is to be 
checked. Pressing the Data button confirms the selection, while the Reset button aborts 
the process.

When the check is finished, the user is asked whether the test report is to be displayed.

The “OK” button outputs the report to an editor window. You can skip the report 
with “Cancel”.
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Repair consistency > Repository file
This function enables inconsistencies in pool files to be repaired. When this function is 
selected, a file selection box opens so that the user can select the files to be repaired. 
After confirming, the file is first checked for consistency. If an error is identified, a report 
first of all states which errors have been found and what needs to be done to repair them.

Here is a typical report:
***************************************************************************************
Log: C:\SIS_DATA\sislemgo\user\martin.icking\jg0000722b.013 - 26 05 11 22 06 27
User: mi
***************************************************************************************
-Object being checked ...
***************************************************************************************
Active file: C:\SIS_DATA\sislemgo\sisnet\dgn\gas\lokal\jg0000722b.dgn (29227)
***************************************************************************************
Scan: GR.:the element in the active file with the position=4000004; DB.:none; crit2:0
***************************************************************************************
 Object with no DB record:construction point,ID: 4392373
***************************************************************************************
File-end log:
1 elements have met the graphic search criteria !
1 objects have met the DB search criteria in 1 work processes
***************************************************************************************
1 files examined
1 elements (1 objects) have met the DB search criteria
1 error found
Repairing files as follows...

***************************************************************************************
Construction point,ID: 4392373 deleting the graphic found
***************************************************************************************

Now the user can trigger the repair.

Repair consistency > Single object
This function is similar to the repairing of pool files described above, except that here the 
user is prompted to select an object which is then checked and, if necessary, repaired.

Update pool files in DB
This enables the sisNET pool files to be saved in the database. By default, the sisNET pool 
files are only held in central directories on a file server. You can use this functionality to 
also store pool files (as so-called BLOBs) in the database. On the one hand, this provides 
improved security, since the files can be restored from the database. On the other hand, 
almost the entire sisNET project can be saved by backing up the database.
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When the menu item is selected, the dialog for setting and maintaining the file storage in 
the database opens.

Here you can select the individual map types that are to be saved in the database. The 
functions of the buttons in the lower half of the dialog:

Reset

Update

Save

Save all
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8 The Applications menu
The “Applications” menu holds entries which the user can use to change to the 
applications that are currently loaded.
Microstation
This function is used to change to Microstation. The Microstation menu shown in the 
image (below) then appears.

Please refer to the Microstation user guide for information and user instructions.

All the Microstation functions for editing drawing files are then available to the user. 
However, some editing functions are locked during a sisNET session so that no incorrect 
sisNET data is inadvertently produced.

sisNET
You can use this function to change to sisNET. All the sisNET functions are then available 
to the user. The sisNET menu shown in the image (below) then appears.

Task: Select from the “Applications” menu:

Change to Microstation Microstation (Page 171)

Change to sisNET sisNET (Page 171)
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9 The Help menu
The Help menu is like the MicroStation menu but with some additional items.
Contents
This menu item opens the “sisNET Online Help” window and displays the contents of the 
entire user guide.

Task: Select from the “Help” menu:

Displays the index of contents of the sisNET 
user guide

Contents (Page 173)

Displays the index of contents of the sisNET 
administration guide

Administration Guide (Page 174)

Displays an application module document in the 
HTML format

View schema documentation (Page 174)

Reproduces an application module document in 
the HTML format

Create schema documentation (Page 175)

Displays the sisNET version About Bentley sisNET V8i (Page 177)
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If you click the plus sign to the left of one of the reference subjects shown, you can view 
the subject’s sub-sections.

The structure in this index of contents is like a tree, so you can branch from each main 
subject to the related sub-sections.

Administration Guide
This opens the sisNET administration guide as a help file.

View schema documentation
This menu item opens the browser associated with the operating system (e.g. Internet 
Explorer) and displays a hierarchically structured list of content of the application 
modules (categories, classes, objects, file types and filters). You can branch from any 
main subject to its sub-sections by clicking the subject. If the documentation does not 
yet exist, it will be created.
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Create schema documentation
In contrast to the menu item above, here the application module HTML document is 
created anew each time it is selected. This may require a lengthy wait and only needs 
to be done if changes have been made to the application module.
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About Bentley sisNET V8i
This menu item opens the sisNET welcome screen with the version information.
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10 Configuring the application modules
Most application modules (e.g. Display altitude readings, Isolation Trace, Network paths, 
Hydraulic calculation network model) need to be customised for the current schema. For 
this purpose, every application module possesses its own data model with object types 
and associated attributes which is connected to the sisNET object types and attributes 
using the input dialogs described below.
Description of function
The first time that an application module is called within a category, the user queries the 
category-based assignment between module object type and sisNET object type for the 
module and saves it as the default configuration. The “Configure application module” dialog 
can be used to retrospectively change this configuration, and different configurations can be 
saved with different assignments to sisNET object types and attributes.

Description of the input dialogs

Configure application module
The “Configure application module” dialog (shown for the isolation trace zone in this 
example) enables the user to edit all the object types in the application module being 
called for the configuration that is currently loaded:
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Object types

Contains the names of the object types for the application module.

New

Select the “New” button to add another object type. Firstly, the “New object type” dialog 
opens for entering the name of the object type. If no ID has been selected for the new 
object type, the “Select object types” dialog, for assigning the sisNET object types to the 
new object type, then opens.

Delete

Select the “Delete” button to delete an object type that is not required. This button is 
disabled for the object types that are required.

Edit

Select the “Edit” button to change the assignment of sisNET object types to the application 
module object type that is currently selected (“Select object types” dialog (Page 184)).

✍ No assignment is required for object types that are ID’d in sisNET, e.g. for the node and 
the connecting point. So the “Edit” button is disabled for those object types.

Attributes

Select the “Attributes” button to display or change the attributes of the object type 
currently selected (“Attributes for object type” dialog (Page 185)).

Config name

This text field displays the name of the current configuration. To save a changed 
configuration under a different name, this name needs to be changed and the “Save” 
button then selected.

Load

Opens the ““Load configurations” dialog” on page 188.

Save

Saves the current configuration under the name entered.

Delete

Opens the “Delete configurations” dialog for deleting a saved configuration.

New

Starts the reconfiguration of the sisNET plug-in module.

Export

Exports the current module configuration to a text file. For this purpose, a file selection 
dialog opens for entering/selecting the export file. After entering a file name (the name 
param.cfg is the default) and confirming with the OK button, the current configuration 
is exported to this file.
182 sisNET Suite - User Guide



Configuring the application modules
“New object type” dialog
Import

imports a module configuration file into the current configuration. This overwrites the 
current configuration. A file selection dialog opens for selecting the file to be imported. 
After selecting the import file and confirming the selection with the OK button, the 
selected file is imported.

“New object type” dialog
To create a new object type, the following dialog opens in which the name and, possibly, 
a sisNET ID are queried for the new object type.

Name

Field for entering the name of the new object type.

ID

An ID may be issued. The following options are available:

If no ID has been selected (this is usual), when the dialog is confirmed with OK the Select 
Object Types dialog (See ““Select object types” dialog” Page 184) opens for querying the 
sisNET object types associated with the new object type.

Delete

Deletes a user-defined entry from the list of defined object types.

ID Meaning

None No additional ID

CP Construction point

SP The object is a node

STRA The object is a street in sisNET

ADRS The object is an address in sisNET

ANPU The object is a connection point in sisNET
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“Select object types” dialog
This dialog enables the user to assign sisNET object types to an object type in the 
application module. Here sisNET object types are selected which, for example, are 
to take on the role of a stop point in the application module.

Add

The “Add” button adds the selected sisNET object type to the list of sisNET object types 
assigned to the application module object type.

Remove

The “Remove” button removes the selected entry from the list of sisNET object types 
assigned to the application module object.

Condition

Here you can specify a delimitation for the selected sisNET object type in the list of 
assigned sisNET object types. This delimiting condition must be entered in the database 
query language SQL and requires a knowledge of the database attributes of the relevant 
sisNET object type (only recommended for experienced users).

OK

The OK button confirms the changes in the dialog and exits the dialog.

Cancel

The Cancel button discards the changes in the dialog and returns to the previous window. 

Cancel configuration

The Cancel configuration button discards the changes in the dialog and exits the entire 
configuration process. 
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“Attributes for object type” dialog
The Attributes dialog enables the user to enter and change the attributes assigned to the 
current object type. In this example, the user can configure the attribute that is going to 
be used later on as the pipe status in the isolate trace zone.

The list of attributes includes the following columns:

• Attribute name: Descriptive name for the sisNET Param attribute.

• Type: Data type of the sisNET Param attribute. See Type (Page 186) for possible 
data types.

• Factor: Conversion factor used to multiply the sisNET attribute in order to get 
a numeric value in the calculation network model.

• sisNET object: sisNET object type assigned to the sisNET Param object type.

• sisNET attribute: sisNET attribute within the sisNET object type which determines the 
value of the attribute. The value may be multiplied by the factor for numeric attributes.

New

Select the New button to insert a new attribute in the attributes list (“New attribute for 
object type” dialog (Page 186)).

Delete

Deletes the selected sisNET Param attribute from the list.

✍ Depending on the object type, a certain number and type of attributes is mandatory for 
the calculation network model. These attributes cannot be deleted.

Edit

By selecting Edit you can change the entries in the selected row in the list (“Edit attribute 
for object type” dialog (Page 186)).

OK

Closes the configuration box and applies the changed attribute settings.
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“New attribute for object type” dialog
In the “New attribute for object type” dialog, the user must enter the name, the data 
type and, possibly, the scaling factor for an attribute which is being created:

For a description of the input fields (See ““Edit attribute for object type” dialog” Page 186).

You can use the “External attribute” button to specify that this attribute does not belong to 
this object type but is, rather, the attribute of a related object. If this button is selected, after 
the “OK” button is selected, the relation object type and its attribute need to be selected.

Then the “Assign sisNET attribute for attribute” dialog (Page -187) for selecting the 
associated sisNET attribute for each sisNET object type is queried.

“Edit attribute for object type” dialog
The user can change the attribute name, the data type and, for numeric attributes, 
the scaling factor for the attribute being edited:

Attribute name

The current attribute name can be changed in this input field.

Type

The following values are available for selecting the data type

Data type Meaning

CHAR Strings such as names and descriptive texts
REAL numeric, floating decimal value
DATE Date and time
INTEGER numeric, whole number value
BINARY Large binary objects from e.g. graphics stored in the data inventory
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Factor

The factor can only be entered for numeric types. The target value for the hydraulic 
model is derived from multiplying the numeric sisNET attribute value by the factor.

Change mapping of sisNETattributes?

The user can use the “Change mapping of sisNETattributes?” field to decide whether the 
attribute needs to be reassigned to the sisNET attributes. If this field is selected, when 
the OK button is selected to close this dialog, the “Assign sisNET attribute for attribute” 
dialog opens.

“Assign sisNET attribute for attribute” dialog
This dialog is used to assign the application module attribute an attribute of the 
corresponding sisNET object type. In this example, the attribute of the sisNET object type 
“AL Section” is selected, which is to represent the status of a pipe in the isolation tracing 
zone.

If the current sisNET Param object type has more than one sisNET object type assigned to 
it, an assigned sisNET attribute is queried for the current sisNET Param attribute for each 
sisNET object type.

If the attribute is not essential for the application module, you can also exit the dialog 
with “Cancel”.
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“Load configurations” dialog
The “Load configurations” dialog mask provides a list of the configurations that have 
been created for the current sisNET plug-in module.

OK

Loads the selected configuration and closes the dialog mask. The data is then available 
for further processing.

Cancel

Closes the dialog mask without loading a new configuration. The configuration data that 
has already been modified in the system is retained and can continue to be used.
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“Delete configurations” dialog
The “Delete configurations” dialog mask offers for deletion a list of the configurations 
that have been created for the elevation profile.

OK

Deletes the selected configuration and closes the dialog mask.

W The current configuration cannot be deleted.

Cancel

Closes the dialog mask without deleting a configuration.
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11 Isolation tracing zone
The “Isolation tracing zone” application module can be used to select and display related 
line sections which meet particular, selectable criteria.
Description of function
The “Isolation tracing zone” module is a standalone program which does not come 
as standard with sisNET, but which can be purchased as an add-on application.

The “Isolation tracing zone” function can be used to select and display related line 
sections which meet particular, selectable criteria. The selection conditions for the pipes’ 
section area which is to be selected can be specified using either a selectable attribute 
value for the pipe itself or for a stop point built into the pipe.

Conditions for using the isolation tracing zone
Because the sisNET data structure can, to a great extent, be freely configured, the 
isolation tracing zone can be configured to different customer data models. To do this, 
the associated sisNET object types from the sisNET schema for the current category, and 
the required display attributes, need to be assigned to the object types which are to be 
differentiated in the isolation tracing zone.

Only three object types are required for the isolation tracing zone:

• the node (without attributes).

• the pipe object type for the pipe objects whose isolation tracing zone is to be 
displayed based on a start point. The schema attribute for the status of the pipe 
(Operational/Not operational), which it might be possible to use as a criterion for 
aborting the isolation tracing zone search, is required for the pipe object type.

• the stop point object type for the stop point objects which might, under certain 
circumstances, restrict the search area. The schema attribute for the status of the 
stop point (Open/Closed), which can be used as a potential abort criterion for the 
isolation tracing zone search, is required for the stop point object type.

To create an isolation tracing zone, certain conditions, described below, are also required 
for the data model in the customer schema.

1. the pipe objects are all linked to one another by common nodes.

2. the stop points have a relationship to the pipe which is to be isolated and to a node in 
the pipe which is to be isolated.
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Using the Isolation tracing zone module

By selecting the search mode, the user can decide how the pipes in the isolation 
tracing zone are searched for, starting from the first pipe clicked on. These search 
modes are possible

• No restriction
this mode finds all the pipes that are connected to the starting pipe by a particular path.

• Stop by stop points
in this mode, and beginning with the starting pipe, all the possible pipe paths are 
followed until the program comes to any stop point that lies on the pipe. This search 
condition can be further restricted by only specifying a stop condition for selected 
stop points with defined attribute values.

• Stop by pipes/cables
in this mode, and beginning with the starting pipe, all the possible pipe paths are 
followed until the program comes to a pipe for which there is, or is not, depending 
on the choice of condition operator (= or !=), a particular attribute value.

• Stop by stop points and pipes/cables
this mode combines the two previous modes and identifies the pipes in the isolation 
tracing zone beginning with the starting pipe along a path until one of the specified 
conditions is met.

For this search mode there is an option to restrict the search to a maximum number of 
pipes. When this option is used, once the maximum number of pipes has been reached 
in the isolation tracing zone found, the user is asked whether to search for the same 
number of pipes again or abort the search.

The option “Add to previous isolation tracing zone” can be used to, after the 2nd 
isolation tracing zone search after the application is started, add the newly found 
isolation tracing zone to the one found previously.
192 sisNET Suite - User Guide



Isolation tracing zone
Isolation tracing zone settings
In addition to the search modes, the user can specify whether the search for pipes in the 
isolation tracing zone, beginning with the starting pipe, should only go in one direction 
(a directed search) or in both directions. With the directed search, they can also specify 
whether the search should go forwards or backwards in relation to the direction of the 
starting pipe. The directions forwards and backwards here relate to the beginning point 
of the starting pipe. Forwards means away from the starting point, while backwards 
means back to the starting point.

The Settings menu can also be used to configure the various settings for the isolation 
tracing zone:

Isolation tracing zone settings
The “Settings” dialog is opened under the menu item “Settings > Options”: 

Active stop point colour

Display colour for active stop points A circle in the colour selected in this dialog, plus the 
display size selected, indicate active stop points.

Other stop point colour

Display colour for non-active stop points. A circle in the colour selected in this dialog, plus 
the display size selected, indicate all the non-active stop points.

Isolation tracing zone colour

All the pipes belonging to the isolation tracing zone currently identified are shown in the 
colour selected.

Stop point display

This selection field is used to select the display size for the stop point, in pixels or metres.

Task: Selection from the “Settings” menu:

Configuring the object types pipe, stop 
point and node with their attributes

Configure application module (Page 181)

Options Isolation tracing zone settings (Page 193)
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Stop point size

You can enter the size you want as a numeric value (pixels or m) in the “Stop point size” 
field. If pixels is chosen for the display size, the size shown is independent of the current 
level, but it depends on the current level if you specify metres.

OK

You can close the dialog with the “OK” button. The colour and display size settings for 
each individual user are stored in a parameter file abxxx.par, where xxx stands for the 
category ID.

Initially configuring the Isolation tracing zone
You need to configure the object types node, pipe and stop point along with the 
attributes required for the isolation tracing zone.

To do this, first of all, for each object type (exception: node; the associated sisNETobject 
type node can be identified by the LP flag in the schema without any user query) the 
associated sisNET object type or types need to be assigned (See ““Select object types” 
dialog” Page 184).

Then, for each object type, the associated sisNET attributes must be queried for the 
attributes required (See ““Assign sisNET attribute for attribute” dialog” Page 187).
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models
Description of function
The network calculation models used when planning pipeline systems require time-
consuming, error-prone preparatory work to obtain data, particularly in large networks. 
As a result of the large data volumes and ever-changing customer structure, maintaining 
the data required for the network calculation is also associated with substantial costs.

At the same time sisNET is deployed as a GIS system for documenting and managing the 
pipe networks in the supply industry. sisNET is used to manage and maintain all the graphic 
information and object data from the company’s networks in a central, integrated system.

For companies who are simultaneously using sisNET and network calculation programs, 
the generating of hydraulic calculation network models, from now to be referred to as 
sisNET HR Module, provides an opportunity to connect these data-heavy systems to 
avoid keeping redundant data. The sisNET HR Module uses the GS data maintained in 
sisNET to generate input data for network calculation programs.

Because of the high level of detail in the data from pipeline networks that is held in GIS, 
and the consequent volume of data for the network calculation, which it is difficult to get 
an overview of, the sisNET HR Module also provides various methods for simplifying the 
network structure in an automated, reproducible way.

Requirements of the data structures in the GIS data
For it to be able to perform its tasks, the sisNET HR Module can be configured for 
a range of data structures both on the sisNET side and (to a limited degree) the network 
calculation side. We shall now describe what the sisNET HR Module requires of the data 
structures in the sisNET data and how the sisNET HR Module handles them.
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Data structures in sisNET

The data structures in sisNET are not usually specified in advance but can, to a very large 
extent, be configured by and for the end users, depending on their needs. In principle, a 
distinction is drawn between 2 different network structures when managing the network 
data in the sisNET:

1. Common route and pipeline data (the usual data model for 1-conductor networks 
such as gas and water networks):

• The pipeline topology is described by one or more pipeline object types in which the 
pipeline data, such as length, diameter, wall thickness, year of manufacture, etc., is 
also maintained.

• There needs to be a node at least at the beginning and end of the pipeline objects. 
The node must have relations to the pipelines beginning and ending at the node, so 
that the network structure can be calculated using the relations between pipelines 
and nodes.

• The nodes between the pipeline objects must have, as an attribute, at least one 
elevation value for the position of the pipeline.

• In the case of networks with more than one conductor, (e.g. district heating networks), 
the possibly differing attributes such as internal diameter, K-value and cladding 
diameter must be present with this type of data structure for each conductor.

• If connecting systems are being worked with in the data inventory, a distinction may 
be drawn, with the pipeline objects, between supply line and connecting line. To be 
able to distinguish supply lines and connecting lines, there needs to be either different 
object types or a pipe type attribute.

• In the case of data inventories in large companies, there is also a relation of pipeline 
objects to an object of the network type. This assignment can be used to restict the 
model generation to one or more networks.

2. Separate route and pipeline data (the usual data model for multi-conductor networks 
such as in the district heating sector):

• The pipeline topology is described by one or more route objects which only describe 
the local path of the pipeline network.

• There needs to be a node at least at the beginning and end of the route objects. The 
node must have relations to the pipelines beginning and ending at the point, so that 
the network structure can be calculated using the relations between route objects 
and nodes.

• For each conductor in the network (e.g. supply and return or steam and condensation 
pipe) there is, in parallel to the route object, a pipeline object with the relevant 
pipeline data such as length, diameter, wall thickness and year of manufacture. These 
pipelines are connected to one another by nodes, too. The pipeline objects must have 
a relation to the associated route object. The pipeline objects also need to have an 
attribute for determining the conductor (supply/return or steam/condensation). 

• The nodes between the pipeline objects must have, as an attribute, at least one 
elevation value for the position of the pipeline.
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As a further object type for generating a calculation model, there needs to be at least one 
consumer object type for determining the connection power or the volume consumed by 
heat consumers. The consumer object type (the building connection in the default district 
heating application module) must have a relation to a node which, in turn, must have 
a relation to a route object (for separate route and pipe data) and to a pipeline object 
type. If, in the case of consumer objects, no consumption quantity is being maintained 
(this is normal) there must be either a unique ID for assigning the consumption data from 
a customer charging system or the address of the consumption point either as attributes 
for the consumer object type or via a relation to an address object.

For the feed object type, too, the same relation requirements apply as with the consumers; 
however, this object type is not essential for generating a calculation model - the feeds can 
be added to in the hydraulic calculation program.

The hydraulic object types pump and stop point must have a relation to a node which, 
in turn, must have a relation to a pipeline object type. The stop point must also have 
a relation to the pipeline object type which is to be isolated, and the pump must have 
a relation to the pipeline object type which the pump delivers to or from. The pump 
and stop point object types are not essential for generating a calculation model and 
can be added to in the hydraulic calculation program.

In many application modules, connecting systems are also used to input the service 
connection pipes including the service connection. The outflow point of the connecting 
system from the so-called supply pipe is indicated, here, by a connecting point type 
object. Each connecting point must lie on a node of a supply pipe and have a relation 
to this point. All the connecting pipes and the service connection have a relation to this 
connecting point.

Data structures in network calculation programs
In contrast to sisNET, network calculation programs use data models which are 
fundamentally similar, due to the same physical descriptive equations which are to be 
applied in each program. The objects that occur in almost every calculation program are:

• Pipe runs,

• Nodes,

• Consumers,

• Suppliers,

• Pumps,

• Stop points.

Advanced network calculation programs, such as the SISHYD network calculation 
program, have a large number of objects in addition to these, which can be used 
to describe networks’ installations, control elements, operating methods, etc.

The sisNET HR Module focuses on transmitting the mass data from sisNET so that the 
supplementing of the calculation network data through the objects, which are weakly 
represented in numeric terms, is done manually after the automated transformation 
of the sisNET data.
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In addition to the 6 standard object types mentioned initially, the sisNET HR Module 
creates object classifications which enable users to specify particular object properties 
for entire groups:

• Pipe classes,

• Consumer groups,

• Organisation groups,

• Pump types,

• Fitting types.

The sisNET HR Module can generate the groups and associations to a group both 
automatically and configured by the user. There is more on this in “Generating the 
calculation network model” on page 204.

Object types in the sisNET HR module
Due to the minimum technical data requirements of pipe network calculation programs, 
the sisNET HR Module has 20 object types, in all:

• Network,

• Sub-network,

• Nodes,

• Connecting point,

• Route (only for multi-conductor networks with separate route and pipeline data),

• Pipe,

• Connecting cable,

• Consumers,

• Suppliers,

• Pump,

• Stop point,

• Disconnecting point,

• Hydrant (for water only),

• Hydrant (for water and WaterCAD export format only),

• Tank (for water and WaterCAD export format only),

• Pipe classes,

• Consumer groups,

• Organisation groups,

• Pump types,

• Fitting types.

We shall now describe these object types and their minimum attibutes.
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Network

This object is currently only used to restrict the model generation to one or more 
networks in the data inventory.

Sub-network

This object can be used to divide the network into different geographic areas. If sub-
networks are to be generated, each pipe object must have a relation to a sub-network 
object (in the water category e.g. the pressure zone).

Node

The nodes in the calculation network model are generated from the start and end points 
in the route line sections and from interim nodes in route sections with associated 
branch route pipe, pump or stop point. The minimum attribute is the geodetic height, 
a corresponding sisNET attribute is to be provided. Other attributes can be configured. 
Attributes generated by the sisNET HR Module are:

• Node name: unique text identifier for the node; in multi-conductor systems, supply 
and return nodes, like the pipes, are identified by an appended ‘V’ or ‘R’.

• Node number: unique numeric identifier for the node. Used in the relational link 
to the pipes.

• X, Y coordinates: derived from the graphic position of the nodes in sisNET.

• Z coordinate: where there is separate route and pipeline data, calculated from the 
elevation values of the nearest pipeline nodes, otherwise directly from the node in 
the pipeline section.

Connecting point

This object is only used to combine connecting lines and service connections into 
one connecting system. When generating the network model without including the 
connecting lines, the consumer assignment to the supply pipe from which the connection 
system leaves is derived from the position of the connection point.
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Route

This object relates to the route (mid) line usually maintained in sisNET in multi-
conductor systems. 

In sisNET, the physically existing pipes have a technical data relation to this route line. 
So that, the data for the pipes and nodes for supply and return can be managed together 
in the pipe network calculation program, the network geometry is calculated from the 
path of the route line and not from the path of the pipelines. This enables a symmetrical 
supply and return path where possible. As the route line itself is inconsequential for 
a network calculation, the sisNET HR Module does not export it; no attribute information 
can be configured for this object, either. The user can assign one or more sisNET objects 
to the route object.

Pipe

This object’s minimum attributes are length, internal diameter (or external diameter and 
wall thickness) and the operating status (operational or not operational) and, in multi-
conductor networks, the pipe type (supply or return). One or more sisNET objects are to 
be assigned to the pipe object. For each one of the sisNET objects, the sisNET attributes 
that are to match the relevant sisNET HR Module attributes need to be selected. Other 
attributes (e.g. resistance factors, heat transfer coefficients, wall thicknesses, laying 
procedure, etc.) can be added. sisNET HR Module also generates attributes that are used 
to identify the data records:

• Pipe name: unique text identifier for the pipe; in multi-conductor systems, supply 
pipes are given a final letter ‘V’, and return pipes an ‘R’.

• Pipe number: unique numeric identifier for the pipe

• Start number, End number: unique numeric identifier for the pipe’s start and 
end nodes

• Pipe class number: unique numeric identifier for the pipe’s pipe class (providing the 
sisNET HR Module is to create pipe classes)

Example of a district 
heating pipe:
 with route in 

a sisNET system
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Connecting line (for common route and pipe data only)

For data inventories using connecting systems, the connecting lines are distinguished 
from the supply pipes. The pipe object type is then only given the supply pipe objects, 
while the connecting line object type is given the connecting lines to the service 
connections. The minimum attributes are identical to the pipe object type.

Inflection points

If, in sisNET, a pipeline does not run straight between the start and end point, the sisNET 
HR Module can write the intermediary inflection points to the calculation network 
model, which means that a network calculation with a separate graphic display can be 
mapped to the network in a way that is more true to the original. The sisNET HR Module 
generates the following attributes:

• Pipe number: numeric identifier for the pipe to which the inflection point belongs

• Inflection no.: serial number of the inflection point, calculated from the start to the 
end point of the pipe

• X, Y coordinates: derived from the graphic position of the inflections in sisNET

Consumer

One or more sisNET objects are to be assigned to this sisNET HR Module object type. The 
minimum attribute is the consumption data, which is to be taken from a relevant sisNET 
attribute. Other useful attributes might, for example, be:

• Other consumption values (e.g. volumes)

• Associations with consumer groups (sector, consumer type)

• Return temperature

• Address (street, house number, postcode)

The sisNET HR Module generates the following attributes:

• Consumer name: unique text identifier for the consumer

• Consumer number: unique numeric identifier for the consumer

• Node number: Numeric identifier for the calculation network node in the supply 
to which the consumer is connected

• Start number, End number: Unique numeric identifier for the consumer’s start 
and end nodes

Supplier

In the sisNET HR Modules minimal functionality, this object is only used to prevent 
network points with this object having to submit to any reduction procedure. For this 
reason, too, there is no minimum attribute. The values characterising the generator’s 
operation, such as current feed-in capacities and supply temperatures, are usually only 
entered into the network calculation and calculated when a calculation run is being 
configured. Other useful attributes may be, e.g.:

• Maximum feed-in capacity

• Maximum feed-in temperature
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The sisNET HR Module generates the following attributes:

• Supplier name: unique text identifier for the supplier

• Supplier number: unique numeric identifier for the supplier

• Node number: Numeric identifier for the calculation network node in the supply 
to which the consumer is connected

• Start number, End number: Unique numeric identifier for the supplier’s start and 
end nodes

Pump

This object type is optional. One or more sisNET objects can be assigned to this sisNET HR 
Module object type. The minimum attribute is the name, which is to be taken from 
a relevant sisNET attribute. Other useful attributes might, for example, be:

• Engine power

• Construction type

• Factory no., manufacturer, etc.

The sisNET HR Module generates the following attributes:

• Pump name: unique text identifier for the pump

• Pump number unique numeric identifier for the consumer

• Start number, End number: Unique numeric identifier for the pump’s start and 
end nodes

Stop point

This object type is optional, i.e. one or more sisNET objects can be assigned to this sisNET 
HR Module object type, but the generating of the calculation network also runs when no 
stop point object types are assigned.

Because a stop point in the middle of a pipeline object requires a division of this pipeline 
(=> 1 additional pipe object and 2 additional node objects) and additionally for each stop 
point in a network calculation operation specifications are required, this object type 
should only include control stop points and important shut-off fittings. To do this, 
a restricting condition, e.g. only stop points with the construction type valve or cover, 
can be entered in the Condition input field for the assigned sisNET object type. Any other 
stop point types can be assigned to the disconnecting point object type.

The minimum attribute is the stop point name, which is to be taken from a relevant 
sisNET attribute. Other useful attributes might, for example, be:

• Stop point type (construction type)

• Stop point function (lockable, controllable, etc.)

• KVS value

• Operational status (OPEN/CLOSED)

The sisNET HR Module generates the following attributes:

• Stop point name: unique text identifier for the stop point

• Stop point number: unique numeric identifier for the consumer

• Start number, End number: Unique numeric identifier for the stop point’s start 
and end nodes
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Disconnecting point

This object type enables stop points with a purely locking function to be taken over for 
particular operating situations as an additional attribute for the pipeline on which the 
disconnecting point lies. This enables the number of stop points to be generated for the 
calculation network and, thus, the operational specifications required a later hydraulic 
calculation, to be reduced. Also, sometimes, a pipeline does not need to be divided 
because of a stop point that lies in the middle of the pipe, so that, instead of 3 network 
elements (2 pipelines and 1 stop point), only one pipeline is generated. For this object 
type there are no attributes.

Pipe classes

Pipe classes are used in network calculation programs in order to be able to assign 
the same types of property to groups of pipelines. The main attribute here is the pipe’s 
internal diameter. The user can configure other attributes (e.g. resistance factors, heat 
transfer coefficients, etc.). For each combination of attribute values to be found in sisNET, 
the sisNET HR Module can create a pipe class and assign it to the pipes concerned.

Consumer groups

Consumer groups are sometimes used in network calculation programs to be able to 
assign the same types of load profiles to groups of consumers. To classify the consumers 
into consumer groups, for each sisNET object type assigned to the consumer type there 
needs to be at least one attribute suitable for categorising the consumers. For each 
combination of attribute values to be found in sisNET, the sisNET HR Module generates 
a consumer group and assigns it to the consumers concerned.

Organisation groups

Organisation groups are sometimes used in network calculation programs as an 
additional organisation unit to be able to assign the same types of load profiles to groups 
of consumers. To classify the consumers into organisation groups, for each sisNET object 
type assigned to the consumer type there needs to be at least one attribute suitable for 
categorising the consumers. For each combination of attribute values to be found in 
sisNET, the sisNET HR Module generates an organisation group and assigns it to the 
consumers concerned.

Pump groups

Pump groups are used in some network calculation programs (e.g. in sisHYD) in order to 
be able to assign the same types of property to groups of pumps. The user can configure 
available attributes such as manufacturer, construction type, engine power for the 
generation of pump groups. For each combination of attribute values to be found in sisNET, 
the sisNET HR Module can create a pump group and assign it to the associated pumps.

Stop point groups

Stop point groups are used in some network calculation programs (e.g. in sisHYD) in 
order to be able to assign the same types of property to groups of stop points. The user 
can configure available attributes such as construction type, KVS value, nominal width 
for the generation of stop point groups. For each combination of attribute values to be 
found in sisNET, the sisNET HR Module can create a stop point group and assign it to the 
associated stop points.
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Output file
The sisNET HR Module output file is an ASCII file in which the data records are separated 
from one another by an empty line. Each record begins with a header row which specifies 
the type of record (pipe, node, etc.). The individual attributes of the records are each in 
a separate row that begins with a keyword that identifies the attribute. The user can 
configure the keywords for both the object types and the attributes. An extract from 
a calculation network model file generated by sisNET HR Module is displayed below.

NODE
NODE_IDK_0011499V
NODE_NO22998
MSLINK22998
X_COORD        3476701.2147
Y_COORD        5757777.6897
Z_COORD              0.0000

PIPE
ELEM_IDK0022991-K0022999R
MSLINK2
ELEM_NO2
START_NO22991
END_NO22999
PIPECLASSES_NO1
LENGTH             94.1600
NOMINALDIAMETER            150.0000

CONSUM_DATA
CONSUMER_IDK_0022994
CONSUMER_NO11687
START_KNR122994
NOMINALOUTPUT0.0

INFLEXION POINTS
ELEM_NO2
INFLECTION_NO1
X_COORD        3476726.7353
Y_COORD        5757709.3040

PIPE CLASSES
PIPECLASSES_IDN_2
PIPECLASSES_NO2
NOMINALDIAMETER25

Generating the calculation network model
The sisNET HR Module automatically generates the calculation network model after 
the user has configured the system and, by possibly isolating any necessary pipelines, 
delimited the area to be converted (see “Using the sisNET HR module” on page 205). To 
start the conversion, the user graphically selects a node inside the area to be converted. 
The sisNET HR Module now uses a topology tracing method to determine the data to be 
converted and its links. In multi-conductor systems, the calculation network is mapped 
using the trace lines; in one-conductor systems the pipelines are used straightaway.

1. Generate list of all traces starting from the current node

2. Is there any trace remaining in the trace list which has not been marked? If No, end 
the sub-program, if Yes, this becomes the current trace

3. If trace contains branches, divide trace into relevant trace sections, create list of 
trace sections

4. Is there any trace section remaining in the trace section list which has not been 
marked? If No, go to 2., if Yes, this becomes the current trace
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5. Mark trace, trace’s end node becomes current node

6. Open 1. as sub-program

7. Go to 4.

After the calculation network framework has been created in this way, the supply 
and return pipes that have a relation to the trace lines and their length and diameter 
attributes are extracted. The connected consumers with consumption values and the 
suppliers are also determined.

This raw data model which has been created in this way now contains all the data 
required for any subsequent network compression (compression procedure described 
in Simplifying calculation network models (Page 221)).

When any network simplification has been done, the definitive calculation network 
model can now be generated. The first part of this process involves extracting the 
additional attributes of the objects that the user has configured from sisNET.

The sisNET HR Module can then generate the pipe classes, consumer groups, pump groups 
and/or stop point groups as required. The user can define a catalogue of pipe, consumer, 
stop point and pump attributes. Based on this catalogue, the sisNET HR Module generates, 
for each combination of attributes, a pipe class, consumer group, stop pipe group and 
pump group, and assigns these to the relevant pipes, consumers, pumps or stop points.

The calculation network model is then exported as an ASCII file.

Using the sisNET HR module
The sisNET HR Module’s main dialog controls all the activities, from configuring the 
hydraulic calculation network model through the extracting of the model from the sisNET 
data to backing up the data. All the functions needed to generate the calculation model 
can be accessed via the menu bar and the button bar.

Button bar
The button bar has 7 icon buttons for the functions that are frequently required to 
generate a hydraulic calculation model.

These include, for example, triggering the generation and triggering the outputting of the 
network model to a text file. The icon buttons also provide functions for delimiting the 
network area permitted for the model generation. Pipe sections (for separate trace and 
pipeline data) and pipeline sections can be blocked for the model generation and then 
approved again, and the pipe sections that are currently excluded can be displayed.

Task: Icon button to select:

Start calculating the topology “Generate” on page 206

Export the hydraulic analysis that has been generated “Export” on page 208
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Generate

Selecting this icon button opens the dialog with which you start generating the 
calculation network model from the sisNET data.

In this dialog you select the generation mode for the model generation that is to be 
started. The pipe objects for the model to be generated can either be identified using the 
selection table of the current sisNET user, using a list of pool indices, or using a topology 
search from a start node. For GIS models with connecting pipes, there is also the option 
to exclude the connecting pipes when the network model is generated. In these cases, 

Delete the pipelines blocked for the network topology 
search

“Delete” on page 209

Display all the pipelines blocked for the network 
topology search

“Display” on page 209

Hide the display of all the pipelines blocked for the 
network topology search

“Hide” on page 209

Add a new pipe to the list of pipelines blocked for the 
network topology search

“Add” on page 210

Remove a new pipe from the list of pipelines blocked 
for the network topology search

“Remove” on page 210

Task: Icon button to select:
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the consumers on the connecting pipes are assigned via the connecting point to either 
the start or end of the supply lines to which the connecting system branches. For the 
STANET export format, there is also the option to suppress the separating of pipes by 
acceptors on the pipe.

Generation mode via the selection table:

The sisNET Selection module can be used to insert into the selection table all the pipe 
objects from any fence which are required to generate a model. The calculation model 
is generated for all the pipe objects included in the current selection table and calculates 
the network model from these pipes with connected stop point/pump/supplier/acceptor 
objects. 

✍ In the case of a model with separate trace and pipe data, the trace objects need to be 
written to the selection table using a selection.

Generation mode by selecting a start pipe:

With this type of generation, the user has to select a start pipe for the model generation. 
If the network object type has been configured, the networks to be included can also be 
restricted for the subsequent generation of a network model.

In selecting the start pipe, AccuSnap only offers the user suitable sisNET objects. When 
a pipe has been selected, the user must confirm with the left mouse button (Generating 
the calculation network model (Page 204)). 

During the 1st generation phase (the topology search), the user has the option of 
cancelling the generation by pressing the Reset button (usually the right mouse button). 
If the Reset button is pressed, the user is asked whether they really wish to cancel the 
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generation. If they select the No button, the generation proceeds, whereas if they select 
the Yes button, the network generation is aborted at the pipe currently being examined 
and the network model generated prior to the abort appears in the network display.

Generation mode via the list of pool indices:

To generate a partial model from individual sisNET inventory files, the via a list of pool 
indices generation mode can be used. The user can enter a comma-delimited list of pool 
indices in the List of pool indices input field. The network model is then generated from 
all the pipes whose graphic is in the required inventory files.

Export

Opens a box to select files for exporting the data generated for the hydraulic calculation 
network model in the ASCII format. A default setting gives the text files the filename 
ending *.ASC. However, the user can set any other name ending.
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To save the text file, switch to the required directory, enter a file name and select OK. 
If a file of the same name already exists, a dialog will ask whether the existing one should 
be overwritten or if the process should be cancelled.

Delete

Selecting this icon button deletes the list of pipes excluded for the model generation.

Display

Selecting this icon button highlights, in the graphic, all the pipes that are excluded for the 
model generation.

Hide

Selecting this icon button returns all the excluded pipes which are highighted in the 
graphic to their normal display.
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Add

Excludes one or more pipeline sections or pipe sections for the model generation. When 
the Add button has been selected, pressing the left mouse button selects the pipe to be 
excluded; after the selected pipe has been highlighted, pressing the left mouse button 
again confirms the choice of pipe, while pressing the right mouse button rejects it.

Remove

Removes one or more pipe sections or pipeline sections from the list of excluded pipes. 
When the Remove button has been selected, pressing the left mouse button selects the 
pipe to be re-released; after the selected pipe has been highlighted, pressing the left 
mouse button again confirms the choice of pipe, while pressing the right mouse button 
rejects it.

The “File” menu
The “File” menu contains functions for the full range of input and output functions for 
the sisNET HR Module.

Load
Reads in an existing, generated network model (with no network reductions) and displays 
the network elements based on the symbol colours set in the current views. With this 
function, after a network reduction, the original network can be restored or, after 
rebooting the sisNET HR Module without identifying the topology, a network model 
that has been generated can be loaded.

✍ This enables multiple network reduction strategies to be tested without repeatedly, 
laboriously identifying the network topology from the sisNET data.

Export
Starts outputting the generated network model to a text file (Export (Page 208)).

Close
Exits the application module sisNET HR Module and saves the setting changes.

Task: Select from the “File” menu:

Load and draw a network model that has been 
generated

“Load” on page 210

Export the current model network “Export” on page 210

Exit the sisNET HR Module “Close” on page 210
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The “Configuration” menu
The “Configuration” menu is used to enter all the configuration data for generating and 
outputting a network model.

Data model
Opens the dialog Configure application module (Page 181). This is used to configure 
the object types in the hydraulic calculation network model by assigning them to sisNET 
object types and their attributes.

Model network
Opens the “Data model” dialog. This dialog is used to configure the network model for 
the current category.

Common route and pipeline data
Check the selection field if you wish to generate a hydraulic calculation network model 
for one-conductor systems (Data structures in sisNET (Page 196)).

✍ Any change made to this setting will require the entire sisNET HR Module to be reconfigured.

Task: Select from the “Configuration” menu:

Assign the sisNET object types and sisNET attributes 
to the object types for the hydraulic model network

“Data model” on page 211

Enter/change the setting for the model network to be 
generated, such as network type, attribute value for 
network position, etc.

“Model network” on page 211

Select attributes for generating the pipe classes “Type classes > Pipe classes” on page 213

Select attributes for generating the consumer groups “Type classes > Consumer groups” on page 214

Select attributes for generating the pump types “Type classes > Pump types” on page 214

Select attributes for generating the stop point types “Type classes > Stop point types” on page 214

Select attributes for generating the organisation groups “Type classes > Org groups” on page 214

Assign keywords for exporting the generated model 
network

“Keywords” on page 215
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Number of pipes
For network data in which the trace and pipeline data is maintained together in one 
sisNET object, you can specify the number of pipes to be generated from one pipe object.

✍ If this setting is changed and the number of pipes to be generated is increased, the 
parameters will need to be reconfigured.

Export format
Allows the user to select the network calculation program for which the network model 
is to be exported. Different options may be selected, depending on the category:

Hydraulic pipe assignment
Opens, in turn, the dialog “Value representing supply pipe” and “Value representing 
return pipe” for querying the attribute values for assigning the pipeline sections to the 
supply or return pipe (“Value representing supply/return pipe” dialog (Page 212)).

Operating status
Opens the “Non-operational status for pipe” dialog for assigning an attribute value for 
flagging a pipe for the “Non-operational” operating status (“Non-operational status” 
dialog (Page 213)).

“Value representing supply/return pipe” dialog
This dialog is used to specify the attribute values for assigning a pipe to the supply or 
return pipe.

The user can select the entry they want from the displayed list of network positions 
found, and select OK to confirm.

Category Export formats

District heating sisHYD

Gas sisHYD, Stanet, Optiplan

Water sisHYD, WaterCAD, Stanet, REHMCROSS
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“Non-operational status” dialog
This dialog is used to query, for the Status attribute, the attribute value for flagging 
a pipe for the “Non-operational” operating status.

A pipe with this attribute value is not copied to the hydraulic network model.

✍ If the Cancel button is used to exit this dialog, all the pipes will be copied to the hydraulic 
network model, whatever their operational status.

Type classes > Pipe classes
Opens the “Pipe Class Configuration” dialog mask. Here you specify the attributes whose 
unique combination defines the relevant pipe classes (e.g. generate a pipe class for each 
combination of internal diameter, installation type and installation system that occurs in 
the network generated).
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The list of pipeline attributes comprises all the potential, pipe class-relevant attributes 
that have not yet been used to for pipe class generation.

The list of pipeline attributes lists all the pipeline attributes currently selected for pipe 
class generation. The buttons “->” and “<-” can be used to swap pipeline attributes 
between the two lists in order to change the pipe class generation.

OK

Applies the pipeline attributes selected for pipe class generation, and closes the 
dialog mask.

Cancel

Closes the dialog mask without saving the entries.

Type classes > Consumer groups
Opens the “Consumer Group Configuration” dialog mask. Here you specify the attributes 
whose unique combination defines the relevant consumer group (e.g. generate a 
consumer group for each different consumer type that occurs in the network generated).

The consumer attributes that can be used to generate consumer groups are selected in 
the same way as the pipe class attributes (See “Type classes > Pipe classes” Page 213).

Type classes > Pump types
Opens the “Pump Type Configuration” dialog mask. Here you specify the attributes whose 
unique combination defines the relevant pump type (e.g. generate a pump type for each 
combination of engine power and manufacturer that occurs in the network generated).

The pump attributes that can be used to generate pump types are selected in the same 
way as the pipe class attributes (See “Type classes > Pipe classes” Page 213).

Type classes > Stop point types
Opens the “Stop Point Type Configuration” dialog mask. Here you specify the attributes 
whose unique combination defines the relevant stop point type (e.g. generate a stop 
point type for each combination of nominal flow and manufacturer that occurs in the 
network generated).

The stop point attributes that can be used to generate stop point types are selected in 
the same way as the pipe class attributes (See “Type classes > Pipe classes” Page 213).

Type classes > Org groups
Opens the “Organization Group Configuration” dialog mask. Here you specify 
the attributes whose unique combination defines the relevant organisation group 
(e.g. generate an organisation group for each different year of manufacture that 
occurs in the network generated).

The organisation group attributes that can be used to generate organisation groups are 
selected in the same way as the pipe class attributes (See “Type classes > Pipe classes” 
Page 213).
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Keywords
Opens the “Keyword Configuration” dialog. Here, for every object and every attribute, 
you specify a keyword that inserts the relevant value into the export file generated.

The “Settings” menu
The “Configuration” menu is used to enter all the configuration data for generating and 
outputting a network model.

Display
Opens the “Network display settings” dialog. You can use this to specify the colours for 
displaying the generated calculation network model.

Task: Select from the “Settings” menu:

Enter/change the setting for the model network to be 
generated, such as network type, attribute value for 
network position, etc.

“Display” on page 215

Select attributes for generating the pipe classes “Export” on page 216
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Display inflection points

If this button is selected, the pipeline’s inflection points will display when the calculation 
network model is displayed, otherwise they are not displayed.

Node color

Specifies the fill colour of the calculation network’s nodes.

Pipe colour

Specifies the fill colour of pipes that are used for the hydraulic calculation network model.

Consumer

Specifies the colour which identifies the consumers that are put into the hydraulic 
calculation network model.

Supplier colour

Specifies the fill colour of suppliers that are used for the hydraulic calculation network model.

Stop point colour

Specifies the fill colour of stop points that are used for the hydraulic calculation 
network model.

Pump colour

Specifies the fill colour of pumps that are used for the hydraulic calculation network model.

✍ The entries in the sisNET colour palette are available as colours. The colour palette opens 
as soon as the user clicks the coloured in field or, if the focus is on the input field, presses 
the space bar. 

OK

Selecting the OK button closes the dialog mask and the settings are applied to the fill colour.

Cancel

Closes the dialog mask without saving the entries.

Export
Opens the “Export Settings” dialog. You can use this dialog to change the settings for the 
next network model export.
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Generate inflection points

When this box is checked, when the hydraulic network model is calculated, inflection 
points are generated for each pipeline with more than 2 graphic points for graphic points 
without an associaed node, to display the precise path of the pipeline.

✍ Generating inflection point information is only useful if your network calculation 
program, or the program to be used to post-process the data, is capable of re-assigning 
the inflection points to the pipes.

Generate pipe classes

When this box is checked, pipe classes are generated for the generated pipelines in line 
with the pipeline attributes configured in the “Pipe Class Configuration” dialog (See “Type 
classes > Pipe classes” Page 213).

Generate consumer groups

When this box is checked, consumer groups are generated for the generated consumers 
in line with the consumer attributes configured in the “Consumer Group Configuration” 
dialog (See “Type classes > Pipe classes” Page 213).

Generate pump types

When this box is checked, pump types are generated for the generated pumps in line 
with the pump attributes configured in the “Configure Pump Type” dialog (See “Type 
classes > Pump types” Page 214).

Generate stop point types

When this box is checked, stop point types are generated for the generated stop points 
in line with the stop point attributes configured in the “Stop Point Type Configuration” 
dialog (See “Type classes > Stop point types” Page 214).

Generate organisation groups

When this box is checked, organisation groups are generated for the generated 
consumers in line with the consumer attributes configured in the “Organisation Group 
Configuration” dialog (See “Type classes > Org groups” Page 214).

OK

Adopts the setting for the export and closes the dialog mask.

Cancel

Closes the dialog mask without saving the entries.

The “Reduction” menu
The “Reduction” menu holds the functions for reducing the generated network model.

Task: Select from the “Reduction” menu:

Configure and manage different reduction methods “Strategies” on page 218

Reduce network model “Reduce” on page 221
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Strategies
Opens the “Strategy List” dialog. This dialog can be used to manage different network 
reduction strategies and configure a current sequence of different reduction methods 
for compressing the calculation model network.

Insert

The Insert button is used to insert a new reduction strategy in front of the entry currently 
selected. The “Edit strategy” dialog (Page 219) opens for entering the reduction strategy 
you wish to insert.

Add

The Add button is used to add a new reduction strategy after the entry currently 
selected. The “Edit strategy” dialog (Page 219) opens for entering the reduction strategy 
you wish to add.

Delete

The Delete button deletes the reduction strategy which is currently selected from the list 
of reduction strategies.

Edit

The Edit button is used to edit the reduction strategy which is currently selected. The 
“Edit strategy” dialog (Page 219) opens for editing the strategy.

OK

When this button is selected, the changes made in the dialog are applied and the dialog 
mask closes.

Cancel

When this button is selected, the changes made in the dialog are discarded and the 
dialog mask closes.
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“Edit strategy” dialog
The “Edit strategy” dialog enables the user to configure a network reduction strategy. 
Depending on the reduction method selected (there are currently 3 methods), different 
setting options display for the current strategy.

Description

Describes the strategy.

Reduction method

This selection menu enables the user to specify the reduction method they want for the 
current strategy.

Depending on the reduction method selected, the other input fields for the current 
strategy differ:

“Remove terminal pipes” reduction method

With this method, the last pipes to the consumers are removed and the entry node to the 
terminal pipe is activated for the consumer.

The following entry fields specify under which conditions terminal pipes may be removed:

Length

Check the box if the terminal pipe is to be reduced if the length falls short of a length that 
you specify.

✍ If the box is not checked, the reduction is done whatever the length of the pipeline.

Diameter

Check the box if the terminal pipe is to be reduced if the diameter is less than you specify.

✍ If the box is not checked, the reduction is done whatever the diameter of the pipeline.
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Consumption

Check the box if the terminal pipe is to be reduced if the minimum consumption is less 
than you specify.

✍ If the box is not checked, the reduction is done whatever the consumption connected.

Recursive

Check the box if the reduction of terminal pipes is to be done recursively.

✍ If the box is not checked, with each reduction step, just one terminal pipe in a run, which 
meets the criterion, is removed.

“Group T-joints” reduction method

With this reduction method, T-joint nodes which are adjacent can be combined into 
a single calculation node (See “Merge crossing points” Page 223).

Length

Check the box if the T-joint nodes are to be grouped if the length falls short of a length 
that you specify.

Diameter

Check the box if the T-joint nodes are only to be grouped if the diameter of the main pipe 
on which the T-joint nodes lie is less than you specify.

“Merge pipes” strategy

With this reduction method, pipelines lying one behind the other that have the same 
pipe class data (diameter, wall thickness, etc.) and between which there is no T-joint or 
any pump, stop point, consumer or supplier, can be merged into one common pipeline.
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Length

Check the box if two pipes with the same pipe class data are only to be merged if the 
length falls short of a length that you specify, and enter the maximum length for the 
removal of intermediary nodes.

Tolerances

This button is currently still inactive.

OK

Applies the settings in the strategy and closes the dialog mask.

Cancel

Discards the settings and changes and closes the dialog mask.

Reduce
The last network model generated is reduced in line with the strategy list that has been 
configured, and displayed in the current views. If a model has yet to be loaded, the last 
model generated is loaded (See “Load” Page 210).

The reduction in network elements and nodes that has been achieved in the relevant 
reduction steps is output in the message window.

Simplifying calculation network models
The calculation network models extracted from a GIS system usually have a degree of 
detail which is undesirably great for doing network calculations. So sisNET HR Module’s 
ability to automatically run different, parametrisable, network simplification methods is of 
great benefit to the user. Each of these methods is described in the sections that follow.
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Merge hydraulically identical pipe sections
In GIS systems, in contrast to network calculation programs, pipes are often divided into 
individual sections without changing any hydraulically related parameters (e.g. changing 
the material, manufacturer, year of manufacture, etc.). The sisNET HR Module is able to 
merge such pipe sections into a single pipe.

This sisNET HR Module method can be parametrised:

• Only pipes shorter than a prescribed length are merged.

• Pipe sections whereby “just a little” differs are merged. Tolerance values can be 
defined for any relevant attributes as percentage changes from one pipe section 
to the next. If these tolerances are not reached for all the attributes, the pipes 
concerned can be merged. The attributes of the pipe section that was originally 
longer are used as the attributes for the newly merged pipe.

✍ If the pipe sections are merged with no tolerances, this method does not affect the 
precision of the calculation results, despite its data reduction, so all users should 
generally use it.

Remove terminal pipes
Terminal pipes (e.g. stub lines to service connections) do not usually have a major impact 
on a hydraulic network calculation. So they, too, lend themselves to a network reduction 
with no negative consequences.

The sisNET HR Module places consumers who are supplied by the removed terminal 
pipes on the start nodes of the removed pipes.

Section 1 Section 2

New pipe

Pipe sections before 
and after merging

Before

After

Example of a recursive 
removal of terminal 

pipes

Before

After

Based on:
Recursion
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The method can also be applied recursively so that pipes can be removed which 
themselves become terminal pipes when terminal pipes are removed.

The method for removing terminal pipes can be parametrised in sisNET HR Module:

• Only terminal pipes with a length smaller than a prescribable threshold value are 
removed

• Only terminal pipes with a diameter smaller than a prescribable threshold value 
are removed

• The only terminal pipes removed are those used to supply a consumer with 
a consumption smaller than a prescribable threshold value.

Merge crossing points
Since almost all service connections are managed in GIS systems, it is relatively often 
the case that multiple stub pipes come off a main pipe within a relatively short distance. 
sisNET HR Module is able to merge such densely positioned branches.

The position of the merged branch is the position of the branch with the greater 
connected consumption.

This sisNET HR Module simplification method, too, can be parametrised:

• Only branches with a distance below a prescribable threshold value are merged

• Only branches between which there is a pipe with a diameter smaller than 
a prescribable threshold value are merged

Merge “connection systems”
Specifically in sisNET, the option is available to assign network parts of any size to 
a “connection system”. The sisNET HR Module can combine this connection system 
completely into one consumer. All the consumers in this connection system that are 
maintained in the GIS are added to it.

Example of merging 
branches 

Before

After
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13 Generating electrical calculation network 
models
Description of function
The network calculation models used when planning power distribution networks 
require time-consuming, error-prone preparatory work to obtain data, particularly 
in large networks. As a result of the large data volumes and ever-changing customer 
structure, maintaining the data required for the network calculation is also associated 
with substantial costs.

At the same time sisNET is deployed as a GIS system for documenting and managing 
the lines networks in the supply industry. sisNET is used to manage and maintain all 
the graphic information and object data from the company’s networks in a central, 
integrated system.

For companies simultaneously using sisNET and network calculation programs, the 
generation of electrical calculation network models, referred to in the following as 
sisNET SR Module, provides an opportunity to connect these data-heavy systems to 
avoid keeping redundant data. The sisNET SR Module uses the GS data maintained in 
sisNET to generate input data for electrical network calculation programs.

Requirements of the data structures in the GIS data 
For it to be able to perform its tasks, the sisNET SR Module can be configured for a range 
of data structures both on the sisNET side and (to a limited degree) on the network 
calculation side. We shall now describe what the sisNET SR Module requires of the 
data structures in the sisNET data and how the sisNET SR Module handles them.

Data structures in sisNET

The data structures in sisNET are not usually specified in advance but can, to a very large 
extent, be configured by and for the end users, depending on their needs. 

The topology of an electricity network is described by one or more cable object types, 
bus bar object types and transformer object types, in which the electrical attributes, such 
as length, nominal voltage, resistances, etc., are also maintained.

• There needs to be a node at least at the beginning and end of the cable, bus bar and 
transformer objects. The node must have relations to the topology objects beginning 
and ending at the node, so that the network structure can be calculated using the 
relations between cables, bus bars, and transformers.

• In the case of data inventories in large companies, there is also a relation of pipeline 
objects to an object of the network type. This assignment can be used to restict the 
model generation to one or more networks.
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Other object types for generating a calculation model are consumers and the switch 
object types load switch, protection switch, isolating switch and switch connector. The 
consumer objects must have a relation to a node which, in turn, must have a relation to 
a topology object.

The switch objects must also have a relation to a node in a topology object; a relation to 
the cable/transformer object which is switched/protected by the switch is also required.

Object types in the sisNET SR module
Due to the minimum technical data requirements of network calculation programs, the 
sisNET SR Module has 10 object types, in all:

• Network,

• Node,

• Cable,

• Bus bar,

• Transformer,

• Consumer,

• Load switch,

• Isolating switch,

• Protection switch,

• Load isolating switch,

• Cable types.

Output file
The sisNET SR Module’s output depends on the export format selected. The ASCII file 
generated for the DigSilent calculation program looks like this:

$$General;No(i);Descr(a:40);Val(a:40)
1;Version;4.0
2:Source;sisNET

$$ElmCoup;No(i);Name(a:40);Table_Cub1(a:15);Cub1(i);Table_Cub2(a:15);Cub2(i);aUsage(a:4);chr_name(a:20)
**********************************************************************
* No,Name: Number and Name of Element
* Station_I; Cub_I: Connection
* aUsage: Switch Type, cbk=Circuit-Breaker, dct=Disconnector, sdc=Load-Break-Disconnector,swt=Load-Switch
**********************************************************************
100000003;P035DBF3;Cubicles;100000002;Cubicles;100000049;swt;3529715
100000008;P035DBF5;Cubicles;100000007;Cubicles;100000050;swt;3529717
100000010;P035DD51;Cubicles;100000009;Cubicles;100000051;swt;3530065
100000012;P035DD4E;Cubicles;100000011;Cubicles;100000052;swt;3530062
100000016;P035DBF4;Cubicles;100000015;Cubicles;100000053;swt;3529716
100000018;P035DBBE;Cubicles;100000017;Cubicles;100000119;swt;3529662

$$ElmTerm;No(i);Name(a:40);iUsage(i);uknom(r);chr_name(a:20)
**********************************************************************
* No,Name: Number and Name of Element
* iUsage: Usage: Busbar=0,Junction Node=1, Internal Node=2
* uknom: Nominal Voltage: Line-Line in kV
* char_name: Characteristic name
**********************************************************************
100000023;G035E415;0;0.999;3531797
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100000102;K0342204;2;1;3416580
100000076;K034253B;2;1;3417403
100000070;K0342898;2;1;3418264
100000040;K0343146;2;1;3420486
100000060;K0343196;2;1;3420566
100000072;K03433C6;2;1;3421126
100000043;K0343C6F;2;1;3423343
100000063;K0343D4A;2;1;3423562

$$ElmLne;No(i);Name(a:40);Table_typ_id(a:15);typ_id(i);Table_Cub1(a:15);Cub1(i);Table_Cub2(a:15);Cub2(i);dline(r);
chr_name(a:20)
**********************************************************************
* No,Name: Number and Name of Element
* typ_id: Type of Element
* Station_I; Cub_I: Connection
* dline: Parameters: Length of Line in km
* char_name: Characteristic Name
**********************************************************************
100000006;R03402B1-0345021;TypLne;1;Cubicles;100000049;Cubicles;100000005;0.026260;3444158
100000025;R0345021-03448CE;TypLne;1;Cubicles;100000005;Cubicles;100000024;0.023780;3444159
100000027;R0346313-0345021;TypLne;2;Cubicles;100000026;Cubicles;100000005;0.019490;3445472

$$TypLne;No(i);Name(a:40);uline(r);sline(r);aohl_(a:3);rline(r);xline(r);cline(r);rline0(r);xline0(r);cline0(r);rtemp(r);lthr
(r)
**********************************************************************
* No,Name: Number and Name of Element
* uline: Rated Voltage in kV
* sline: Rated Current in kA
* aohl: Cable / OHL
* rline: Parameters per Length 1,2-Sequence: Resistance R' in Ohm/km
* xline: Parameters per Length 1,2-Sequence: Reactance X' in Ohm/km
* cline: Parameters per Length 1,2-Sequence: Capacitance C' in µF/km
* rline0: Parameters per Length Zero Sequence: Resistance R0' in Ohm/km
* xline0: Parameters per Length Zero Sequence: Reactance X0' in Ohm/km
* cline0: Parameters per Length Zero Sequence: Capacitance C0' in µF/km
* rtemp: Max. End Temperature in degC
* lthr: Rated Short-Time (1s) Current (Conductor) in kA
* char_name: Characteristic Name
**********************************************************************
3;C_3;1;;ohl;;;;;;;;
2;C_2;1;;ohl;;;;;;;;
1;C_1;1;;ohl;;;;;;;;

$$ElmLod;No(i);Name(a:40);Table_Cub1(a:15);Cub1(i);chr_name(a:20)
**********************************************************************
* No,Name: Number and Name of Element
* Station_I; Cub_I: Connection
* char_name: Characteristic name
**********************************************************************

$$ElmTr2;No(i);Name(a:40);Table_Cub1(a:15);Cub1(i);Table_Cub2(a:15);Cub2(i);chr_name(a:20)
**********************************************************************
* No,Name: Number and Name of Element
* Station_I; Cub_I: Connection
* char_name: Characteristic name
**********************************************************************
100000118;R035C28C-035BAAA;Cubicles;100000119;Cubicles;100000117;3528097

$$Cubicles;No(i);Name(a:40);Table_Station(a:15);Station(i);chr_name(a:20)
**********************************************************************
* No,Name: Number and Name of Element
* Station: Name of Terminal
* char_name: Characteristic Name
**********************************************************************
100000102;K0342204;ElmTerm;100000102;3416580
100000076;K034253B;ElmTerm;100000076;3417403
100000070;K0342898;ElmTerm;100000070;3418264
100000040;K0343146;ElmTerm;100000040;3420486
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Generating the calculation network model
The sisNET SR Module automatically generates the calculation network model after the 
user has configured the system (see “Using the sisNET SR module” on page 228). To start 
the conversion, the user either graphically selects a start cable inside the area to be 
converted, or uses a fence to generate a sisNET selection of all the topology objects 
located in the required area. The sisNET SR Module generates an electrical network 
model based on the start cable selected or on the content in the selection.

When the calculation model generated is exported in the export format selected, the 
cable types for the cable/aerial line segments are generated and, when the export is 
ended, saved in a separate file for changing the name / adding missing attribute values.

Using the sisNET SR module
The sisNET SR Module’s main dialog controls all the activities, from configuring the 
electrical calculation network model through the extracting of the model from the sisNET 
data to backing up the data. All the functions needed to generate the calculation model 
can be accessed via the menu bar and the button bar.

Button bar
The button bar has 2 icon buttons for the functions that are frequently required to 
generate an electrical calculation model.

These include triggering the generation and triggering the outputting of the network 
model to a text file.

Task: Icon button to activate:

Starting the topology investigation “Generating” on page 229

Exporting the generated electrical analysis “Exporting” on page 230
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Button bar
Generating

Selecting this icon button opens the dialog with which you start generating the 
calculation network model from the sisNET data.

In this dialog you select the generation mode for the model generation that is to be 
started. The topology objects for the model to be generated can either be identified 
using the selection table of the current sisNET user, or using a topology search from 
a start cable. 

Generation mode via the selection table:

The sisNET selection module can be used to insert all the topology objects (cables, 
transformers and bus bars) into the selection table from any fence which are selected 
to generate a model. The calculation model is generated for all the topology objects 
included in the current selection table and calculates the network model from these 
objects with connected switch/acceptor objects.

Generation mode by selecting a start cable:

With this type of generation, the user must select a start cable for the model generation. 
If the network object type has been configured, the networks to be included can also be 
restricted for the subsequent generation of a network model.

To select the start cable, the user must only select the start line desired with the left 
mouse button (Generating the calculation network model (Page 228)). 
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While the electrical network model is being generated, the user has the option of 
cancelling the generation by pressing the Reset button (usually the right mouse button). 
If the Reset button is pressed, the user is asked whether they really wish to cancel the 
generation. If they select the No button, the generation resumes, otherwise the model 
generation is aborted after the current generation step so that there is only an 
incomplete model.

Exporting

Opens a box to select files for exporting the data generated for the electrical calculation 
network model in the ASCII format. A default setting gives the text files the filename 
ending *.txt. However, the user can set any other name ending.

To save the text file, switch to the required directory, enter a file name and select OK. If 
a file of the same name already exists, a dialog will ask whether the existing one should 
be overwritten or if the process should be cancelled. For the DigSilent export format, 
an optional cable type file from a previous generation, which is to be used when 
determining the cable types for the cable and aerial line segments, is then queried. 
Without a loaded cable types file the type classes are generated during the export, 
otherwise the cable types that have been read are used and new cable types are only 
generated for new cable/aerial line attribute combinations which are not contained in 
the cable types file.
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If no cable types file has been loaded or if new cable types have been added, when the 
export is complete there is a prompt for a file name for saving the cable types that have 
been generated.

The “File” menu
The “File” menu contains functions for the full range of input and output functions for 
the sisNET SR Module

Loading
Reads in an existing, generated network model and displays the network elements based 
on the symbol colours set in the current views. With this function, after rebooting the 
sisNET SR Module without identifying the topology, a network model that has been 
generated can be loaded.

Exporting
Starts the output of the generated network model to a text file (Exporting (Page 230)).

Closing
Closes the application module sisNET SR Module and saves the setting changes.

The “Configuration” menu
The “Configuration” menu is used to enter all the configuration data for generating and 
outputting a network model.

Application module objects
Opens the dialog Configure application module (Page 181). This is used to configure 
the object types in the electrical calculation network model by assigning them to sisNET 
object types and their attributes.

Task: Select from the “File” menu:

Load and draw a network model that has been 
generated

“Loading” on page 231

Export the current model network “Exporting” on page 231

Exit the sisNET SR Module “Closing” on page 231

Task: Select from the “Configuration” menu:

Assign the sisNET object types and sisNET attributes 
to the object types for the electrical model network

“Application module objects” on page 231

Select attributes for generating the cable types “Type classes > Cable types” on page 232
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Type classes > Cable types
Opens the “Configure Cable Types” dialog mask. Here you specify the attributes whose 
unique combination defines the relevant cable types (e.g. generate a cable type for each 
combination of nominal voltage, DIN name and dimension that occurs in the network 
generated).

The list of cable attributes comprises all the potential, cable type-relevant attributes that 
have not yet been used to for cable type generation.

The list of cable type attributes lists all the cable attributes currently selected for cable 
type generation. The buttons “->“ and “<-“ can be used to swap cable attributes between 
the two lists in order to change the cable type generation.

OK

Applies the cable attributes selected for cable type generation, and closes the dialog 
mask.

Cancel

Closes the dialog mask without saving the entries.

The “Settings” menu
The “Configuration” menu is used to enter all the configuration data for generating and 
outputting a network model.

Task: Selection from the “Settings” menu:

Enter/change the presentation colours for the graphic 
for the generated the model network

“Presentation” on page 233
232 sisNET Suite - User Guide



Generating electrical calculation network models
The “Settings” menu
Presentation
Opens the “Network presentation settings” dialog. The colours for presenting the 
generated calculation network model can be set here.

Node color

Determines the colour for the calculation network’s nodes.

Cable color

Specifies the fill colour for cable segments that are used for the electrical calculation 
network model.

Consumer

Specifies the colour which identifies the consumers that are put into the electrical 
calculation network model.

Transformer color

Specifies the fill colour of transformers that are used for the electrical calculation 
network model.

Switch color

Specifies the fill colour of switches that are used for the electrical calculation 
network model.

Bus bar color

Specifies the fill colour of bus bars that are used for the electrical calculation 
network model.

✍ The entries in the sisNET colour palette are available as colours. The colour palette opens 
as soon as the user clicks the coloured in field or, if the focus is on the input field, presses 
the space bar. 

OK

Selecting the OK button closes the dialog mask and the settings are applied to the fill 
colour.

Cancel

Closes the dialog mask without saving the entries.
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14 Display elevation profile
The “Display elevation profile” application module enables, for a freely selectable 
pipeline, the elevation profile along that section to be displayed in a 3D profile 
(providing elevation information is maintained for the relevant sisNET objects).
Description of function
The “Elevation profile” application module enables, for a freely selectable pipeline, 
the elevation profile of the associated pipe sections to be displayed in a 3D profile.

Which object types are to be used to display the longitudinal section can be configured 
separately for each category. 

There are 2 different configurations, depending on the category selected:

1. the default configuration for “normal, generally pressure-driven pipe networks” 
(the district heating, gas, and water categories) and 

2. the wastewater configuration for wastewater pipe networks (the wastewater category).

The “Elevation Profile” module automatically detects which type of configuration 
is required.

For the default elevation profile, the elevation profile between 2 nodes, connected 
by any number of pipe sections, is displayed.

The diagram below, for example, shows the 3D profile for a district heating pipe:
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For the wastewater elevation profile, the elevation profile between 2 manholes or 
special constructions, connected by any number of line reaches and manholes/special 
constructions, is displayed.

The diagram below, for example, shows the 3D profile for a wastewater pipe:

The elevation profile display can largely be configured in terms of the graphic design of 
the elevation profile diagram generated. So you can configure the display colours, line 
type, line width and font for all the elements to be graphically displayed, and you can 
switch the display of some legend texts on and off.

Prerequisites for using the elevation profile module
Because the sisNET data structure can, to a great extent, be freely configured, the 
elevation profile module can be configured to different customer data models. To do 
this, the associated sisNET object types from the sisNET schema for the current category, 
and the required display attributes, need to be assigned to the object types which are to 
be differentiated in the elevation profile.

Only two object types are required for the default elevation profile:

• the node with the attributes height and ground elevation (optional) for the vertical 
sections to be displayed and

• the pipe object type for the pipe objects whose path is to be displayed as a 3D profile. 
The application module attributes for the length, the installation type, and 
a maximum of 3 different pipe diameters are required for the pipe object type.
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Four object types, in all, are required for the wastewater elevation profile:

• the site point as connection components between the line reaches,

• the object type line reach for the line objects whose path is to be displayed as a 3D 
profile. The application module attributes for the entry and exit base elevation and 
for the elevation of the line reach are required for the line reach object type.

• the manhole object type with the attributes base height and cover height and, 
optionally, the diameter for the manholes to be displayed and

• the special structure object type with the attributes base height and cover height and, 
optionally, the diameter for the special structures to be displayed.

To create an elevation profile, certain conditions, described below, are also required for 
the data model in the customer schema.

For the standard elevation profile:

1. the pipe line objects for the elevation profile to be displayed are all linked to one 
another by common site points,

2. the site points have at least one attribute for the height.

If the path passes through site points with missing height values, there is the option of 
temporarily adding the height values or having them interpolated The elevation module 
cannot be used to make any permanent changes to the height values - this needs to be 
done in sisNET itself.

For the wastewater elevation profile:

1. the pipe objects (line reaches) for the elevation profile to be displayed are all linked 
to one another by common site points,

2. the line reaches have an attribute for both the exit and entry elevation and the 
start and end elevations (in the flow direction) and are laid out graphically in the 
flow direction,

3. the manholes and special structures have the attributes cover height and base height,

4. in the case of line reaches that are connected to one another by a manhole, the start 
and endpoints are at the midpoint of the manhole; in the case of line reaches that are 
connected to one another by a special structure, the start and endpoints are at the 
edge of the special structure and the channels inside the special structure are created 
as separate line reach objects (with a different profile type) with relations to the line 
reaches coming in from the outside and those going out, and to the special structure.

For this program module to be started, an environment variable SIS_LOCAL needs to be 
defined. The value of SIS_LOCAL should point to the sisNET work directory. As soon as 
the program has been configured once, the parameter file hoehexxx.par (xxx is the 
internal number of the category for the parameter file), containing the settings made 
while configuring the program, is created in the directory defined by SIS_LOCAL.
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Using the Elevation Profile module
When Elevation Profile is launched (via the menu item “Display elevation profile” 
beneath the main Application menu in sisNET), the main dialog window opens:

The four buttons are used to launch the main functions of the Elevation module:

The Settings menu can also be used to configure the various settings for the 
elevation profile:

Task: Button to select:

Start selecting the starting point and 
end point of the elevation profile

Route search (Page 239)

Return from the graphic display of 
the elevation profile to the elevation 
coordinates

Elevations (Page 239)

Create the current elevation profile Redraw (Page 241)

Plot the current elevation profile Plot (Page 241)

Task: Selection from the “Settings” menu:

Configure the object types pipe and 
node and line reach, manhole and 
special structure with their 
attributes

Data model Configure application module (Page 181)

Make settings for the diagram 
display

Diagram display Settings > Diagram display (Page 241)

Make settings for the installation 
system display (for the standard 
elevation profile only)

Linear display Settings > Linear Display (Page 242)
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Route search
By pressing the switch route search the selection of the start and endpoint for the 
displayed elevation profile is started. First of all, the message line in the sisNET main 
menu prompts the user to select the startpoint.

A node is selected by selecting the required start situation point with the Tentative 
button, which causes the selected node to appear with a large cross, and then confirming 
the selection with the left mouse button. After confirming the selection of the start node, 
the user is prompted to select the end point for the elevation profile. This is selected in 
the same way as the start node.

Now the program searches for the possible paths between the selected endpoints. If 
more than one path is found, first of all the number of paths is given. Then the first path 
found in the graphic is highlighted and the user is prompted to confirm or reject the path 
found. Clicking the left mouse button confirms the displayed path, while the right mouse 
button rejects it. If it is rejected, the next path found is highlighted in the graphic and the 
user is prompted to confirm or reject. If no other path has been found, the path search is 
restarted by querying the start node.

When a path between the 2 selected endpoints is confirmed, the elevation values are 
displayed along the path and in the dialog “Elevations”.

Elevations
This dialog displays the elevation values for the nodes along the elevation profile 
calculated. For a default elevation profile, the dialog looks like this:
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With the elevation profile for wastewater pipes, more elevations need to be displayed, so 
the Elevation values for the wastewater pipes dialog looks like this: 

The various nodes in the elevation profile are numbered consecutively (station), with the 
position in front of the decimal point showing the pipes in the elevation profile, and the 
position after the decimal point showing the sequential number of the nodes inside the 
pipe. The station numbers and the elevation values of the nodes can be temporarily 
changed and missing values can be interpolated in linear fashion.

Interpolate
When this button is selected, missing elevation values are calculated, using linear 
interpolation, based on the elevations of the adjacent nodes.

✍ Only elevations between 2 nodes with known elevation values can be interpolated.

Draw
Clicking on the “Draw” button closes the current dialog and the elevation profile of the 
displayed situation points is shown graphically.

✍ The elevation profile shown graphically is automatically saved to a MicroStation drawing 
file “Hoehexxx.dgn” in the directory defined by the environment variable SIS_LOCAL. 
The xxx symbol in this file name stands for a 3-digit number, with the previously highest 
existing number in the directory being automatically incremented by the value 1 for each 
new 3D profile file.

Cancel
This button cancels the elevation profile for the currently selected pipeline by closing the 
current dialog and returning to the main elevation profile dialog. If an elevation profile 
diagram is open, the current drawing file is closed and the drawing file (job or inventory 
file) that was originally loaded is reopened.
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Settings > Diagram display
Redraw
Selecting this button rebuilds the drawing file with the elevation profile.

✍ This enables you to test the effect of changes in the settings dialogs (Settings > Diagram 
display and Settings > Linear Display) without doing another search for a pipe path.

Plot
Selecting this button launches the MicroStation plot dialog for outputting the elevation 
profile that has been generated to a printer/plotter.

Application module objects
This menu item opens the dialog for displaying and changing the application module 
modification of the elevation profile Configure application module (Page 181).

Settings > Diagram display 
The “Elevation Profile Settings” dialog is opened by the menu item “Settings > 
Diagram display”:

Site points with NULL values

If the “Include site points without value” button is not selected, only site points with 
a specified height attribute are included. The default setting is that site points with 
unspecified height attributes are also included. 

✍ In the dialog Elevations (Page 239) users can retrospectively, manually enter missing 
elevations for the elevation profile display or interpolate them in linear fashion based 
on known adjacent values.
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Scale

In the “Scale” input group, a different scale can be specified for the horizontal and 
vertical display so that the actual elevation profile of the pipe can be displayed enlarged.

Symbology

The “Symbology” field lists the symbol elements used in the elevation profile diagram. 
For each symbol element used (legend, grid, route length, decline, station numbers, and 
the elevations to be displayed), the user can individually specify the drawing level, colour, 
line style, line width and font. For the elevation lines, route length, decline and station 
numbers, the user can also switch the legend output on and off.

These display attributes are specified by selecting the symbol required in the list field 
using the scroll bar, and then setting the display attributes using the setting fields for 
each attribute.

The configuration selected for the graphic display of the 3D profile is confirmed and 
made effective with “OK”.

Settings > Linear Display
For the default elevation profile, in this box the user can select a display symbol for the 
display parameters selected for this installation type for every attribute value for the 
attribute entered in the database.

.

The user selects the display symbols for the installation types (pipe types) and their 
attributes by specifying the relevant combination in the VLSYS, Parameter and Status list 
fields. In the “Status” list field you can specify whether the attribute set for the selected 
installation type is not available (none) or whether the attribute has been assigned 
a value (OK) or the attributed value is empty.

For each combination used, the user can individually specify the drawing level, colour, 
line style, line width and font. These display attributes are specified in the “Parameter 
Symbology” field by setting the display attributes using the setting fields for each attribute.

The configuration selected for the graphic display of the pipes in the 3D profile is 
confirmed and made effective with “OK”.
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Initially configuring the elevation profile
Depending on the elevation profile (default or wastewater), the object types pipe and 
node (for the default elevation profile) or the object types line reach, manhole and special 
structure need to be configured with the attributes required for the elevation profile.

To do this, first of all, for each object type (except for nodes; the associated sisNET 
object type node can be identified by the LP flag in the schema without any user query) 
the associated sisNET object type or types need to be assigned “Select object types” 
dialog (Page 184).

Then, for each object type, the associated sisNET attribute must be queried for the 
attributes required “Assign sisNET attribute for attribute” dialog (Page 187).
sisNET Suite - User Guide 243



Display elevation profile
Initially configuring the elevation profile

14
244 sisNET Suite - User Guide



Part IV: Attachments





Glossary
The glossary explains terms and expressions that have been included in the 
documentation.
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